Understanding and Using WinBench® 96 Version 1.0

�LICENSE AGREEMENT FOR ZIFF-DAVIS’ WINBENCH® 96 VERSION 1.0

READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE EMBODIED IN THE WINBENCH® 96 VERSION 1.0 CD�ROM, DISKETTE(S), OR, IF PRELOADED ON YOUR HARD DISK, DOWNLOADED OR IF PROVIDED AS PART OF A COLLECTION, THE PRELOADED, DOWNLOADED OR COLLECTED FILE(S) (the “Media”). Embodied in the WinBench 96 Media is the WinBench 96 computer program and related documentation (the “Software”). Ziff-Davis Publishing Company, having a place of business at One Park Avenue, New York, New York 10016 (“Ziff-Davis”) is the licensor under this Agreement and you are the licensee. By using the Software, in whole or in part, you agree to be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly return the Software to the Ziff-Davis Benchmark Operation at 1001 Aviation Parkway, Suite 400, Morrisville, North Carolina 27560 (or, if downloaded or preloaded on your hard disk, delete the Software, or if provided as part of a collection, cease use of the Software). Title to the Software and all copyrights, trade secrets and other proprietary rights therein are owned by Ziff-Davis. All rights therein, except those expressly granted to you in this Agreement, are reserved by Ziff-Davis.

1.	Limited License

This Agreement grants you only limited rights to use the Software. Ziff-Davis grants you a non-exclusive, non-transferable license to use the Software on a single dedicated computer or on a file server networked with multiple PC computers for the sole purpose of conducting benchmark tests to measure the performance of computer hardware and operating system configurations. You have the right to make a single copy of the Software for archival purposes and the right to transfer a copy of the Software across an internal local area network only to the PC computers attached to such network; provided, however, that all such copies are considered Software hereunder, that all uses of such copies are governed by the terms and conditions of this Agreement and that you shall be responsible for all uses of such copies in violation of the terms and conditions of this Agreement.

Ziff-Davis hereby grants you the right to publish, except in any country where a third party claims during the term of this license that such distribution infringes that party’s proprietary rights, benchmark test results obtained by you from your use of the Software provided that with the publication of each such result you: 

A.	Identify Ziff-Davis, the name and version number of the benchmark Software used (i.e., Ziff-Davis’ WinBench® 96 ver. 1.0);

B.	Identify the specific WinBench 96 score(s) being reported (i.e., Ziff-Davis’ WinBench® 96 ver. 1.0 Graphics WinMark™ 96);

C.	Identify the exact name, processor speed and type, amount of RAM, amount of secondary RAM cache, if any, hard disk model, type of hard disk controller, and size of hardware hard disk cache, if any, of the PC used for the test (e.g., WXY Corp. Model 466 with 66�MHz Intel® 486DX2�66 CPU, 8MB of RAM, 64KB RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache); 

D.	Identify the exact graphics adapter name, amount and type of RAM on it, graphics driver name and date, refresh rate, Microsoft® Video for Windows® version, and CODEC version that produced the result (e.g., XYZ Corp. XYZ Graphics adapter with 2MB VRAM with XYZ.DRV version 1.1 driver, a refresh rate of 72 Hz, Microsoft Video for Windows version 1.1e, and Intel Indeo™ Video version 3.2 CODEC); 

E.	Identify the exact CD-ROM drive model, CD-ROM controller model, CD-ROM controller RAM cache size (if any), and CD-ROM-specific software cache and size (if any) that produced the result (e.g., XYZ Corp. XYZ CD-ROM Quad-Speed drive, XYZ Corp. CD-ROM controller, with no controller RAM cache and no CD-ROM specific software cache); 

F. 	Identify the operating system version (e.g., MS�DOS® 5.0 and Microsoft Windows 3.1), size and type of software disk cache, if any (e.g., SMARTDRV 2MB cache), graphics resolution and color depth (e.g., 800 by 600 pixels with 256 colors), and any other special conditions used to achieve the result (e.g., disk compression utility ABC version 1.0 enabled); 

G.	State that all products used in the test were shipping versions available to the general public;

H.	State that the test was performed without independent verification by Ziff-Davis and that Ziff-Davis makes no representations or warranties as to the result of the test; and 

I.	Follow proper trademark usage and acknowledge Ziff-Davis' trademark rights (e.g., “[ ] achieved a Graphics WinMark™ 96 score of X on WinBench® 96 ver. 1.0. WinBench is a registered trademark or trademark and WinMark is a trademark of Ziff-Davis Publishing Company in the U.S. and other countries.”). 

This Agreement and your rights hereunder shall automatically terminate if you fail to comply with any provision of this Agreement. Upon such termination, you agree to cease all use of the Software, cease the transfer of any copies of the Software and cease the publication of benchmark test results obtained by you from use of the Software. Further you agree to delete the Software and to destroy all tangible copies of the Software and other materials related to the Software in your possession or under your control, or, if downloaded or preloaded on your hard drive or if provided as part of a collection, to cease use of and to destroy any and all copies of the Software in your possession or under your control.

2.	Additional Restrictions

A.	You shall not (and shall not permit other persons or entities to) rent, lease, sell, sublicense, assign, or otherwise transfer the Software or this Agreement. Any attempt to do so shall be void and of no effect.

B. 	You shall not (and shall not permit other persons or entities to) reverse engineer, decompile, disassemble, merge, modify, include in other software or translate the Software, or use the Software for any commercial purposes, except for the publication of test results, as provided above.

C.	You shall not (and shall not permit other persons or entities to) remove or obscure Ziff-Davis’ copyright, trademark or other proprietary notices or legends from any of the materials contained in this package or downloaded.

D.	You acknowledge that the Software contains Ziff-Davis’ trade secret information and you agree not to disclose or disseminate such information other than as provided herein.

3.	Limited Warranty and Limited Liability

THE SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS ASSUME NO RESPONSIBILITY FOR THE ACCURACY OR APPLICATION OF OR ERRORS OR OMISSIONS IN THE SOFTWARE. IN NO EVENT SHALL ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS HAVE BEEN ADVISED OF THE LIKELIHOOD OF SUCH DAMAGES OCCURRING. ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGES OR COSTS, ARISING OUT OF, BUT NOT LIMITED TO, LOST PROFITS OR REVENUE, LOSS OF USE OF THE SOFTWARE, LOSS OF DATA OR EQUIPMENT, THE COSTS OF RECOVERING SOFTWARE, DATA OR EQUIPMENT, THE COST OF SUBSTITUTE SOFTWARE OR DATA, CLAIMS BY THIRD PARTIES, OR OTHER SIMILAR COSTS.

THE ONLY WARRANTY MADE BY ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS IS THAT THE ORIGINAL PHYSICAL MEDIA IN WHICH THE SOFTWARE IS EMBODIED AND WHICH IS DISTRIBUTED BY ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS SHALL BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP. ZIFF-DAVIS’ ENTIRE LIABILITY AND THE USER’S EXCLUSIVE REMEDY SHALL BE LIMITED TO THE REPLACEMENT OF THE ORIGINAL PHYSICAL MEDIA IF DEFECTIVE. THE WARRANTIES AND REMEDIES SET FORTH HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. NO ZIFF-DAVIS DISTRIBUTOR, AGENT OR EMPLOYEE, OR THIRD PARTY, IS AUTHORIZED TO MAKE ANY MODIFICATION OR ADDITION TO THIS WARRANTY.

SOME STATES DO NOT ALLOW EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES OR LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES; SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

�4.	U.S. Government Restricted Rights

The Software is licensed subject to RESTRICTED RIGHTS. Use, duplication or disclosure by the Government or any person or entity acting on its behalf is subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS (48 CFR 252.227-7013) for DoD contracts, in paragraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights clause in the FAR (48 CFR 52.227-19) for civilian agencies, or in the case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR, or in other comparable agency clauses. The contractor/manufacturer is the Ziff-Davis Benchmark Operation, 1001 Aviation Parkway, Suite 400, Morrisville, North Carolina 27560.

5.	General Provisions

Nothing in this Agreement constitutes a waiver of Ziff-Davis’ rights under U.S copyright laws or any other Federal, state, local or foreign law. You are responsible for installation, management, and operation of the Software. This Agreement shall be construed, interpreted and governed under New York law. If any provision of this Agreement shall be held by a court of competent jurisdiction to be illegal, invalid or unenforceable, the remaining provisions shall remain in full force and effect.

�Trademarks

MacBench®, NetBench®, ServerBench®, WinBench®, and Winstone® are registered trademarks and CPUmark™ and WinMark™ are trademarks of Ziff�Davis Publishing Company.

Compton’s Interactive Encyclopedia™ is a trademark of Compton’s New Media, Inc.

Corel GALLERY™ is a trademark of Corel Corporation.

dBASE® is a registered trademark of Borland International, Inc.

Microsoft®, MS-DOS® and Windows® are registered trademarks and Encarta™ and Windows NT™ are trademarks of Microsoft Corporation.

Myst™ is a trademark of Cyan, Incorporated.

Intel® is a registered trademark of Intel Corporation.

Novell® is a registered trademark of Novell, Inc.

OS/2® is a registered trademark of International Business Machines Corporation.

Quicken® is a registered trademark and Quicken for Windows CD-ROM Deluxe Edition™ is a trademark of Intuit, Incorporated.
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This is the reference manual for WinBench® 96. This manual provides information on installing and using WinBench 96 as well as information on interpreting results.

NOTE:	Before you do anything with the software, you need to read the license agreement at the front of this manual. (The same license agreement appears on the PC’s screen the first time you start WinBench 96.)

This section lists the different parts of this manual, the conventions the manual uses, and other available WinBench 96 documentation.

Finding the information you need

There are several ways you can find the information you need in this manual. In addition to the Table of Contents and Index, you’ll find a reading path chart at the beginning of this manual (just after the license agreement pages). If you’re uncertain which chapters or sections you need to read, you can consult that chart for a reading path that may be appropriate for you.

To make it easier to find the information you need, this manual includes the following parts:

Part 1:	� REF Part1GettingtoKnow \* MERGEFORMAT �Getting to Know WinBench 96��Provides an introduction to the benchmark.

Part 2:	� REF Part2InstallingandSettingUpWS \* MERGEFORMAT �Installing and Setting Up WinBench 96��Explains how to install and setup the WinBench 96 software.

Part 3:	� REF Part3RunningWS \* MERGEFORMAT �Running WinBench 96��Discusses things you need to know before you run WinBench 96, explains how to run WinBench 96’s tests and save results, explains how to create custom test suites, and provides information on the benchmark’s Disclosure.

Part 4:	� REF Part4AnalyzingResults \* MERGEFORMAT �Analyzing Results��Explains how to use the results database, discusses what the numbers mean about a PC’s performance and can affect a PC’s results, and tells what information you must include about a PC if you publish its WinBench 96 results.

Part 5:	Looking Under the Hood—How WinBench 96 Works�Explains what went into the benchmark’s development, what the tests do when you run them, and how the benchmark calculates its results.

Part 6:	� REF Part6IfYouHaveaProblem \* MERGEFORMAT �If You Have a Problem��Provides troubleshooting information and explains how to contact Ziff-Davis if you have a problem with the benchmark.

This manual also includes the following appendices:

Appendix A:	� REF AppendixADatabaseFiles \* MERGEFORMAT �The Database Files��Lists and describes all the database files WinBench 96 creates when you save results to a database.

Appendix B:	� REF AppendixBCustomConfigFile \* MERGEFORMAT �The Custom Configuration File��Explains in detail how to build a custom configuration file.

Appendix C:	� REF AppendixBVideo \* MERGEFORMAT �The Video Clips��Explains what you should see at certain frame numbers during each type of video test. Also includes a chart that maps each video test name to the .AVI video clip file that test runs and a chart that lists the attributes for each .AVI video clip file.

Conventions this manual uses

� XE "Manual conventions" �� XE "WinBench 96:Manual conventions" �This manual uses a few general conventions. For example, it:

Uses the pronoun “we” to refer in general to either the Ziff-Davis Benchmark Operation (ZDBOp) or Ziff-Davis.

Uses bold type face for DOS and Windows commands, file names, and directory names. For example, you’ll see sentences similar to the following:

“The WB96REF.DOC file is in the \ZDBENCH\DOCS\WB96\REF directory on the CD�ROM.”

Uses a monospace or typewriter font for information you must enter verbatim from the command line. The manual also displays system responses that appear on the PC’s screen in the same font. For example:

D:\ZDBENCH\WB96\SETUP.EXE

Uses the terms “select” and “choose” in the same way Windows documentation uses these terms. In Windows documentation, the terms “select” and “choose” have different, and specific, meanings. When you select an item, you mark it with the selection cursor, and the selection appears as a highlight, a dotted rectangle, or both. You also select check boxes in dialog boxes. Selecting alone doesn’t initiate an action.

You choose an item to carry out an action. For example, when you choose WinBench 96 from the Ziff-Davis Benchmarks program group, WinBench 96 opens its main window. You can also choose an item from a menu or choose a command button in a dialog box. You often need to select an item before you can choose it.

Available WinBench 96 documentation� XE "WinBench 96:Documentation, what’s available" �� XE "Documentation:What’s available" �

This document:�Is located in the:�And contains:��README.WRI�\ZDBENCH\WB96 directory on the CD�ROM or in the root directory on DISK 1.�The license agreement, a list of new features, and a list of known problems as of the CD�ROM’s release.��WinBench® 96 Version 1.0 Tester’s Handbook�(WB96HBK.*)�\ZDBENCH\DOCS\WB96\HANDBOOK directory on the CD�ROM. The CD�ROM may include three different formats of the handbook (.DOC, .TXT, and .RTF).�The minimum information you need to install WinBench 96, run the tests, and analyze the results.

The on�line help contains most of the information in the tester’s handbook.��Understanding and Using WinBench® 96 Version 1.0�(WB96REF.*)�\ZDBENCH\DOCS\WB96\REF directory on the CD�ROM. The CD�ROM may include three different formats of the manual (.DOC, .TXT, and .RTF).�The WinBench 96 reference manual. (This is the document you’re reading now.)��End of About this Manual
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�Part 1: �Getting to Know WinBench 96

Chapter 1:	� REF Chapter1IntroducingWS \* MERGEFORMAT �Introducing WinBench 96��Provides an introduction to the WinBench 96 basics.

Chapter 2:	� REF Chapter2WhatsNew \* MERGEFORMAT �What’s New in This Release��Lists the improvements and changes for this release of WinBench.

Chapter 3:	� REF Chapter3KeyConcepts \* MERGEFORMAT �WinBench 96 Key Terms��Briefly explains the general WinBench 96 terms and concepts this manual uses.

�Chapter 1: �Introducing WinBench 96

This chapter provides a brief description of WinBench 96.

Sections in this chapter

� REF _Ref298231824 \* MERGEFORMAT �WinBench 96 in a nutshell�

� REF _Ref336158011 \* MERGEFORMAT �Why you should use WinBench 96�

� REF _Ref336232769 \* MERGEFORMAT �Using other ZD benchmarks�

WinBench 96 in a nutshell

� XE "WinBench 96:In a nutshell" �WinBench 96 is a subsystem-level benchmark that measures the performance of a PC’s graphics, disk, processor, video, and CD�ROM subsystems in a Windows-based environment. WinBench 96’s tests perform many of the same operations applications commonly execute. For WinBench 96, we profiled the same Windows-based applications Winstone® 96� XE "Winstone 96" � uses. These applications cover top-selling Windows product areas, including database, business graphics and desktop publishing, spreadsheet, and word processing.

NOTE:	WinBench 96 doesn’t run actual applications during its tests. Instead, the tests mimic the operations leading Windows-based applications perform.

WinBench 96 returns five main results that provide an overview of a PC’s graphics, disk, processor, and CD�ROM subsystems performance—the Graphics WinMark 96, Disk WinMark 96, the CPUmark�16��� and CPUmark�32�, and the CD-ROM WinMark 96. In addition, the benchmark includes full-motion video tests to measure the PC’s video subsystem performance.

Why you should use WinBench 96

� XE "WinBench 96:Why use it" �A few key concepts are at the heart of WinBench 96. Like previous versions of the benchmark, WinBench 96 uses “market-centered” tests. It aims to measure the level of performance typical business users will achieve while performing common operations with leading business applications.

The results WinBench 96 produces will be useful to the vast majority of users, because most spend a great deal of computing time working with the same basic classes of applications.

That’s not to say, however, that WinBench 96’s results will apply equally well to everyone or to every computing situation. If you spend all your time running CAD programs, WinBench 96’s results will not reflect your work. Even if you are such a user, however, you can use WinBench 96’s hundreds of analysis tests to gauge specific aspects of a PC’s performance.

� XE "WinBench 96:Synthetic benchmark" �� XE "Synthetic benchmark" �WinBench 96 is a “synthetic” benchmark. It executes specially crafted programs designed to act in ways similar to the way applications behave. The hard part in creating a synthetic benchmark like WinBench 96 is making sure it really does act like the applications whose behavior it is supposed to reflect. The key to making this happen is “application profiling,” a process of logging and analyzing the way the target applications behave. To build WinBench 96, ZDBOp profiled the processor, graphics, disk, and CD-ROM activity of the leading Windows applications

The industry changes, and Ziff-Davis’ benchmarks must change to reflect it. New versions of applications have appeared, and those versions put different performance demands on PCs than previous versions. These changes make the upgrade to WinBench 96 even more critical.

Using other ZD benchmarks

� XE "Winstone 96" �The CD-ROM that contains WinBench 96 also includes Winstone 96. Winstone 96 is a benchmark that runs test suites of Windows-based applications and provides an overall measure of a PC’s Windows performance.

Thus, you can use ZD’s PC benchmarks to assess both the performance of individual PC subsystems and overall PC performance. Such a combination could be particularly helpful if your work relies heavily on the performance of a particular subsystem (such as CD-ROM, disk, graphics, or video). Taken together, these different benchmark scores provide a broad set of information on both overall performance and the performance of the PC’s subsystems.

For example, you may want to use WinBench 96 and Winstone 96 as a team. WinBench 96 returns data on the performance of the PC’s graphics, disk, processor, video, and CD-ROM subsystems, whereas Winstone 96 measures the performance of a PC as a whole and the effect of component changes on overall system performance.

In addition to the PC benchmarks, ZD has benchmarks for servers and Mac™ OS computers. To request a ZD benchmark, see the form at the back of this manual.

End of Chapter

�Chapter 2: �What’s New in This Release

Each year, we release a new generation of our PC benchmarks. During the year, we spend our time generally improving the benchmarks and fixing problems.

This chapter tells you about the changes and improvements we’ve made to WinBench. It also includes a list of the problems with WinBench 95 that WinBench 96 fixes.

Sections in this chapter

� REF _Ref298310679 \* MERGEFORMAT �How WinBench has changed�

� REF _Ref336145015 \* MERGEFORMAT �Problems WinBench 96 fixes�

How WinBench has changed

� XE "WinBench 96:New features" \r "WhatsNew" �This section briefly explains what has changed with this year’s benchmark.

NOTE:	The test files WinBench 96 uses for the � XE "WinBench 96:Tests:CD-ROM" �� XE "Tests:CD-ROM" �CD-ROM and � XE "WinBench 96:Tests:Full-motion video" �� XE "Video tests" �� XE "Tests:Video" �full�motion video tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM will not contain these tests. In addition, some CD-ROM versions may not include these tests.

	You can use the Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests.

CD-ROM WinMark 96� XE "WinBench 96:Marks:CD-ROM WinMark 96" �� XE "CD-ROM:WinMark 96" �� XE "Tests:CD-ROM WinMark 96" �

WinBench 96 includes a new WinMark™—the CD�ROM WinMark 96. This suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem.

The CD-ROM tests measure the entire CD-ROM subsystem, which includes the CD-ROM drive, the adapter to which it is connected, the software drivers it requires to operate, and any software caches. Any one of these pieces can affect the performance of the whole CD-ROM subsystem.

NOTE:	The test PC must have a CD-ROM drive and the CD-ROM that contains WinBench 96 must be in that drive before you can run any WinBench 96 CD-ROM tests.

For information on running the CD-ROM WinMark 96 suite, see page � PAGEREF _Ref333742898 �51�. If you’d like to know what the CD-ROM WinMark 96 result means about a PC’s CD-ROM subsystem performance, see page � PAGEREF _Ref330267616 �110�.

Full-motion video tests� XE "WinBench 96:Tests:Full-motion video" �� XE "Tests:Video" �� XE "Video tests" �

WinBench 96 includes new tests that provide concrete measures of a PC’s ability to play full�motion video. Unlike other WinBench 96 tests that focus on a specific subsystem’s performance, the new video tests stress many different parts of the PC’s hardware and software.

NOTE:	The test PC must have a CD-ROM drive and the CD-ROM that contains WinBench 96 must be in that drive before you can run any WinBench 96 video tests.

For information on running a video test, see page � PAGEREF _Ref330197959 �52�. If you’d like information on what the video test results mean, see page � PAGEREF _Ref330276046 �111�. If you’d like a play-by-play of what you’ll see on the PC’s screen when you run a video test, see page � PAGEREF _Ref336157074 �209�.

32- and 16-bit processor tests� XE "WinBench 96:Marks:CPUmarks" �� XE "WinBench 96:Tests:CPUmarks" �� XE "Tests:CPUmarks" �� XE "Processor tests" �� XE "32-bit test" �� XE "16-bit test" �� XE "WinBench 96:Processor tests" �� XE "WinBench 96:Tests:Processor" �

WinBench 96 offers two new tests for measuring processor subsystem performance:  CPUmark32 and CPUmark16. The � XE "Processor subsystem" �� XE "Subsystems:Processor" �� XE "WinBench 96:Subsystems:Processor" �processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.

As their names imply, the CPUmark32 and CPUmark16 tests measure the performance of x86 processors running different workloads.

The CPUmark32 measures the processor subsystem’s speed at running 32-bit Windows applications.

The CPUmark16 measures the processor subsystem’s speed at running 16-bit Windows applications.

Both tests are useful for obtaining a complete picture of a PC’s processor subsystem performance. Most of the new Windows applications are 32-bit products, and Windows 95 is largely a 32-bit operating system. The CPUmark32 is the right tool for measuring how well a PC’s processor subsystem will perform when running such software. At the same time, some applications are 16-bit products, and large portions of Windows 95 run as 16-bit code. For 16-bit code, the CPUmark16 is the right choice.

Whether one or both of the processor tests is appropriate to you depends on the mix of 32- and 16-bit applications you run.

For more information on the processor tests and what their results mean about a PC’s performance, see page � PAGEREF _Ref336240442 �110�.

Configuration check before test runs

� XE "WinBench 96:Configuration check" �� XE "WinBench 96:Configuration Information window" �� XE "Configuration Information window" �You can use WinBench 96’s new Configuration Information window to compare the test PC with either a pre-set list of optimization tips or a custom configuration file you create. (For information on disabling the configuration check, see page � PAGEREF _Ref327694563 �39�.)

NOTE:	You can open the Configuration Information window from the Run menu on the main window menu bar without running a test.

The Configuration Information window has two sections:

Optimization Tips. � XE "WinBench 96:Configuration check:Optimization Tips" �� XE "Optimization Tips" �� XE "Configuration Information window:Optimization Tips" �Compares the PC’s setup and configuration to a pre-set list of optimization tips.

Custom Configuration File. � XE "WinBench 96:Configuration check:Custom Configuration File" �� XE "Custom Configuration File" �� XE "Configuration Information window:Custom Configuration File" �Compares the PC’s setup and configuration to a custom configuration file. For information on using a custom configuration file, see page � PAGEREF _Ref327694797 �38�.

For more information on this new feature, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�, beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.

Disclosure fields for multimedia

� XE "WinBench 96:Disclosure:Multimedia fields" �� XE "Disclosure:Multimedia fields" �WinBench 96 includes new Disclosure fields for multimedia. The following table lists the new fields as they appear in the WBN_SYS.DBF� XE "WBN_SYS.DBF" � results file.� XE "WinBench 96:Results:Files" �

�NOTE:	The following list shows the fields exactly as they appear in the results file. If you use a .DBF�compatible application to view the file, the fields may appear in a different order.

Result:�Result field name:�Field type:�Width (bytes):��CD-ROM drive description�CD_DRV_DES�Character�80��CD-ROM controller description�CD_CONT_DE�Character�80��CD-ROM controller RAM �CD_CONT_RA�Character�10��CD-ROM software cache description�CD_SCH_DES�Character�80��CD-ROM software cache size�CD_SCH_SZ�Character�10��Sound adapter description�SND_ADP_DE�Character�80��Video for Windows version �VFW_VER�Character�20��Win32s version�WIN32S_VER�Character�20��Windows drivers�WIN_DRVS�Memo���If you’d like more information on using the database files, see page � PAGEREF _Ref336240491 �97�. For additional information on the database fields WinBench 96 uses, see Appendix A, “� REF AppendixADatabaseFiles \* MERGEFORMAT �The Database Files�,” beginning on page � PAGEREF AppendixADatabaseFiles �183�.

Error messages log file

� XE "WinBench 96:Messages:ERRORS.TXT" �� XE "Messages:ERRORS.TXT" �� XE "ERRORS.TXT" �� XE "Error messages log file" �WinBench 96 logs all error messages in a file named ERRORS.TXT in the parent directory in which you installed the benchmark (probably \ZDBENCH). (WinBench 96 shares this log file with Winstone 96.) The automatic logging feature frees you from having to keep track of any error messages WinBench 96 may display during a test run.

You can view the ERRORS.TXT file with any text editor.

Problems WinBench 96 fixes

� XE "Problems WinBench 96 fixes" �� XE "WinBench 96:Problems fixed in this release" �The following lists the problems with WinBench 95 that WinBench 96 fixes.

1.	WinBench 96 does not limit the PC Emulation Info in the Software page of the Questionnaire to three characters.

2.	In WinBench 95, the directory list box and the drives list box in the Database browser dialogs did not correctly paint the directory and drive icons when you ran with a monochrome graphics driver. WinBench 96 does not have this problem.

3.	WinBench 96 does not cause a GPF if you cancel batch mode during a batch mode message and then double-click in the Disclosure window’s drop-down list of results.

4.	With WinBench 95, if you started a sequence of tests and then moved the mouse repeatedly over the title bar, the cursor was an arrow, instead of a watch when the next test started. WinBench 96 no longer has this problem.

5.	WinBench 96 does not GPF when printing the Table of Results or the Disclosure if the text you’re printing happens to be exactly one less than a multiple of 16 characters.

6.	The NOCPUCHECK command line option works correctly in WinBench 96.

End of Chapter

�Chapter 3: �WinBench 96 Key Terms

Before you run any of WinBench 96’s tests, it would help to understand a few basic terms. This chapter provides an overview of the key terms you should know to best understand how to run WinBench 96 and understand its results.

NOTE:	You can also consult the Glossary at the end of this manual.

Sections in this chapter

� REF _Ref335631095 \* MERGEFORMAT �Baseline �

� REF _Ref335632213 \* MERGEFORMAT �CD-ROM WinMark 96�

� REF _Ref333724443 \* MERGEFORMAT �Chart of Results�

� REF _Ref335632226 \* MERGEFORMAT �CPUmark16�

� REF _Ref335632230 \* MERGEFORMAT �CPUmark32�

� REF _Ref333724446 \* MERGEFORMAT �Disclosure�

� REF _Ref333724448 \* MERGEFORMAT �Disclosure Questionnaire�

� REF _Ref335631515 \* MERGEFORMAT �Disk WinMark 96 suite�

� REF _Ref335632545 \* MERGEFORMAT �Full-motion video tests�

� REF _Ref335631106 \* MERGEFORMAT �Functions window�

� REF _Ref335632247 \* MERGEFORMAT �Graphics WinMark 96 suite�

� REF _Ref333724453 \* MERGEFORMAT �Main window�

� REF _Ref333724455 \* MERGEFORMAT �Table of Results�

Baseline machine� XE "WinBench 96:Baseline machine" �� XE "Baseline machine" �

When you display results, you can choose which set of results you want to use as a baseline system. With a baseline system, you can quickly compare all the results to that one set of results in WinBench 96’s Chart of Results.

When you select a baseline system, WinBench 96 sets that system’s results to 1.00 and displays all other results as a fraction of the baseline system’s results. When you use a baseline system, you can quickly determine from the graphs how results for different PCs compare.

For example, once you’ve set the baseline system, the bar graph for a set of results that is faster (or better) than the baseline system’s will be more than 1.00, while the bar graph for a set of results that is slower (or worse) than the baseline system’s will be less than 1.00.

To specify which set of results you want WinBench 96 to use as the baseline system or to change the current baseline system, select Baseline... from the Chart menu.

CD-ROM WinMark 96

� XE "WinBench 96:Marks:CD-ROM WinMark 96" �� XE "CD-ROM:WinMark 96" �The CD-ROM WinMark 96 suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem. (When you run the CD-ROM WinMark 96 suite, the CD�ROM that includes WinBench 96 must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

When you run the CD-ROM WinMark 96 suite, you actually run a single large test called the CD-ROM Mix. The CD-ROM Mix consists of six different sections. Each section executes a set of CD-ROM operations corresponding to the operations performed by one of the six profiled applications.

For information on what the CD-ROM WinMark 96 suite does when you run it, see page � PAGEREF _Ref336143703 �141�. If you want to run the CD-ROM WinMark 96 suite, see page � PAGEREF _Ref333742898 �51�.

Chart of Results

When you run any of WinBench 96’s tests, it automatically displays its results in the Chart of Results.

WinBench 96 displays the name of the test and a horizontal bar graph showing its result.

You can also add results for other machines to the Chart of Results. If you do this, then WinBench 96 displays a horizontal bar graph for each machine in the chart. The Chart of Results groups results together by test. You can display up to five sets of comparison results in this chart.

CPUmark16

� XE "WinBench 96:Marks:CPUmarks" �The CPUmark16� XE "CPUmark16" � is a � XE "16-bit test" �16-bit test that reflects the processor usage of 16-bit applications and focuses solely on a PC’s processor subsystem. (The processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.) The CPUmark16 is a synthetic test that stresses the processor subsystem by running a workload that simulates the processor behavior of leading Windows applications. The CPUmark16 workload includes such real work as compressing data, adjusting dates, analyzing words, and formatting text.

CPUmark32

� XE "WinBench 96:Marks:CPUmarks" �The CPUmark32� XE "CPUmark32" � is a � XE "32-bit test" �32-bit test that reflects the processor usage of 32-bit applications and focuses solely on a PC’s processor subsystem. (The processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.) The CPUmark32 is a synthetic test that stresses the processor subsystem by running a workload that simulates the processor behavior of leading Windows applications. The CPUmark32 workload includes such real work as compressing data, adjusting dates, analyzing words, and formatting text.

Disclosure

The Disclosure window displays information about a PC’s configuration. You can also view system information about comparison machines from the Disclosure window. To open this window, choose its icon from the WinBench 95 main window or the Disclosure option from the Window menu.

Disclosure Questionnaire

� XE "WinBench 96:Disclosure Questionnaire" �� XE "Disclosure Questionnaire" �When you need to edit Disclosure information, you use WinBench 96’s Disclosure Questionnaire window. This window lets you edit information about a PC’s configuration. To open this window, choose Disclosure Questionnaire... from the Edit menu in the WinBench 96 main menu bar.

Disk WinMark 96 suite

� XE "WinBench 96:Marks:Disk WinMark 96" �� XE "Disk WinMark 96" �The Disk WinMark 96 suite gives you an overall comparative measure of a PC’s disk subsystem. The components of that subsystem are the hard disk, the disk controller, any device driver software, and any hardware and software disk caches your PC uses.

When you run WinBench 96’s Disk WinMark 96 suite, you actually run a single large test called the Disk Mix. The Disk Mix executes a series of disk operations similar to typical disk operations leading applications perform. WinBench 96 times how long the test PC takes to perform the Disk Mix and then returns a Disk WinMark 96 result in thousands of bytes per second.

Full-motion video tests

� XE "WinBench 96:Tests:Full-motion video" �� XE "Tests:Video" �� XE "Video tests" �WinBench 96’s video tests provide concrete measures of a PC’s ability to play full-motion video. Video playback functions stress multiple areas of the PC, including the PC’s processor and graphics subsystems, as well as the CD-ROM or disk subsystems, depending on the location of the video clips you’re playing. (The CD�ROM that includes WinBench 96 may also includes WinBench 96’s video clips. When you run a video test, that CD�ROM must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

Unlike other WinBench 96 tests that focus on a specific subsystem’s performance, the new video tests stress many different parts of the PC’s hardware and software.

Functions window

The Functions window� XE "Functions window" �� XE "WinBench 96:Functions window" � is the portion of WinBench 96’s main window that contains the function buttons. The section “� REF _Ref298751138 \* MERGEFORMAT �Using the Functions buttons�” on page � PAGEREF _Ref298751138 �72� explains what each function button does when you choose it.

Graphics WinMark 96 suite

� XE "WinBench 96:Marks:Graphics WinMark 96" �� XE "Graphics WinMark 96" �The Graphics WinMark 96 suite gives you an overall comparative measure of a PC’s graphics subsystem. The components of that subsystem are the graphics adapter, whether on the motherboard or a plug-in graphics card, its Windows device driver, as well as your PC’s monitor.

The Graphics WinMark suite gives you an overall comparative measure of the performance of � XE "Subsystems:Graphics" �� XE "WinBench 96:Subsystems:Graphics" �a PC’s graphics subsystem by focusing on graphics operations. It performs a mix of Graphics Device Interface (GDI) painting operations that top�selling Windows�based applications use. The tests the Graphics WinMark includes perform operations such as memory to screen BitBlts and screen to screen BitBlts and operations that draw both geometric objects (such as lines, circles, and rectangles) and text.

Main window

WinBench 96� XE "WinBench 96:Main window" �� XE "Main window" �’s main window is the window that appears when you first start WinBench 96. The Functions window is inside the main window.

Table of Results

� XE "Table of Results" �� XE "WinBench 96:Table of Results" �When you run one of WinBench 96’s tests, it includes the result for that test in the Table of Results. WinBench 96 doesn’t, however, automatically display the Table of Results as it does the Chart of Results. To open this window, choose its icon in the WinBench 96 main window or the Table of Results option in the Window menu.

Information in the Table of Results is in a column format grouped into sets of results by test.

�You can add up to five sets of comparison results to the Table of Results. If you do this, WinBench 96 displays your PC’s current results in the first column. WinBench 96 displays results for the comparison machines in the columns that follow the current results. You may need to use the scroll bars to view all the comparison results in the table.

Test Screen

� XE "WinBench 96:Test Screen" �� XE "Test Screen" �When WinBench 96 runs a graphics test, it opens a window for the test called the Test Screen. After the test completes, WinBench 96 leaves the last screen image it displayed during that test run in the Test Screen. To open the Test Screen, choose it from the WinBench 96 main window.

� XE "Tests:Graphics" �� XE "WinBench 96:Tests:Graphics" �If you have problems while running one of WinBench 96’s graphics tests, you can use the Test Screen to make sure the test finished successfully by comparing the test screen from a test you know was successful with the current Test Screen. (If you do this, you’ll need to make sure the graphics driver uses the same resolution and options for the current test as for the successful test.)

Test suite

� XE "Test suite" �� XE "Tests:Suite" �� XE "WinBench 96:Test suite" �A test suite is a test or group of tests you can run at one time by choosing Run from the File menu or by choosing the Run button. For example, WinBench 96 includes the following built�in test suites:  the Graphics, Disk, and CD-ROM WinMarks and the CPUmark16 and CPUmark32.

End of Chapter

�Part 2: �Installing and Setting Up WinBench 96

Chapter 4:	� REF Chapter4SettingUp \* MERGEFORMAT �Setting Up the Test PC��List the minimum requirements to run WinBench 96 and explains how to create a set of installation diskettes.

Chapter 5:	� REF Chapter5Installing \* MERGEFORMAT �Installing the WinBench 96 Files��Explains how to install the benchmark.

Chapter 6:	� REF Chapter6Licensing \* MERGEFORMAT �Licensing and Registering WinBench 96��Tells you how to license and register your copy of the software. (You must license and register WinBench 96 before you can run any of its tests.)

�Chapter 4: �Setting Up the Test PC

This chapter lists the minimum requirements to run WinBench 96 and explains how to create a set of installation diskettes for WinBench 96.

Sections in this chapter

� REF _Ref333726159 \* MERGEFORMAT �Minimum requirements�

� REF _Ref335633025 \* MERGEFORMAT �Making a set of installation diskettes�

Minimum requirements

� XE "WinBench 96:Minimum requirements" �� XE "Installing:Minimum requirements" �� XE "Minimum requirements" �� XE "Requirements" �If the PC doesn’t meet WinBench 96’s minimum requirements, the benchmark won’t be able to run the tests properly. The chart on the next page lists the minimum requirements to install and run WinBench 96.

�

Windows 3.1 or 3.11* or�Windows for Workgroups 3.1 or 3.11*��Windows 95�Windows NT™�3.5* or later��OS/2® Warp* ��MS-DOS® (or compatible) version 5.0 or later or Novell® DOS 7�N/A�N/A�N/A��Video for Windows version 1.1E† �N/A�N/A�Video for Windows version 1.1E†��Win32s 1.25†�N/A�N/A�Win32s 1.1†��Microsoft CD Extension software or equivalent�N/A�N/A�N/A��8MB RAM�8MB RAM�minimum RAM the operating system requires�minimum RAM the operating system requires��6MB of free space on the PC’s hard disk and an additional 58MB plus the size of RAM of free space �for temporary files the Disk WinMark 96 suite uses��80386 (or compatible) or higher processor��CD-ROM drive��Sound card‡ ��VGA resolution (640x480) or higher graphics adapter��Making a set of installation diskettes

� XE "WinBench 96:Diskettes:Making" �� XE "Diskettes:Making a set of installation diskettes" �If you don’t have a CD-ROM drive on the PC you wish to test, you can make a set of installation diskettes from the CD-ROM that contains WinBench 96.

To make a set of installation diskettes, you’ll need a DOS machine that has a CD�ROM drive. You’ll also need three formatted, high-density, 3.5 inch, empty diskettes. You should label the first diskette “WinBench 96 Version 1.0 DISK1”, the second diskette “WinBench 96 Version 1.0 DISK2”, and the third diskette “WinBench 96 Version 1.0 DISK3”.

The \ZDBENCH\DISKETTE\WB96 directory on the CD-ROM also contains a batch file you can use to automatically copy the files from the CD�ROM to the blank diskettes.

To copy the necessary WinBench 96 files to the diskettes:

1.	Put the CD-ROM in the CD-ROM drive.

2.	Change to the \ZDBENCH\DISKETTE\WB96 directory on the CD-ROM.

3.	Execute the batch file MAKEDISK.BAT and supply the name of the diskette drive. For example, if you're PC's diskette drive is the A drive, use the following command:

MAKEDISK.BAT A

MAKEDISK� XE "MAKEDISK" � will prompt you when you need to insert the next diskette.

End of Chapter

�Chapter 5: �Installing the WinBench 96 Files

To install the benchmark, you execute SETUP.EXE from the \ZDBENCH\WB96 directory. The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

If you’re an experienced PC user, you may not need to read this chapter. It explains step�by�step how to install WinBench 96 files.

Sections in this chapter

� REF _Ref333726896 \* MERGEFORMAT �Installing WinBench 96�

� REF _Ref335634609 \* MERGEFORMAT �Installing Video for Windows�

� REF _Ref335634610 \* MERGEFORMAT �Installing Win32s�

Installing WinBench 96

Depending on how you received WinBench 96, the installation may be slightly different. Basically, you always run SETUP.EXE to install WinBench 96’s files. If you received the software on diskettes or if you downloaded a file, you do, however, have a couple of added steps during installation.

To make it easier to find the information you need, this part of the manual include three sections. If you have:

A CD-ROM, read the next section “� REF _Ref328881205 \* MERGEFORMAT �Installing from the CD-ROM�.”

A set of installation diskettes, go to page � PAGEREF _Ref333140082 �26�.

NOTE:	If you received WinBench 96 on CD-ROM and need to make a set of installation diskettes, see page � PAGEREF _Ref335633025 �22�.

A downloaded file, go to page � PAGEREF _Ref328820115 �27�.

Installing from the CD-ROM

� XE "WinBench 96:Installing:CD-ROM" �� XE "Installing:CD-ROM" �To install WinBench 96 from the CD-ROM, run SETUP.EXE from the \ZDBENCH\WB96 directory on the CD-ROM.

NOTE:	If you received WinBench 96 on CD-ROM, that CD-ROM may contain the Ziff�Davis PC Benchmarks Installer program� XE "Ziff�Davis:PC Benchmarks Installer program" �� XE "PC Benchmarks Installer program" �� XE "Installer program" �. With this installer program, you can install both WinBench 96 and Winstone 96, as well as other programs WinBench 96 requires, at one time. If you’re running Windows 95, the installer program starts automatically if the CD-ROM is in the CD-ROM drive. If you need to start the installer program, execute INSTALL.EXE� XE "INSTALL.EXE" �  from the CD-ROM’s root directory using the File | Run command under Windows.

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

NOTE:	Although you don’t have to install WinBench 96’s files to the default directory, \ZDBENCH\WB96, you should choose the default directory for compatibility with other Ziff-Davis benchmarks.

When the setup program begins installing the files, it displays a status bar to let you know how it’s doing. After installation is complete, WinBench 96 displays a message telling you it’s done.

Installing from diskettes

� XE "Installing:Diskettes" �� XE "WinBench 96:Installing:Diskettes" �To install WinBench 96 from diskettes, run SETUP.EXE from DISK1.

NOTE:	The test files WinBench 96 uses for the CD-ROM and full�motion video tests are very large. Thus, versions of WinBench 96 on diskette do not include these tests.

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

NOTE:	Although you don’t have to install WinBench 96’s files to the default directory, \ZDBENCH\WB96, you should choose the default directory for compatibility with other Ziff-Davis benchmarks.

When the setup program begins installing the files, it displays a status bar to let you know how it’s doing. The setup program prompts you when it’s ready for the next diskette. After installation is complete, WinBench 96 displays a message telling you it’s done.

Installing if you downloaded WinBench 96

� XE "Installing:Downloaded file" �� XE "WinBench 96:Installing:Downloaded file" �When you downloaded WinBench 96, you downloaded the file WINBEN.EXE� XE "WINBEN.EXE" �.

NOTE:	The test files WinBench 96 uses for the CD-ROM and full�motion video tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM, including the versions you can download from CompuServe� XE "CompuServe" � and the World Wide Web� XE "World Wide Web" �, will not contain these tests.

	You can use a Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests. You can find the form at the back on this manual, in the on-line help file, and on the ZD Benchmark forum on CompuServe.

To install WinBench 96, follow these steps:

1.	Copy the WINBEN.EXE file from the directory where you downloaded it to a temporary directory.

NOTE:	The temporary directory must not be the same directory where you plan to install WinBench 96.

2.	Change directories to the temporary directory and run WINBEN.EXE. You can run the file by:

Selecting Run from the File menu in the Program Manager window. Then type the path name of the temporary directory and WINBEN.EXE in the Command Line text box.

Double-clicking on the file name from the File Manager window.

Running WINBEN.EXE extracts the WinBench 96 setup files and places them in the temporary directory. One of these files is SETUP.EXE.

3.	Run SETUP.EXE from the temporary directory.

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

NOTE:	Although you don’t have to install WinBench 96’s files to the default directory, \ZDBENCH\WB96, you should choose the default directory for compatibility with other Ziff-Davis benchmarks.

When the setup program begins installing the files, it displays a status bar to let you know how it’s doing. After installation is complete, WinBench 96 displays a message telling you it’s done.

4.	Delete the temporary directory once the setup program completes.

NOTE:	You may want to copy the WINBEN.EXE file to another directory before you delete the temporary directory so you can install WinBench 96 again if you need to without having to download the file again.

Installing Video for Windows

If the PC under test is running Windows 3.1 or 3.11 or Windows for Workgroups 3.1 or 3.11, you must install Video for Windows� XE "Video for Windows" � � XE "WinBench 96:Installing:Video for Windows" �before you can run any of WinBench 96’s � XE "WinBench 96:Tests:Full-motion video" �� XE "Video tests" �full-motion video tests. (You don’t need to install Video for Windows if the test PC is running Windows 95 or Windows NT.)

To install Video for Windows, run SETUP.EXE from the \VFW\11E directory on the CD�ROM.

Installing Win32s

If you want to run the Processor/32-Bit � XE "32-bit test" �test or the CPUmark™32� XE "CPUmark™32" �, you must install the Win32s subsystem. (You don’t need to install Win32s� XE "Win32s" �� XE "WinBench 96:Installing:Win32s" � if the test PC is running Windows 95 or Windows NT.) There are two versions of Win32s on the CD-ROM—versions 1.1 and 1.25. The version of Win32s you install depends on the operating system running on the test PC.

If the PC is running:�Execute SETUP.EXE from this directory on the CD-ROM:��OS/2� XE "OS/2" ��\WIN32S\11\DISK1��Windows� XE "Windows" � 3.1 or 3.11 or�Windows for Workgroups 3.1 or 3.11�\WIN32S\125\DISK1��End of Chapter

�Chapter 6: �Licensing and Registering WinBench 96

You must license and register the software before you use it. If for any reason you don’t agree to the terms and conditions of the license agreement, return the CD-ROM and anything that came with it to the following address:

Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560

Sections in this chapter

� REF _Ref296749961 \* MERGEFORMAT �Licensing WinBench 96�

� REF _Ref296750256 \* MERGEFORMAT �Registering WinBench 96�

Licensing WinBench 96

� XE "WinBench 96:Licensing" �� XE "Licensing" �� XE "Registering" �Before you can run any of WinBench 96’s tests, you must license and register your copy of the software. The first time you start WinBench 96, it prompts you with its licensing screen.

By licensing WinBench 96, you agree to the requirements and terms of the license agreement displayed on the screen. (You’ll find the same license agreement at the front of this manual and in the README.WRI� XE "README.WRI" � file.) You should read the license agreement carefully before continuing.

To license WinBench 96:

1.	Start WinBench 96 by choosing WinBench 96 from the Ziff-Davis Benchmarks program group. The first time you run WinBench 96, it displays the licensing information.

2.	Read the licensing information. You can use the scroll bar to the right of the license screen to view all the licensing information.

Once you have read the license agreement, you can:

a.	Choose Proceed to continue with the licensing procedure. You must scroll to the end of the license agreement before you can choose Proceed.

b.	Choose Exit to leave the program without licensing WinBench 96.

Registering WinBench 96

If you agree to the terms of the license agreement and choose to continue, WinBench 96 displays its registration window.

To register WinBench 96:

1	Enter your name in the Registration window. You must enter your name to register the software. If you don’t, the program won’t continue.

NOTE:	You can enter a name in the Organization field of this dialog box if you like. The Organization field is optional.

2.	Select Yes to license and register your copy of WinBench 96.

NOTE:	If you don’t agree to the terms of the license agreement, select No. You must then delete all copies of WinBench 96 and return the CD�ROM and any other materials that came with it.

	If you’d like to reread the license agreement, select the Reread License button.

WinBench 96 only prompts you with the license and registration information the first time you run it. The next time you start the program, you won’t need to license and register it again.

End of Chapter

�Part 3: �Running WinBench 96

Chapter 7:	� REF Chapter7BeforeYouRun \* MERGEFORMAT �Before You Run a Test��Lists the things you need to know before you run any WinBench 96 tests.

Chapter 8:	� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window��Explains WinBench 96’s configuration check and how to use the Configuration Information window.

Chapter 9:	� REF Chapter9QuickStart \* MERGEFORMAT �Quick Start—Running the Main Tests and Saving Results��Contains step-by-step, quick instructions on running the main tests and getting some results.

Chapter 10:	� REF Chapter10RunningSuites \* MERGEFORMAT �Running WinBench 96’s Test��Explains in detail how to run WinBench 96.

Chapter 11:	� REF Chapter11ButtonsandMenus \* MERGEFORMAT �What Do All These Buttons and Menus Do?��Includes information on how to use each function button and menu in WinBench 96.

Chapter 12:	� REF Chapter12WorkingwithDisclosure \* MERGEFORMAT �Working with Disclosure Information��Explains how to view and edit Disclosure information.

Chapter 13:	� REF Chapter13WorkingwithCustomSuites \* MERGEFORMAT �Working with Custom Suites��Contains instructions on how to build custom test suites.

�Chapter 7: �Before You Run a Test

Running WinBench 96’s tests can take quite a while. This chapter lists facts you need to know before you start running any tests. Understanding these caveats can save you time later. This chapter also explains how to change WinBench 96’s test settings before you run a test.

Sections in this chapter

� REF _Ref298748781 \* MERGEFORMAT �Don’t get stung by gotchas:  Read these caveats!�

� REF _Ref333120951 \* MERGEFORMAT �Changing test settings�

Don’t get stung by gotchas:  Read these caveats!

� XE "WinBench 96:Caveats" �WinBench 96, like any other software, requires a PC to meet certain conditions. If the PC doesn’t meet these conditions, the test may not finish successfully. Before you run any of WinBench 96’s tests, read the following list of caveats. (A similar list of caveats appears in WinBench 96’s README.WRI� XE "README.WRI" � file.)

1.	You can � XE "WinBench 96:Tests:Interrupting" �� XE "Tests:Interrupting" �� XE "Interrupting a test" �interrupt an executing test or group of tests by pressing the ESC key. If a disk, CD-ROM or video test is executing WinBench 96 will terminate the test in a short period of time. If a graphics or processor test is running, WinBench 96 will finish the currently executing test. WinBench 96 will not execute any other tests in the group.

The currently executing graphics or processor test could take several minutes to complete. The only way to immediately terminate a currently executing test is to use the Ctrl-Alt-Del key combination. If you interrupt WinBench 96 using Ctrl-Alt-Del, you should restart Windows as soon as possible.

2.	SETUP.EXE installs a RESULT96.ZDB� XE "RESULTS.ZDB" � database directory if one does not already exist. We've included sample results from a few machines in our research center.

3.	You can use the following command line options to disable WinBench 96's automatic detection of some disclosure fields.� XE "WinBench 96:Command line options" �� XE "Command line options" �

The NOCPUCHECK� XE "NOCPUCHECK" � � XE "WinBench 96:NOCPUCHECK" �option prevents WinBench 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK� XE "NOVIDCHECK" � � XE "WinBench 96:NOVIDCHECK" �option prevents WinBench 96 from detecting the display refresh rate and graphics adapter types.

The NOREGCHECK� XE "NOREGCHECK" �� XE "WinBench 96:NOREGCHECK" � option prevents WinBench 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK� XE "NOSYSCHECK" � � XE "WinBench 96:NOSYSCHECK" �option disables nearly all detection.

You should use these options if WinBench 96 fails during initialization. The NOVIDCHECK option is useful if display corruption occurs after WinBench 96 initializes.

4.	This release does not accept databases you created or files you exported using WinBench 95. WinBench 96 will display an error message if you use databases or files from WinBench 95.

Changing test settings

� XE "WinBench 96:Tests:Changing test settings" �� XE "Tests:Changing test settings" �� XE "Changing test settings" �� XE "Test settings" �If you’re going to run WinBench 96’s CD-ROM, disk, or video tests, you can change the test settings for these tests using the Test Settings dialog box. The test settings remain in place for all of WinBench 96’s tests until you exit the program. The next time you start WinBench 96, it uses the default test settings.

To change test settings:

1.	Select Settings... from the Edit menu in the main menu bar. WinBench 96 displays its Test Settings dialog box.

2.	Select the group on the left-hand side of the window that corresponds to the settings you wish to change.

When you select one of these groups, WinBench 96 changes the Test Settings dialog box to display the information about that group. For example, if you want to change the drive settings for the CD-ROM and disk tests, select the button to left of Drives. WinBench 96 then changes the display in the dialog box to the Disk and CD-ROM Drives page.

3.	Once you have the settings the way you want, choose the Update Settings button.

If at any point you wish to exit the Test Settings dialog box without saving your changes, choose the Cancel button.

End of Chapter

�Chapter 8: �Using the Configuration Information Window

This chapter explains how to use the Configuration Information window.

Sections in this chapter

� REF _Ref333740485 \* MERGEFORMAT �The different sections of the Configuration Information window�

� REF _Ref333740497 \* MERGEFORMAT �Understanding the Optimization Tips�

� REF _Ref327694797 \* MERGEFORMAT �Using a Custom Configuration File�

� REF _Ref327694563 \* MERGEFORMAT �Disabling WinBench 96’s configuration check�

The different sections of the Configuration Information window

You can use the Configuration Information window� XE "Configuration Information window" �� XE "WinBench 96:Configuration Information window" �� XE "WinBench 96:Configuration check:Optimization Tips" �� XE "WinBench 96:Configuration check:Custom Configuration File" � � XE "Optimization Tips" �� XE "Custom Configuration File" �to check a PC’s configuration to make sure it meets a minimum set of requirements. This window has two sections:

Optimization Tips

Custom Configuration File

When WinBench 96 displays this window, the section that contains any warnings will be on top. For example, if WinBench 96 finds a setting in the PC’s system files that differs from the pre-set list of optimization tips, it will display the Optimization Tips section first. (You can look at the other section if you’d like. Just click on the button at the top of the window that corresponds to the section you wish to view.)

In the top left corner of the Configuration Information window, you’ll find the Options drop�down menu. You can use this menu to tell WinBench 96 what areas to check before running tests (for example, you can have WinBench 96 check the Optimization Tips and nothing else) and to load or unload a custom configuration file.

Understanding the Optimization Tips

� XE "WinBench 96:Configuration check:Optimization Tips" �� XE "Configuration check:Optimization Tips" �When WinBench 96 performs its configuration check, it notes areas where the PC differs from a pre-set list of optimization tips. For example, when you run WinBench 96, the load= option in the [Windows] section of the PC’s WIN.INI� XE "WIN.INI" � file should be empty. So, if load= entry isn’t empty, WinBench 96 lists this difference on the Optimization Tips page.

For information on why a certain setting may cause problems for WinBench 96, highlight the setting in the Configuration Information window and WinBench 96 displays an explanation at the bottom of the window.

Using a Custom Configuration File

� XE "WinBench 96:Configuration check:Custom Configuration File" �� XE "Custom Configuration File" �In addition to comparing the PC to a list of pre-set optimization tips, you can also use a custom configuration file. Then, when WinBench 96 performs its configuration check, it will compare the pre-defined settings in the custom configuration file with the settings the test PC uses. If you’re testing multiple PCs, you can use a custom configuration file to assure that each PC matches the custom settings.

WinBench 96 includes a sample configuration file (SAMPLE.CFG� XE "SAMPLE.CFG" �) in the \ZDBENCH\WB96 directory on the CD-ROM.

� XE "Configuration check:Custom Configuration File, creating" �� XE "WinBench 96:Custom Configuration File:Creating" �� XE "Creating a Custom Configuration File" �To create a custom configuration file, first copy the SAMPLE.CFG file to another file name (for example, CUSTOM.CFG). Then, edit the custom file so it contains the settings you want. (For information on the different settings the SAMPLE.CFG file can contain, see Appendix B, “� REF AppendixBCustomConfigFile \* MERGEFORMAT �The Custom Configuration File�” beginning on page � PAGEREF AppendixBCustomConfigFile �201�.)

� XE "Custom Configuration File:Loading" �� XE "WinBench 96:Custom Configuration File:Loading" �� XE "Loading a Custom Configuration File" �After you’ve edited the custom file and before you run any WinBench 96 tests, go to each PC you want to test and follow the steps below:

1.	Select Run | Configuration Information... from the WinBench 96 main window.

�2.	Select Option | Load custom configuration file... from the Configuration Information window.

WinBench 96 displays the Load Custom Configuration File dialog box.

3.	Enter the directory and file name of the custom file.

4.	Select OK.

After you load the custom file, WinBench 96 continues to check differences between the custom file and the PC under test for the remainder of the current session and in future sessions on that PC until you unload the file.

� XE "Custom Configuration File:Unloading" �� XE "Unloading a Custom Configuration File" �� XE "WinBench 96:Custom Configuration File:Unloading" �To unload a custom configuration file:

1.	Select Run | Configuration Information... from the WinBench 96 main window.

2.	Select Options | Unload custom configuration file from Configuration Information window.

Disabling WinBench 96’s configuration check

� XE "WinBench 96:Configuration check:Disabling" �� XE "Configuration check:Disabling" �� XE "Disabling the configuration check" �You may want to disable the configuration check if you’re running WinBench 96 on the same PC over and over again without changing that PC’s configuration. Once WinBench 96 performs the check and you’re sure the PC is set up correctly, you can then disable the check. You can also tell WinBench 96 to perform only certain portions of its check. For example, you could have the program check a Custom Configuration File but not check for Optimization Tips.

NOTE:	If you change the PC’s configuration at all, you should enable the configuration check. The check is a good way to be certain WinBench 96 will complete the test without problems.

To disable one portion or all of the check:

1.	Select Options | Check before running tests from the Configuration Information window.

2.	From the sub-menu WinBench 96 displays, select those areas you want the program to check. WinBench 96 marks each selection with a check mark.

�If you don’t select any of the items in this list, WinBench 96 doesn’t perform its configuration check.

Until you change these options, WinBench 96 will perform the configuration checks you select for the current session and for future sessions.

End of Chapter

�Chapter 9: �Quick Start—Running the Main Tests and Saving Results

This chapter leads you through the process of running WinBench 96’s main tests, getting results, and saving those results to a database.

� XE "WinBench 96:Main tests" �WinBench 96’s main tests are the:

Graphics WinMark 96� XE "Graphics WinMark 96" �� XE "WinBench 96:Marks:Graphics WinMark 96" ��Disk WinMark 96� XE "Disk WinMark 96" �� XE "WinBench 96:Marks:Disk WinMark 96" ��CD-ROM WinMark 96* � XE "CD-ROM:WinMark 96" �� XE "WinBench 96:Marks:CD-ROM WinMark 96" ��CPUmark32� XE "CPUmark32" �� XE "WinBench 96:Marks:CPUmarks" ��CPUmark16� XE "CPUmark16" �� XE "WinBench 96:Tests:CPUmarks" �

Sections in this chapter

� REF _Ref296758027 \* MERGEFORMAT �The fast version�

� REF _Ref304978815 \* MERGEFORMAT �The detailed version�

The fast version

� XE "WinBench 96:Running:Main tests" �� XE "Running:Main tests" �We’ve written this section with the assumption you’ve installed WinBench 96, it’s ready to run on the PC, and you understand a little about how the program works. If you get confused, the next section, “The detailed version,” explains in more detail the same steps we list here.

NOTE:	Before you run a test, you should, at a minimum, restart Windows. For the most accurate results, however, you should also defragment the PC’s hard disk, restart the PC, and then restart Windows.

To run the main tests:

1.	Choose WinBench 96 in the Ziff-Davis Benchmarks program group to open the main window.

NOTE:	If you haven’t previously licensed WinBench 96, you’ll have to read and agree to the license agreement before you can continue.

2.	Choose the Run button. (When you open the main window, WinBench 96 displays “All Marks” in the list of names to the right of the Run button. So, choosing the Run button runs all the main tests.)

NOTE:	To run the CD-ROM WinMark 96, the CD-ROM that includes WinBench 96 must be in the test PC’s CD�ROM drive.

	If you need to interrupt a test run, press the Esc key.

3.	When the test finishes, choose the Save button from the WinBench 96 functions window.

WinBench 96 displays the Save to Database dialog box.

NOTE:	You must enter a Description for the test run before you can save results. If you haven’t entered a Description, WinBench 96 prompts you for that information before you can continue the save. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy. Once you’ve entered a Description and verified the other fields, choose the Continue with Save button.

4.	Choose the Save button in the Save to Database dialog box.

WinBench 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

NOTE:	You can change the destination database by choosing the Database button in this window.

The detailed version

� XE "WinBench 96:Running:Main tests" �� XE "Running:Main tests" �This section describes the same steps as the previous section in greater detail.

NOTE:	Before you run a test, you should, at a minimum, restart Windows. For the most accurate results, however, you should also defragment the PC’s hard disk, restart the PC, and then restart Windows.

Step 1:  Start WinBench 96

Before you can run any tests, you need to open the main window. To do this, choose WinBench 96 in the Ziff-Davis Benchmarks program group.

NOTE:	If you haven’t previously licensed WinBench 96, you’ll have to read and agree to the license agreement before you can continue.

	If WinBench 96 fails during initialization, you can use the following command line options to disable WinBench 96’s automatic detection of some disclosure fields.

The NOCPUCHECK option prevents WinBench 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK option prevents WinBench 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after WinBench 96 initializes.

The NOREGCHECK option prevents WinBench 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK option disables nearly all detection.

WinBench 96 briefly displays its logo and copyright information before displaying the main window.

Step 2:  Run WinBench 96’s main tests

When you open the main window, WinBench 96 displays “All Marks” in the list of names to the right of the Run button. So, choosing the Run button runs all the main tests.

To run the main tests, choose the Run button.

If you need to interrupt a test run, press any key or click a mouse button (see page � PAGEREF _Ref333131680 �50� for more information).

Step 3:  Save the results

� XE "WinBench 96:Results:Saving" �� XE "Results:Saving" �� XE "Saving" �When a test finishes, WinBench 96 automatically displays the result for that test in the Chart of Results.

To save results:

1.	Choose the Save button from the WinBench 96 functions window.

WinBench 96 displays the Save to Database dialog box.

NOTE:	You can change the destination database by choosing the Database button in this window.

You must enter a Description for the test run before you can save results. If you haven’t entered a Description, WinBench 96 prompts you for that information before you can continue the save. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy.

If you’ve previously run WinBench 96 or one of our other PC benchmarks on the machine and if you installed these benchmarks in the default \ZDBENCH directory, WinBench 96 automatically uses the same Disclosure information you entered before, including the test description. If you’re running the benchmark several times on the same machine, this keeps you from having to enter the same Disclosure information time and time again.

Once you’ve entered a Description and verified the other fields, choose the Continue with Save button from the Save to Database dialog box.

2.	Choose the Save button in the Save to Database dialog box.

WinBench 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

�Step 4:  Exit WinBench 96

� XE "WinBench 96:Exiting" �� XE "Exiting" �You can exit WinBench 96 by:

Choosing the Exit button in the Functions window or using the key sequence Alt�x.

Choosing Exit from the File drop-down menu.

Choosing the Close command from the Control menu for the main window.

If you have unsaved results when you exit, WinBench 96 asks you if you want to save those results.

End of Chapter

�Chapter 10: �Running WinBench 96’s Test

This chapter explains how to run all WinBench 96’s tests, what to do if you need to interrupt a test, and how to save results. It also tells you how to run WinBench 96 in batch mode and demo mode and how to exit WinBench 96.

Sections in this chapter

� REF _Ref303677710 \* MERGEFORMAT �Running the All Marks suite�

� REF _Ref333131680 \* MERGEFORMAT �Interrupting a test run�

� REF _Ref335710332 \* MERGEFORMAT �Saving results�

� REF _Ref333742898 \* MERGEFORMAT �Running selected tests�

� REF _Ref333742898 \* MERGEFORMAT �Running selected tests�

� REF _Ref330197959 \* MERGEFORMAT �Running the full-motion video tests�

� REF _Ref335710353 \* MERGEFORMAT �Hands-free testing:  Running in batch mode�

� REF _Ref336145988 \* MERGEFORMAT �Seeing WinBench 96 in action:  Running demo mode�

� REF _Ref298312713 \* MERGEFORMAT �Exiting WinBench 96�

Running the All Marks suite

� XE "WinBench 96:Main tests" �WinBench 96’s main tests are the:

Graphics WinMark 96� XE "Graphics WinMark 96" ��Disk WinMark 96� XE "Disk WinMark 96" ��CD-ROM WinMark 96� XE "CD-ROM:WinMark 96" ��CPUmark32� XE "CPUmark32" ��CPUmark16� XE "CPUmark16" �

NOTE:	The test files WinBench 96 uses for the � XE "CD-ROM:Tests" �� XE "Tests:CD-ROM tests" �� XE "WinBench 96:Tests:CD-ROM tests" �CD-ROM tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM, will not contain these tests. In addition, some CD-ROM versions of WinBench 96 may not include these tests because of limited space requirements. Versions of WinBench 96 without these tests do not list “CD�ROM WinMark 96” in the list of tests.

	You can use the Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests. You can find this form at the back of this manual, in the on-line help, and on the ZD Benchmark forum on CompuServe.

To run all these tests:

1.	Choose WinBench 96 from the Ziff-Davis Benchmarks program group to open the main window.

NOTE:	If you haven’t previously licensed WinBench 96, you’ll have to read and agree to the license agreement before you can continue.

	If WinBench 96 fails during initialization, you can use the following � XE "WinBench 96:Command line options" �� XE "Command line options" �command line options to disable WinBench 96’s automatic detection of some disclosure fields.

The NOCPUCHECK� XE "NOCPUCHECK" � � XE "WinBench 96:NOCPUCHECK" �option prevents WinBench 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK� XE "NOVIDCHECK" � � XE "WinBench 96:NOVIDCHECK" �option prevents WinBench 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after WinBench 96 initializes.

The NOREGCHECK option prevents WinBench 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK� XE "NOSYSCHECK" � � XE "WinBench 96:NOSYSCHECK" �option disables nearly all detection.

2.	Choose the Run button. (When you open the main window, WinBench 96 displays “All Marks� XE "All Marks" �� XE "WinBench 96:Tests:All Marks" �” in the list of names to the right of the Run button. So, choosing the Run button runs all the main tests.)

NOTE:	To run the CD-ROM WinMark 96, the CD-ROM that includes WinBench 96 must be in the test PC’s CD�ROM drive.

If you want to run individual WinBench 96 tests, see page � PAGEREF _Ref333742898 �51�.

If you want to run WinBench 96 in batch mode, see page � PAGEREF _Ref335710353 �52�.

How long it takes

The time WinBench 96 takes to run the main tests varies based on the PC’s speed and configuration. Here are a few examples to give you an idea of how long it took to run these tests on machines in our research center. Faster machines will take less time, while slower machines will take more time.

A typical:�Took approximately this much time:��Pentium™ 100 with 32MB of RAM and a quad-speed CD-ROM drive.�24 minutes��Pentium 66 with 16MB of RAM and a double-speed CD�ROM drive.�32 minutes��486DX2/66 with 16MB of RAM and a single-speed CD�ROM drive.�1 hour 5 minutes��What the suite does

The All Marks test suite includes each of WinBench 96’s main tests. WinBench 96 runs these tests in alphabetical order.

During the disk and CD-ROM tests, WinBench 96 displays a progress meter, and when WinBench 96 completely fills the meter, the test is over. WinBench 96 also displays status messages in the bottom, right corner of the main window to tell you what it is doing during the CD-ROM and disk tests.

When WinBench 96 runs a graphics test, you’ll see many types of shapes, pictures, and text all over the PC’s screen. WinBench 96 also displays status messages in the bottom, right corner of the Test Screen to tell you what it is doing.

During the processor tests, WinBench 96 displays a status message box that tells you what test it is running and the maximum amount of time it will take to run the test. WinBench 96 also displays status messages in the bottom, right corner of the main window to tell you what it is doing.

If you’d like to understand what happens when WinBench 96 runs a test, see page � PAGEREF _Ref336240865 �133�.

What you’ll have when WinBench 96 is through

When all the tests in the All Marks suite finish, WinBench 96 automatically displays the results for each of the main tests in the Chart and Table of Results. For information on how to interpret information in the Chart and Table of Results, see page � PAGEREF _Ref336157887 �107�.

Interrupting a test run

If you need to interrupt a test run, press the Esc key. WinBench 96 halts the current test and cleans up any test files.

NOTE:	It may take a while for WinBench 96 to halt the current test. To immediately halt the currently running test, use Ctrl-Alt-Del.

	If you halt a test before it is complete, WinBench 96 will not produce results for that test.

Saving results

� XE "WinBench 96:Results:Saving" �� XE "Results:Saving" �� XE "Saving results" �After WinBench 96 finishes a test, it automatically displays that test’s results in the Chart and Table of Results windows.

To save results:

1.	Choose the Save button from the WinBench 96 functions window.

WinBench 96 displays the Save to Database dialog box.

NOTE:	You must enter a Description for the test run before you can save results. If you haven’t entered a Description, WinBench 96 prompts you for that information before you can continue the save operation. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy. After you’ve entered a Description and verified the other fields, choose the Continue with Save button.

	If you’ve previously run WinBench 96 or one of our other PC benchmarks on the machine and if you installed these benchmarks in the default \ZDBENCH directory, WinBench 96 automatically uses the same Disclosure information you entered before, including the test description. If you’re running the benchmark several times on the same machine, this keeps you from having to enter the same Disclosure information time and time again.

2.	Choose the Save button in the Save to Database dialog box.

WinBench 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

NOTE:	You can change the destination database by choosing the Database button in this window.

Running selected tests� XE "WinBench 96:Running:Selected tests" �� XE "Selected tests:Running" �� XE "Running:Selected tests" �

In addition to running the WinMark 96 tests and other built�in WinBench 96 suites, you can run selected suites and tests using the Select Tests dialog box. You can display this dialog box in two ways:

Choose Selected... from the drop-down list to the right of the Run button.

Choose Select and Run Tests... from the Run menu.

Either option opens WinBench 96’s Select Tests dialog box.

To add a suite or test to the list of Selected Tests:

1.	Select the name of the suite or test.

2.	Choose the Add button. (You can also just double-click on the name to add it to the list of Selected Tests.)

To delete names from the list, use the Remove and Remove All buttons. The Remove button deletes only the highlighted names in the list. The Remove All button deletes all the names from the list.

3.	Choose OK after you’ve got the list under Selected Tests the way you want it.

NOTE:	If you opened the Select Tests dialog box using Select and Run Tests... in the Run menu, WinBench 96 runs the tests under Selected Tests as soon as you choose OK.

	If you opened the Select Tests dialog box by choosing Selected... from the list to the right of the Run function button, WinBench 96 returns you to its main window. To start the tests, choose Run.

Running the full-motion video tests

To run a video test, you use the Select Tests dialog box. (For information on using this dialog box, see the previous section, “� REF _Ref333742898 \* MERGEFORMAT �Running selected tests�.”)

NOTE:	To run a video test, you must have the CD-ROM that contains WinBench 96 in the drive. The new video tests require a particular set of AVI clips located on the CD�ROM.

From the Select Tests dialog box, add the video test name(s) you wish to run. (There is no weighted Mark suite for the video tests.) Each video test name begins with the word “Video.” To find out what a video test name can tell you about the test, see page � PAGEREF _Ref337270898 �164�.

Hands-free testing:  Running in batch mode

� XE "WinBench 96:Running:Batch mode" �� XE "Running:Batch mode" �� XE "Batch mode:Running" �You don’t have to sit at the PC and click the buttons to run WinBench 96’s tests. To make the best use of your time, you may decide to run WinBench 96 in batch mode. When you run WinBench 96 this way, it gets the information it needs to run the tests from a file called RUNWB.INI� XE "RUNWB.INI" �. This file supplies the environment settings, the names of the tests WinBench 96 will run, and the names for the database files it produces. WinBench 96 installs a prototype RUNWB.INI file in its main directory (by default \ZDBENCH\WB96).

NOTE:	You can only use the WinBench 96 RUNWB.INI file with WinBench 96. WinBench 95 won’t accept this file format.

1.	Copy the RUNWB.INI prototype file to another file name (for example, MYFILE.INI).

2.	Edit the new file so it contains the information WinBench 96 needs.

You can use any text editor to modify this file. You can also use the StepN section(s) of this file to refer to custom test suite files that define a set of tests to run in that step. (See the section “� REF _Ref300382296 \* MERGEFORMAT �Creating custom suites�” on page � PAGEREF _Ref300382296 �89� for more information.)

For complete information on the different sections of the RUNWB.INI file you can modify, see page � PAGEREF _Ref335710583 �53�.

3.	After you’ve edited and saved the new file, run WinBench 96 with the AUTO command option and specify the name of the new file.

For example, if MYFILE.INI is the edited copy of the prototype file, you’d use the following command line:

WB96 AUTO MYFILE.INI

How you execute WinBench 96 depends on the Windows shell you’re using.

If you’re using Program Manager, select Run from the Program Manager File menu. Use the Browse feature to enter the WinBench 96 command line, and then add the AUTO option and the name of the .INI file to that command line.

If you’re using Explorer, select Run from the Start menu. Use the Browse feature to enter the WinBench 96 command line, and then add the AUTO option and the name of the .INI file to that command line.

If you want to automate this process so WinBench 96 runs in batch mode each time Windows starts, you can add WinBench 96 with the AUTO command line option and the name of the .INI file to the Windows StartUp group.

The next section explains in detail the different parameters within the RUNWB.INI prototype file that you can modify.

Modifying the RUNWB.INI file� XE "Batch mode:Modifying RUNWB.INI" �� XE "WinBench 96:RUNWB.INI:Modifying" �� XE "RUNWB.INI" �� XE "Running:Batch mode:RUNWB.INI" �� XE "WinBench 96:Running:Batch mode:RUNWB.INI" �

You need to modify the following information in RUNWB.INI:

Environment settings.

The path name of the suites you want to run.

Names of the results files you want to save (you can have up to three).

The sections that follow explain the fields in each of these sections of the RUNWB.INI file.

The [Environment] fields� XE "RUNWB.INI:[Environment] fields" �

Normally WinBench 96 remembers any changes you make to the environment settings using the Disclosure Questionnaire in the DISCLOSE.INI� XE "DISCLOSE.INI" � file. You can override the settings in the DISCLOSE.INI file by copying entries from the ChangedByUser or NotChangedByUser sections in that file to the [Environment] section of the RUNWB.INI and then modifying those entries.

�In addition, you can use the following DOS environment variables to override some of the entries in DISCLOSE.INI.

Entry�Environment Variable��PIN�PIN��Variant1�VARIANT1��Variant2�VARIANT2��Variant3�VARIANT3��Variant4�VARIANT4��Variant5�VARIANT5��Project�PROJECT��Tester Name�TESTER��Tester Organization�TESTORG��The [Environment] section also contains options for WinBench 96’s Refresh Rate, Cursor Type, and Color Reproduction tests. These tests, with your help, can determine an appropriate value for the following fields. You can enable these tests by removing the semicolon (;) at the beginning of each line.

;Display Refresh Rate=Determine With Test�;Display Cursor Type=Determine With Test�;Display Color Reproduction=Determine With Test

The [Options] fields� XE "RUNWB.INI:[Options] fields" �

The second part of the RUNWB.INI file contains the [Options] fields.

The first field lets you set whether WinBench 96 exits Windows when it finishes running in batch mode. Setting ExitWindows to True means WinBench 96 will exit Windows when the suite finishes. The default value for this setting is False, so WinBench 96 normally exits and leaves Windows running.

ExitWindows=False

The next field lets you set whether WinBench 96 quits (closes its main window) when it finishes running the tests. Setting ExitBenchmark to True causes WinBench 96 to exit when it completes the test(s). The default value is True.

ExitBenchmark=True

The next field is DemoMode. You can use this option to run WinBench 96’s demo mode in batch mode Setting DemoMode to True causes WinBench 96 to run the suite specified in the first step in demo mode. The default value is False.

WinBench 96 won’t save any results when it runs in demo mode, and it’ll ignore the ExitBenchmark and ExitWindows settings, as well as all sections named [StepN], where N is larger than 1.

DemoMode=False

The final fields in the [Options] section concerns the Custom Configuration window. Setting the following options to Yes causes WinBench 96 to check the Configuration Information. The default value for each option is No.

Display tips before testing=No�Display custom configuration before testing=No

If you enable the custom configuration above, you must supply the full path name of the custom configuration file in the next item.

Custom configuration file=pathname

The [Messages] field

The third section of the RUNWB.INI file contains the [Messages] field. This field contains a time-out value in seconds and a string WinBench 96 displays in a message box after it starts. This field is optional. A time-out value of 0 means WinBench 96 displays the message box until you close it.

NOTE:	WinBench 96 replaces tilde characters (~) with line breaks in the actual message box.

InitMessage=10,WinBench 96 is starting.

The [StepN] fields� XE "RUNWB.INI:[StepN] fields" �

The last section in the RUNWB.INI file is the [StepN] section. You can repeat this section as many times as you want, with N starting at 1 and increasing

Each [StepN] section lists a file name. The file listed specifies which WinBench 96 tests to run, options WinBench 96 uses during those tests, and the names of the results files to save. You can also specify comparison machines you wish to use in the Chart and Table of Results. This option is useful, however, only in the last [StepN] section.

The first field in each [StepN] section is the Suite= field. This field specifies the path name of the file that contains the list of tests to run and/or display. Every [StepN] must have a Suite= setting.

The file CUSTOM.WBS in WinBench 96’s SUITES subdirectory lists all of WinBench 96’s tests. We’ve included this file name in the RUNWB.INI file as an example.

Suite=c:\zdbench\wb96\suites\custom.wbs

To create your own custom suites, select Create from the Suite menu in WinBench 96’s main window.

The next fields let you supply a Description and Comments for the custom test files you define in each StepN section. WinBench 96 adds the information in these fields to your results file. (If you were running the test interactively, you’d change these fields using the Disclosure Questionnaire.)

Description=Tester Must Supply�Comments=Tester Must Supply

The next field specifies whether you want WinBench 96 to clear its results for one step before running another. If you set ClearResults to False, WinBench 96 won’t clear results between each StepN. The default value is True, meaning WinBench 96 forgets all previous results at the start of each step.

ClearResults=True

The next field lets you prevent WinBench 96 from running the test specified in the step. If you set DontRunTests to True, WinBench 96 won’t run the tests listed in the file name specified by the Suite= option. You might find this option useful if you want to display results from comparison machines without actually running the tests. The default value is False, meaning WinBench 96 will run the test listed in the file specified by the Suite= option.

DontRunTests=False

The next field, CompareN, lets you specify up to five comparison machine results files you wish to use in the Table and Chart of Results. These settings are all optional.

Compare1=exports\results1.txt�Compare2=exports\results2.txt�Compare3=exports\results3.txt�Compare4=exports\results4.txt�Compare5=exports\results5.txt

The next field lets you prevent WinBench 96 from displaying the current results in the Chart of Results. If you set IncludeResults to False, WinBench 96 does not display the current results. You must specify at least one comparison machine to exclude the current results from the Chart of Results. The default value is True, meaning WinBench 96 displays the current results in the Chart of Results.

IncludeResults=True

The next fields, StartMessage and EndMessage, each contain a time�out value in seconds and a string WinBench 96 displays in a message box at the beginning and end of the step. Both messages are optional. If you set the time�out value to 0, WinBench 96 displays the message box until you close it. (WinBench 96 replaces any tilde characters (~) in the message with line breaks in the actual message box.)

StartMessage=10,WinBench 96 is about to start running the custom suite.�EndMessage=10,WinBench 96 has saved the results in the file ~ RESULTS.TXT.

The next section of the RUNWB.INI file lets you define test settings for the tests specified in the Suite= option. WinBench 96 first looks for a setting of the form test�name:setting�name. If it doesn’t find that setting, WinBench 96 looks for the more generic setting�name. If it doesn’t find that setting, WinBench 96 uses the default setting.

The Disk Drive setting specifies which drive WinBench 96 should use for all of the disk tests.

Disk Drive=C

The CD-ROM Drive setting specifies which drive WinBench 96 should use for all of the CD�ROM and Video tests.

CD-ROM Drive=D

�The Video settings options controls how WinBench 96 plays video clip files. Some; settings have special values. For example the Playback Directory setting can be a path name (for example, C:\TEMP) or the constant DoNotCopyBeforePlay to specify that WinBench 96 should play the video clip from the CD-ROM. You can use the following options for Video settings:

Video:Playback Directory	Directory path to which WinBench 96 copies the video clips and from which WinBench 96 plays the video clips or DoNotCopyBeforePlay. This setting lets you run the video clips from a local or network drive instead of a CD�ROM drive.

Video:Compute FPS	Enables or disables WinBench 96’s computation of the maximum display rate (frames per second). Valid values are Yes and No. The default value is Yes.

Video:Compute Utilization	Enables or disables WinBench 96’s computation of the CPU utilization. Valid values are Yes and No. The default value is Yes.

For example, the following setting tells WinBench 96 to copy all video clips to the TEMP directory on drive C before playing them.

Video:Playback Directory=C:\TEMP

The next settings in the RUNWB.INI file are only valid for the User Supplied Video Clip video test. You must specify the Video Clip Path setting for the User Supplied Video Clip test.

Video/User Supplied Video Clip:Video Clip Path�The path(s) to the video clip file(s) you want WinBench 96 to play. You should separate each path and file name with semicolons (;).

Video/User Supplied Video Clip:Scale Factor�Lists the X,Y scale factors or FullScreen. For example “0.5,0.5” plays the movie at half its original size. The default is “1,1”. FullScreen scales the movie to completely fill the WinBench 96 main window.

Video/User Supplied Video Clip:Alignment�Specifies the X and Y alignment of the window. A value of 0 aligns the video clip window on an 8-pixel boundary. A value of 7 aligns the window 7 pixels to the right or below an 8-pixel boundary. The default value is “0,0”.

Video/User Supplied Video Clip:Clipping Windows�A string in the form “N,X,Y,WIDTH,HEIGHT” where N is the video clip index (1-4) the window is relative to; X and Y are the window coordinates specified as percentages of the movie size; WIDTH and HEIGHT are the window size specified as percentage of the video clip size. For example “1,0,0,50,100” creates a window that would clip the left half (50% width, Full height) of the first video clip. The default value “0,0,0,0,0” uses no clipping windows.

For example, the following tells WinBench 96 to play the video clip file C:\AVI\TEST.AVI when you run the User Supplied Video Clip test, scale the video clip by a factor of two in height and width, play the video clip in an unaligned window, and use a clipping window.

Video/User Supplied Video Clip:Video Clip Path=C:\AVI\TEST.AVI�Video/User Supplied Video Clip:Scale Factor=2,2�Video/User Supplied Video Clip:Alignment=1,1�Video/User Supplied Video Clip:Clipping Windows=1,0,0,50,100

The next field lets you specify the path name of the database where you wish to save the results file for the step. If you want to save results in a database, uncomment the Database field and supply the path name of the database directory.

;Database=c:\zdbench\result96.zdb

The final field in the StepN section tells WinBench 96 what to name the results file for that particular step. Using these fields, you can produce three types of result files or any subset of the results files you like.

TextFile=exports\results.txt�XLSFile=exports\results.xls�CSVFile=exports\results.csv

Seeing WinBench 96 in action:  Running demo mode

� XE "WinBench 96:Running:Demo mode" �� XE "Demo mode" �� XE "Running:Demo mode" �Once you install WinBench 96, you can run it in a demonstration mode. Demo mode offers a way to run WinBench 96 repeatedly without manual intervention. You may find demo mode useful if you want to show WinBench 96 to groups of people (for example, at a trade show or office gathering) or if you just want to see what the benchmark can do.

To run WinBench 96 in demo mode, select Demo Mode from the Run menu in the main window.

When you run WinBench 96 in demo mode, it runs the test currently selected in the list of test names to the right of the Run function button, displays that test’s results, and then runs the same test over and over again. For example, if you have the Graphics WinMark 96 test suite selected, WinBench 96 runs just that suite for the demo.

WinBench 96 continues to run in demo mode until you stop it by pressing the Esc key.

NOTE:	Every time you start a WinBench 96’s test, even when you’re running the benchmark in demo mode, WinBench 96 automatically runs its configuration check. If you haven’t disabled the configuration check, WinBench 96 automatically displays the Configuration Information window before running the test.

	For more information on the Configuration Information window, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�,” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.

Exiting WinBench 96

� XE "Exiting" �� XE "WinBench 96:Exiting" �You can exit WinBench 96 from its main window by:

Choosing the Exit button or using the key sequence Alt�x.

Choosing Exit from the File drop-down menu.

Choosing the Close command from the Control menu for the main window.

End of Chapter

�Chapter 11: �What Do All These Buttons and Menus Do?

This chapter lists the standard conventions of the WinBench 96 user interface. It also describes each of WinBench 96’s menu items and function buttons and explains the basics of what happens when you choose one of these items.

Sections in this chapter

� REF _Ref298750635 \* MERGEFORMAT �Standard conventions WinBench 96 uses�

� REF _Ref298750676 \* MERGEFORMAT �Opening the main window�

� REF _Ref298751157 \* MERGEFORMAT �Using the menu bar�

� REF _Ref298751138 \* MERGEFORMAT �Using the Functions buttons�

� REF _Ref299438944 \* MERGEFORMAT �Using the icons in WinBench 96’s main window�

Standard conventions WinBench 96 uses

� XE "WinBench 96:Standard Windows conventions" �� XE "Windows conventions" �When you work with WinBench 96’s windows, screens, and menus, you can use some standard conventions for Windows with which you may already be familiar. For example:

Clicking and double-clicking (pressing a mouse button twice very quickly) to select items. Generally, if you click on an item, such as a name in a list, you’re selecting that item and WinBench 96 highlights it. If you double�click on an item, WinBench 96 takes an action associated with that item.

Using drop-down menus� XE "Drop-down menus" � from the main menu bar in a window. WinBench 96 presents some of its options as menu titles in the main menu bar. When you select one of these menu titles, such as File, a drop-down menu appears displaying the menu items available. In some cases, the drop-down menus duplicate actions you can perform using WinBench 96’s functions buttons. In most cases, the drop�down menus give you additional options, such as changing the test settings before you run a test and getting information on how to contact us.

Resizing and moving windows� XE "Resizing and moving windows" �. You can minimize, maximize, and resize most of WinBench 96’s windows, such as the WinBench 96 Chart and Table of Results, the same way you work with other windows now.

Using keyboard commands� XE "Keyboard commands" � to select items instead of using the mouse. Press the Alt key and the underlined access character of the item you want to select. This item can be one of the WinBench 96 function buttons, a menu title, a menu item within a drop-down menu, or a button within a window.

Opening the main window

� XE "WinBench 96:Opening the main window" �� XE "Main window:Opening" �� XE "Opening the main window" �To open the main window, choose WinBench 96 in the Ziff�Davis Benchmarks program group� XE "Ziff�Davis:Program group" �.

NOTE:	The first time you start WinBench 96, you’ll need to � XE "WinBench 96:Licensing" �license and register the software. The licensing information screens are pretty much self�explanatory.

	If WinBench 96 fails during initialization, you can use the following � XE "WinBench 96:Command line options" �command line options to disable WinBench 96’s automatic detection of some disclosure fields.

The NOCPUCHECK� XE "NOCPUCHECK" � � XE "WinBench 96:NOCPUCHECK" �option prevents WinBench 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK� XE "NOVIDCHECK" � � XE "WinBench 96:NOVIDCHECK" �option prevents WinBench 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after WinBench 96 initializes.

The NOREGCHECK option prevents WinBench 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK� XE "NOSYSCHECK" � � XE "WinBench 96:NOSYSCHECK" �option disables nearly all detection.

When you start WinBench 96, it briefly displays its logo and About box before displaying the main window.

�� XE "WinBench 96:Main window" �� XE "Main window" �WinBench 96’s main window essentially contains the following parts:

The main menu bar� XE "Menu bar" �.

The Functions window� XE "Functions window" �.

WinBench 96’s icons.� XE "WinBench 96:Icons" �

The rest of this chapter explains what the different menus and buttons do when you choose them.

Using the menu bar

WinBench 96’s main menu bar contains several menu options.

NOTE:	The Chart menu option only displays when you have the Chart of Results open.

In some cases, you can perform the same actions using WinBench 96’s functions buttons. In most cases, you can use the menu bar options to perform tasks not defined in the Functions window, such as changing the test settings before you run a test or starting demo mode.

The sections that follow explain each of the menu options from left to right as they appear on the menu bar.

The File menu

� XE "Menu bar:File" �� XE "WinBench 96:Menus:File" �� XE "File" �If you choose File, you’ll see the following options in the drop-down menu.

Save...

� XE "File:Save" �� XE "WinBench 96:Menus:File:Save" �The Save... option in the File menu performs the same function as the Save button in the Functions window. When you choose this option, WinBench 96 displays the Save to Database dialog box. You can use this dialog box to save the current results to a database. You can also select another database using the Database... button in the Save to Database dialog box.

For more information on how to save results and use this window, see page � PAGEREF _Ref298743402 �99�.

Compare...

� XE "File:Compare" �� XE "WinBench 96:Menus:File:Compare" �The Compare... option in the File menu performs the same function as the Compare function button. When you choose this option, WinBench 96 displays the Comparison Machines dialog box. You use this dialog box to select which results you want to display. You can select results from a database, or you can import files you exported in previous WinBench 96 sessions.

For complete information on how to view results for different PCs, see the section “� REF _Ref336245534 \* MERGEFORMAT �Adding results to the display�” on page � PAGEREF _Ref336245534 �101�.

Export

� XE "File:Export" �� XE "WinBench 96:Menus:File:Export" �When you choose Export from the File menu, WinBench 96 displays the Export submenu.

� XE "WinBench 96:Results:Exporting" �� XE "Results:Exporting" �� XE "Exporting results" �The following chart explains what kind of results files you can export.

You can export:�Which contains:�In this format:��Current Results�Results and Disclosure for the tests run in the current session�.TXT, .CSV, or .XLS��Chart of Results�Results the Chart of Results currently displays�.WMF��Table of Results�Results currently listed in the Table of Results�.TXT��Disclosure�Information currently listed in the Disclosure window�.TXT��Test Screen* �The last image WinBench 96 displayed in the Test Screen�.BMP��Choosing any of the above options displays the Export Results to File dialog box. For more information on using this dialog box, see page � PAGEREF _Ref298744197 �105�.

Print Setup...

� XE "File:Print Setup" �� XE "WinBench 96:Menus:File:Print Setup" �Choosing the Print Setup... option opens the Print Setup dialog box.

From this dialog box, you can change the printer, paper source, paper size orientation, number of copies you’d like to print, and other printer options. For more information on how to use a printer setup dialog box, consult your Windows operating system documentation.

Print

� XE "File:Print" �� XE "WinBench 96:Menus:File:Print" �When you choose Print from the File menu, the Print submenu appears.

The Print submenu lets you select whether you want to print the Current Results, the Chart or Table of Results, or the Disclosure information. WinBench 96 prints the item you choose to the currently selected default printer.

For details on WinBench 96’s Print options, see page � PAGEREF _Ref336749130 �104�.

Merge Databases...

� XE "File:Merge Databases" �� XE "WinBench 96:Menus:File:Merge Databases" �When you choose Merge Databases... from the File menu, WinBench 96 displays the Merge Database dialog box. You use this dialog box to specify the target and source databases for two databases whose records you want to merge. For more information on how to use this dialog box, see page � PAGEREF _Ref333895517 �104�.

Delete...

� XE "File:Delete" �� XE "WinBench 96:Menus:File:Delete" �If you choose Delete... from the File menu, WinBench 96 displays the Delete Results from Database dialog box. WinBench 96 lets you delete individual records from its database of results. For information on how to use this dialog box, see page � PAGEREF _Ref299772795 �103�.

Exit

� XE "File:Exit" �� XE "WinBench 96:Menus:File:Exit" �Choosing Exit from the File menu performs the same function as choosing the Exit function button. When you choose Exit, WinBench 96 restores the PC’s pre-test environment, closes the main window, and quits the program.

NOTE:	If you haven’t yet saved your results, WinBench 96 warns you before it exits and gives you a chance to save those unsaved results.

The Edit menu

� XE "Menu bar:Edit" �� XE "WinBench 96:Menus:Edit" �If you choose Edit, you’ll see the following options in the drop-down menu.

Copy

� XE "Edit:Copy" �� XE "WinBench 96:Menus:Edit:Copy" �� XE "WinBench 96:Copying results to the Windows clip board" �� XE "Copying results to the Windows clip board" �The Copy option lets you copy information from the active window to the clipboard. If you have the Chart or Table of Results, Test Screen, or Disclosure windows open, the Copy option is active (you can select it). Otherwise, this menu option is dimmed (you can’t select it).

Display

� XE "Edit:Display" �� XE "WinBench 96:Menus:Edit:Display" �You can use the Display menu to change the way WinBench 96 displays its results. When you select this option, WinBench 96 displays the following submenu:

� XE "WinBench 96:Results:Display options" �The following chart explains each of the Display menu options.

Choosing this option:�Displays results for:��All Test�All its tests.��All Marks�The Graphics, Disk, and CD�ROM WinMark 96 suites and the CPUmark16 and CPUmark32 tests.��Tests Run�Tests run during the current WinBench 96 session.��Selected Tests�The tests as specified in the drop-down list of tests to the right of the Run function button. For example, if the drop-down list displays “All Marks,” then WinBench 96 would display the results for its Graphics, Disk, and CD-ROM WinMark 96 suites and the CPUmark16 and CPUmark32 suites.��Clear Current Results

� XE "Edit:Clear Current Results" �� XE "WinBench 96:Menus:Edit:Clear Current Results" �Choosing the Clear Current Results option removes all the results for the current session from the display. If you’ve saved all the results for the current session, this option doesn’t delete those results from the database. It just removes the results from the Chart and Table of Results, so you don’t see them any more.

To delete results permanently from the results database, use the Delete... option from the File drop-down menu or consult the section “� REF _Ref298818419 \* MERGEFORMAT �Deleting results permanently from the database�” on page � PAGEREF _Ref298818428 �103� for complete information on this option.

Disclosure Questionnaire...

� XE "Edit:Disclosure Questionnaire" �� XE "WinBench 96:Menus:Edit:Disclosure Questionnaire" �When you select Disclosure Questionnaire... from the Edit menu, WinBench 96 displays the Disclosure Questionnaire� XE "Disclosure Questionnaire" �. From this window, you can edit the Disclosure information about the test PC. For more information, see page � PAGEREF _Ref298830710 �78�.

Settings...

� XE "Edit:Settings" �� XE "WinBench 96:Menus:Edit:Settings" �When you select Settings... from the Edit menu, WinBench 96 displays its Test Settings dialog box. If you’re going to run WinBench 96’s CD-ROM, disk, or video tests, you can change the test settings for these tests using the Test Settings dialog box. For information on how to use this dialog box, see page � PAGEREF _Ref333120951 �34�.

The Run menu

� XE "Menu bar:Run menu" �� XE "WinBench 96:Menus:Run" �If you choose Run in the menu bar, you’ll see the following options in the drop�down menu.

Configuration Information...

� XE "Run:Configuration Information" �� XE "WinBench 96:Menus:Run:Configuration Information" �When you run a test, WinBench 96’s configuration check makes sure the PC meets a minimum set of requirements and reports any areas that may cause the test to fail in the Configuration Information window.

When you select Configuration Information... from the Run menu, WinBench 96 displays the Configuration Information window. For details on how to use this window, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.

Marks

� XE "Run:Marks" �� XE "WinBench 96:Menus:Run:Marks" �When you choose Marks from the Run menu, WinBench 96 displays a submenu.

To run one of the Marks, choose the test name from the submenu. To run all the Marks, select All. For more information on running these tests, see page � PAGEREF _Ref335789974 �47�.

All Tests

� XE "Run:All Tests" �� XE "WinBench 96:Menus:Run:All Tests" �If you select All Tests from Run menu, WinBench 96 runs all its tests, in alphabetical order, one after the other.

Select and Run Tests

� XE "Run:Select and Run Tests" �� XE "WinBench 96:Run:Select and Run Tests" �If you choose Select and Run Tests... from the Run menu, WinBench 96 displays its Select Tests dialog box. From this box, you can specify exactly which suites or tests you want WinBench 96 to run. For more information on selecting and running tests, see page � PAGEREF _Ref333742898 �51�.

Demo Mode

� XE "Run:Demo Mode" �� XE "WinBench 96:Menus:Run:Demo Mode" �When you run WinBench 96 in demo mode, it runs the suite or selected set of tests currently displayed in the list of names to the right of the Run function button, displays those results, and then restarts the same test. WinBench 96 continues to run in demo mode until you stop it by pressing the Esc key. For more information on running demo mode, see page � PAGEREF _Ref299769605 �55�.

The Suite menu

� XE "Menu bar:Suite" �� XE "WinBench 96:Menus:Suite" �You use the Suite menu to create, load, edit, and delete custom suite files.

Create...

� XE "Suite:Create" �� XE "WinBench 96:Menus:Suite:Create" �When you select Create... from the Suite menu, WinBench 96 displays the Create Custom Suite dialog box. You use this dialog box to specify which suites and/or tests you want in your custom suite file. For more information on how to use this dialog box to create your own suite files, see page � PAGEREF _Ref300382296 �89�.

Load...

� XE "Suite:Load" �� XE "WinBench 96:Menus:Suite:Load" �When you select Load... from the Suite menu, WinBench 96 displays the Load Suite from File dialog box. You use this dialog box to add a custom suite file name to the list of available suites to the right of the Run function button. For information on how to add a custom suite’s name to the list of available suites, see page � PAGEREF _Ref300392066 �92�.

Edit...

� XE "Suite:Edit" �� XE "WinBench 96:Menus:Suite:Edit" �When you choose Edit... from the Suite menu, WinBench 96 displays the Edit Custom Suite dialog box.

NOTE:	You must select a custom suite name from the list of available suites before you can select Edit. WinBench 96 doesn’t let you edit its built�in test suites.

You use this dialog box to change the suites and/or tests included in your custom suite. For more information, see page � PAGEREF _Ref300392007 �91�.

Delete

� XE "Suite:Delete" �� XE "WinBench 96:Menus:Suite:Delete" �You can use the Delete option from the Suite menu to remove a custom suite name from the list of available suites to the right of the Run function button.

First, you’ll need to select the name of the suite you wish to remove from the list. Then, when you select Delete, WinBench 96 prompts you with a message confirming you want to remove the suite name.

To remove the suite name from the list, select “Yes.” WinBench 96 doesn’t permanently delete the suite file from the PC. To permanently delete the suite file, you’ll need to use the Windows file manager or the DEL command from the DOS command line.

The Test Screen menu

� XE "Menu bar:Test Screen" �� XE "WinBench 96:Menus:Test Screen" �WinBench 96 only displays the Test Screen menu when the Test Screen window is open. � XE "Test Screen" �To visually compare screen images, you use the following options.

You use these options to select which of the three drawing surfaces you want to see (the screen, the color memory bitmap, or the monochrome memory bitmap). You can only view one drawing surface at a time, so if you select the Color Bitmap option, you deselect the Screen option.

You may not be able to select all of these options for each test you run. The options you can choose depend on which drawing surface(s) the last test you ran used. By default, WinBench 96 displays the Screen surface after a test.

The Chart menu

� XE "Menu bar:Chart" �� XE "WinBench 96:Menus:Chart" �� XE "Chart of Results" �� XE "WinBench 96:Results:Chart of Results" �WinBench 96 only displays the Chart menu when the Chart of Results is active. You can use the Chart menu to include or not include results from the current test run in the Chart’s display.

If you choose the Chart menu, you get the following options in its drop-down menu.

Include Current Results

� XE "Chart:Include Current Results" �� XE "WinBench 96:Menus:Chart:Include Current Results" �If you turn on Include Current Results from the Chart menu, WinBench 96 always includes the results from the current test run in its display. Include Current Results is turned on when there’s a check mark to the left of the menu option.

Normalized

� XE "Chart menu:Normalized" �� XE "WinBench 96:Menus:Chart:Normalized" �� XE "WinBench 96:Normalizing results in the display" �� XE "Normalizing results in the display" �If you select Normalized from the Chart menu, WinBench 96 displays most results as a percentage of the results for a baseline machine. By default, the baseline machine is the current set of results. You can set the baseline machine to any set of results currently displayed. For more information, see page � PAGEREF _Ref301331688 �100�.

Absolute

� XE "Chart menu:Absolute" �� XE "WinBench 96:Menus:Chart:Absolute" �If you turn on Absolute from the Chart menu, WinBench 96 displays the absolute results for its tests instead of displaying the results as a percentage. Absolute is on when there’s a check mark to the left of the menu option.

Baseline...

� XE "Chart menu:Baseline" �� XE "WinBench 96:Menus:Chart:Baseline" �� XE "Baseline machine" �� XE "WinBench 96:Baseline machine" �When you select Baseline... from the Chart menu, WinBench 96 displays the Baseline Machine dialog box.

NOTE:	To select Baseline... from the Chart menu, the Chart of Results must be open and you must have normalized results displayed in the chart. Otherwise, the Baseline... option is dimmed (you can’t select it).

This dialog box lets you change the machine to which WinBench 96 normalizes other machine’s results—the baseline machine. You can select any set of results WinBench 96 is currently displaying as the baseline machine. For more information, see page � PAGEREF _Ref301331688 �100�.

The Window menu

� XE "Menu bar:Window" �� XE "WinBench 96:Menus:Window" �The Window menu lets you manipulate and arrange WinBench 96’s windows. If you choose Window in the menu bar, you’ll see the following options in the drop-down menu.

Arrange Windows

� XE "Window:Arrange Windows" �� XE "WinBench 96:Menus:Window:Arrange Windows" �Choosing Arrange Windows layers WinBench 96’s open windows in a cascading manner, one on top of the other.

Arrange Icons

� XE "Window:Arrange Icons" �� XE "WinBench 96:Menus:Windows:Arrange Icons" �Choosing Arrange Icons lines up WinBench 96’s icons in the lower, left-hand corner of WinBench 96’s main window.

1-5

You can select the WinBench 96 window you want to make active from the list of windows numbered one through five.

The Help menu

� XE "Menu bar:Help" �� XE "WinBench 96:Menus:Help" �If you choose Help from the menu bar, you’ll see the following options in the drop�down menu.

Contents

� XE "Help:Contents" �� XE "WinBench 96:Menus:Help:Contents" �Choosing Contents displays the contents page for WinBench 96’s on-line help. WinBench 96’s help facility works like other Windows-based help tools. You use your mouse to select topics in the on-line help window, and WinBench 96 displays text explaining the topics you select.

Search for Help On...

� XE "Help:Search for Help On" �� XE "WinBench 96:Menus:Help:Search for Help On" �Choosing Search for Help On... opens the Windows Search dialog box. You can use this box to look for specific topics in WinBench 96’s on-line help.

How to Use Help

� XE "Help:How to use Help" �� XE "WinBench 96:Menus:Help:How to Use Help" �If you choose How to Use Help, Windows displays information explaining how to use hypertext on-line help documents.

License

� XE "Help:License" �� XE "WinBench 96:Menus:Help:License" �� XE "WinBench 96:Help:License" �Choosing License displays WinBench 96’s license agreement.

Contacting ZDBOp

� XE "Help:Contacting ZDBOp" �� XE "WinBench 96:Menus:Help:Contacting ZDBOp" �If you choose Contacting ZDBOp, WinBench 96 displays the portion of its help file that tells you how to contact us if you have problems with or questions about the software.

About WinBench 96...

� XE "Help:About Winstone 96" �� XE "WinBench 96:Menus:Help:About WinBench 96" �Choosing About WinBench 96... displays our copyright information. From this window you can read the license agreement by choosing the License... button, and you can view the names of the people who worked on the software by choosing the Credits... button.

Using the Functions buttons

� XE "WinBench 96:Functions window" �� XE "Functions window" �WinBench 96’s Functions window contains six functions buttons.

In some cases you can perform these same functions from WinBench 96’s drop-down menus in the main window’s menu bar.

The sections that follow explain each of these functions buttons.

The About WinBench 96... button� XE "Buttons:About WinBench 96" �� XE "WinBench 96:Buttons:About WinBench 96" �

Choosing the About WinBench 96... button displays WinBench 96’s copyright information. From this window, you can view the license agreement by choosing the License... button, or you can read about the people who developed WinBench 96 by choosing the Credits... button.

The Run button� XE "Buttons:Run" �� XE "WinBench 96:Buttons:Run" �

Choosing the Run button starts the test listed in the box to the right of the button. For example, if the text box displays “Graphics WinMark 96,” when you choose Run, WinBench 96 starts the Graphics WinMark 96 test suite.

NOTE:	To see the list of names, select the down arrow to the right of the box.

The Save... button� XE "Buttons:Save" �� XE "WinBench 96:Buttons:Save" �

Choosing the Save... button displays the Save to Database dialog box. You use this dialog box to save the current results to WinBench 96’s database. You can also change the database using the Database... button. For complete information on how to save results to the database and how to use this dialog box, see page � PAGEREF _Ref298743402 �99�.

The Compare... button� XE "Buttons:Compare " �� XE "WinBench 96:Buttons:Compare" �

Choosing the Compare... button displays WinBench 96’s Comparison Machines dialog box. You can use this dialog box to select results you want to display in the Chart and Table of Results. For complete information on how to add results to the display, see page � PAGEREF _Ref298815839 �100�.

The Help button� XE "Buttons:Help" �� XE "WinBench 96:Buttons:Help" �

Choosing the Help button displays WinBench 96’s on-line help.

WinBench 96’s help facility works like other Windows-based help tools. You use your mouse to select topics in the on-line help window, and WinBench 96 displays text explaining the topics you select.

The Exit button� XE "Buttons:Exit" �� XE "WinBench 96:Buttons:Exit" �

Choosing the Exit button closes WinBench 96’s main window and quits the program. If you have unsaved results, WinBench 96 first asks you if you want to save them. WinBench 96 also restores the PC’s environment to pre-test condition before exiting.

Using the icons in WinBench 96’s main window

� XE "Icons" �When you start WinBench 96, it opens and iconizes three windows—the Disclosure, Chart of Results, and Table of Results windows. The sections that follow explain each of these windows.

Disclosure� XE "Disclosure:Icon" �� XE "WinBench 96:Icons:Disclosure" �

The Disclosure window displays information about the PC’s configuration. You can also view system information about comparison machines from the Disclosure window. For information on using and editing Disclosure information, see page � PAGEREF Chapter12WorkingwithDisclosure �77�.

To open this window, choose its icon or select the Disclosure option from the Window drop�down menu.

Chart of Results� XE "Chart of Results:Icon" �� XE "WinBench 96:Icons:Chart of Results" �� XE "WinBench 96:Results:Chart of Results" �

The Chart of Results contains a bar-graph chart of WinBench 96 results. You can change which test results WinBench 96 displays in the Chart of Results using the Edit | Display submenu.

WinBench 96 automatically displays the Chart of Results when it completes a test. You can open this window by choosing its icon or selecting the Chart of Results option from the Window drop�down menu. You can iconize, maximize, and resize this window as you can other application windows.

For more information on how to interpret the graphs in the Chart of Results, see Chapter 15, “� REF Chapter14WhatNumsMean \* MERGEFORMAT �What Do All These Numbers Mean�,” beginning on page � PAGEREF Chapter14WhatNumsMean �107�.

Table of Results� XE "Table of Results:Icon" �� XE "WinBench 96:Icons:Table of Results" �� XE "WinBench 96:Results:Table of Results" �

The Table of Results shows WinBench 96 results in column format. You can change which test results WinBench 96 displays in the Table of Results using the Edit | Display submenu.

WinBench 96 doesn’t automatically display the Table of Results when it completes a test. You can open this window by choosing its icon or selecting the Table of Results option from the Window drop�down menu. You can iconize, maximize, and resize this window as you can other application windows.

For more information on how to interpret the numbers in the Table of Results, see Chapter 15, “� REF Chapter14WhatNumsMean \* MERGEFORMAT �What Do All These Numbers Mean�,” beginning on page � PAGEREF Chapter14WhatNumsMean �107�.

Test Screen

When WinBench 96 runs a graphics test, it opens a window for the test called the Test Screen. After the test completes, WinBench 96 leaves the last screen image it displayed during that test run in the Test Screen. To open the Test Screen, choose its icon from the WinBench 96 main window.

�If you have problems while running one of WinBench 96’s tests, you can use the Test Screen to make sure the test finished successfully by comparing the Test Screen from a graphics test you know was successful with the current Test Screen. (If you do this, you’ll need to make sure the graphics driver uses the same resolution and options for the current test as for the successful test.)

End of Chapter

�Chapter 12: �Working with Disclosure Information

When you run a test, WinBench 96 gathers information about the PC and stores that information in its Disclosure. This chapter explains how you can view, make changes to, and print Disclosure information.

Sections in this chapter

� REF _Ref298830697 \* MERGEFORMAT �Viewing Disclosure information�

� REF _Ref298830710 \* MERGEFORMAT �Editing information in the Disclosure Questionnaire�

� REF _Ref298830733 \* MERGEFORMAT �Printing Disclosure information�

Viewing Disclosure information� XE "Disclosure:Viewing" �� XE "WinBench 96:Disclosure:Viewing" �

When you start WinBench 96, it checks the PC’s configuration and stores the information it finds in the Disclosure. When you save a set of results, WinBench 96 saves the disclosure information for that set of results. If you publish results, you’ll need to include information in the Disclosure with the results you publish. (For information on what you must include when you publish results, see page � PAGEREF _Ref304267582 �127�.)

NOTE:	If you run several tests and save the results on the same PC with the exact same configuration, WinBench 96 only stores the PC’s configuration information once to conserve disk space.

If you want to add to or change information in the Disclosure, choose the Edit button. (The section “� REF _Ref298830710 \* MERGEFORMAT �Editing information in the Disclosure Questionnaire�” on page � PAGEREF _Ref298830710 �78� explains how to edit the different fields in the Disclosure Questionnaire.)

Viewing Disclosure information for the current displayed results

To view the disclosure information for each set of results currently displayed in the Chart and Table of Results, choose Window | Disclosure from WinBench 96’s main menu or choose the Disclosure icon from WinBench 96’s main window.

By default, WinBench 96 displays the disclosure information for the current set of results first. WinBench 96 uses a drop�down list to display the Description for each set of results you’re currently displaying.

Disclosure information for a PC will most likely cover more than one page of the Disclosure window. Use the scroll bars to view portions that don’t fit within the boundary of the window.

Viewing Disclosure information for other sets of results

To look at disclosure information for another set of results:

1.	Select the down arrow to the right of Current Results.

2.	Select the Description for the set of results whose Disclosure information you wish to view.

WinBench 96 then changes the display to show the Disclosure information for that test run.

Editing information in the Disclosure Questionnaire

� XE "WinBench 96:Disclosure Questionnaire:Editing" �� XE "Disclosure Questionnaire:Editing" �� XE "Editing:Disclosure Questionnaire" �If you need to add to or change the Disclosure information WinBench 96 gathers about a PC, you can edit the Disclosure Questionnaire. To edit the questionnaire:

1.	Choose Edit | Disclosure Questionnaire from the WinBench 96 main menu bar.

WinBench 96 opens the Disclosure Questionnaire window.

2.	Select the group on the left-hand side of this window that corresponds to the area of the questionnaire you wish to edit.

When you select one of these groups, WinBench 96 changes the Disclosure Questionnaire window to display just the information about that group.

For example, if you want to edit the Description, select the button beside Description, and WinBench 96 changes the display in the window to the Description information.

3.	Choose the Update Disclosure button once you have the questionnaire the way you want it.

If at any point you wish to exit the Disclosure Questionnaire window without saving your changes and updating the disclosure, choose the Cancel button.

To learn more about the information in the Disclosure Questionnaire, read the sections that follow.

Description� XE "Disclosure:Description" �� XE "WinBench 96:Disclosure:Description" �

When you select the Description button, WinBench 96 displays the test description� XE "Test description" � information.

NOTE:	Before you can save results, you’ll need to enter a test description.

To enter a test description, insert your cursor in the Description text box and type in the test description you want. The name you enter can be any combination of letters, numbers, symbols, and spaces. If you haven’t yet saved results, WinBench 96 uses the default “Current Results” for the test description.

NOTE:	WinBench 96 uses the test description you enter along with other identifiers, like a date and time stamp, as qualifiers for the results you save.

Display� XE "Disclosure:Display" �� XE "WinBench 96:Disclosure:Display" �

When you select the Display button, WinBench 96 changes the questionnaire to show the information about the PC’s graphics subsystem.

The Display information includes information on the PC’s graphics adapter make and model, BIOS version and date, and amount of DRAM and VRAM. WinBench 96 may not be able to determine all this information about a PC. You can use the Display window to add or correct the information about the PC’s display.

You can also run three different display tests from the Display window—Refresh Rate, Cursor Type, and Color Reproduction. The sections that follow explain how to run each of these tests.

Determining the refresh rate

� XE "WinBench 96:Disclosure:Refresh rate" �� XE "Disclosure:Refresh rate" �� XE "Refresh rate" �You can use the Refresh Rate button in the Display window to determine the actual refresh rate of the PC’s graphics card. The refresh rate is the frequency at which the PC’s graphics adapter redraws the monitor’s display. Higher refresh rates reduce screen flicker but can decrease graphics drawing performance because of the time it takes to refresh the screen. Common refresh rates are 60, 72, and 86 (43 interlaced) Hertz. (Hertz (Hz) is a unit of measurement that here indicates the number of times a graphics adapter redraws the screen per second.)

NOTE:	To compare two graphics cards fairly, both should generally use the same refresh rate.

To determine the refresh rate for the PC’s display, follow the steps below.

1.	Select the Refresh Rate... button from the Display window.

WinBench 96 opens the Refresh Rate Detection window� XE "Refresh Rate Detection window" �.

This window contains three sections:  the instructions on the left�hand side, the list of keys in the upper-right corner, and the refresh rectangle in the lower�right corner.

NOTE:	If the current display mode is VGA register-level compatible, WinBench 96 automatically computes the refresh rate. You can then use the Refresh Rate Detection window to verify or refine the rate WinBench 96 computed. (WinBench 96 may be off by as much as a few Hz.)

When you first open the window, WinBench 96 attempts to calculate the refresh rate; so, the refresh rectangle is blank. You’ll see a message that says “Please Wait.” WinBench 96 then repeatedly redraws the refresh rectangle, first in black, and then in white, over and over again.

The � XE "Refresh Rate:Target value" �� XE "WinBench 96:Refresh Rate:Target value" �Target value indicates the redraw rate of the rectangle WinBench 96 is attempting to achieve. The Rate value indicates the actual redraw rate of the rectangle.

You should wait until the Rate value settles to the Target value before proceeding. The Rate value will first rise to above 100 Hz and then settle to the Target value. It may take a few seconds before the Rate and Target values match.

When the Rate and Target values settle, one of two things has happened:  either WinBench 96 determined the refresh rate within a couple of Hz, or it has set the initial target rate to 60 or 72 Hz, depending on the size of the display. If the graphics adapter is operating in a VGA register�set compatible mode, WinBench 96 can determine the refresh rate of the display to within a couple of Hz.

NOTE:	The numbers below the Target and Rate values are for ZDBOp internal use.

2.	Use the keys listed above the refresh rectangle to adjust the refresh rate.

NOTE:	You shouldn’t move the mouse during this test. Instead, use the key sequences the window describes.

To determine the actual refresh rate of the display, adjust the redraw rate of the rectangle until a single, steady, thin diagonal line appears. The line will jump once per second, but it otherwise should not move.

You can use the number keys, 1 through 9, to set the Target rate to 10 through 90 Hz in increments of 10 Hz. You can use the function keys to decrease or increase the Target rate in increments of 10 Hz, 1 Hz, or .1 Hz.

F4:	decrease by 10 Hz�F5:	decrease by 1 Hz�F6:	decrease by .1 Hz�F7:	increase by .1 Hz�F8:	increase by 1 Hz�F9:	increase by 10 Hz

NOTE:	Wait a few seconds between keystrokes to allow the Rate value of the rectangle to match the Target value. Each time you select a key, WinBench 96 immediately adjusts the Target value. It then must adjust the Rate value of the rectangle’s display to match that target. Sometimes adjusting the rate can take a few seconds.

If the redraw rate is close to the actual refresh rate of the display, you need to refine the rate using the function keys. If the refresh rate is not close, you need to first use the number keys to narrow the rate and get it close.

If the initial Target rate WinBench 96 uses is close to the actual refresh rate of the display, you’ll see a thin black and white line on a flickering gray background in the refresh rectangle. The line will jump about once a second. Between jumps, it may be moving to the left or right or it may be steady.

To determine the actual refresh rate, you need to refine the Target rate using the function keys until the line is steady between jumps. First use the F5 and F8 keys to adjust the Target rate until you find two rates that are 1 Hz apart—one that moves the line to the left and one that moves the line to the right. Then, use the F6 and F7 keys to steady the line. If the line is moving to the right, use the F5 and F6 keys. If the line is moving to the left, use the F7 and F8 keys. Be sure to wait for the Rate value to settle to the Target value before pressing another key.

NOTE:	You may not be able to produce a completely steady diagonal line. In this case, reduce the line’s movement as much as possible.

If WinBench 96 does not pick an initial Target rate that is close to the actual refresh rate of the display, you’ll see black and white moving bands in the refresh rectangle. You need to hunt for a rate that produces a thin diagonal line (or at least thinner bands). Beginning with 1 and progressing in order, press each of the number keys from 1 to 9. Remember to wait for the Rate value to settle to the Target value before pressing another key.

Watch for a Target rate that produces a thin band or line in the refresh rectangle. After you’ve examined all of the rates (from 10 to 90 Hz), return to the rate that produced the thinnest band or line. Next, use the F5 and F8 keys to reduce the width of the band or line until you can see a thin black and white line on a gray flickering background. Then, use the F6 and F7 keys to steady the line. If the line is moving to the right, use F6. If the line is moving to the left, use F7. You can then refine the rate using the technique in the bullet item above.

3.	Press Enter once you’ve determined the correct refresh rate.

NOTE:	You can press Esc at any time to exit the window without adjusting the refresh rate.

Once you’ve determined the refresh rate, WinBench 96 displays the Interlaced Monitor Detection window� XE "Interlaced Monitor Detection window" �� XE "WinBench 96:Disclosure:Interlaced Monitor Detection" �� XE "WinBench 96:Interlaced Monitor Detection" �� XE "Disclosure:Interlaced Monitor Detection" �.

WinBench 96 uses this window to determine whether the PC’s screen is an interlaced or a non�interlaced screen. A graphics adapter draws an interlaced screen in two steps. First, it draws the odd scan lines of the screen from top to bottom, and then it draws the even scan lines from top to bottom. A graphics adapter draws a non�interlaced screen completely from top to bottom before drawing it again.

So, if the PC’s screen is interlaced, the Refresh Rate test determines a rate twice the actual refresh rate. The Interlaced Monitor Detection window determines whether the PC’s screen is interlaced or non�interlaced and automatically corrects the Refresh Rate if the screen is interlaced.

The Interlaced Monitor Detection window contains three sections—the instructions on the left�hand side, the list of keys in the upper-right corner, and the rectangle in the lower-right corner.

When you first open the window, WinBench 96 attempts to match the redraw rate of the rectangle to the refresh rate you determined in the previous Refresh Rate Detection window. So, the rectangle is blank, and WinBench 96 displays a message that reads “Please Wait.” WinBench 96 then repeatedly redraws the refresh rectangle, first in black, and then in white, over and over again.

To use this window, follow the steps listed below.

1.	Wait until the Please Wait message disappears.

2.	Enter either “N” or “I” depending on the way the rectangle appears.

If the rectangle appears gray or consists of very thin, alternating black and white horizontal lines, select the letter “N” (for non�interlaced). WinBench 96 automatically enters the refresh rate in the Disclosure Questionnaire window.

NOTE:	If the PC has a non-interlaced screen, WinBench 96 displays the refresh rate in the Disclosure Questionnaire window in Hz without any other notation.

If the rectangle appears black and white or consists of two horizontal black and white bands, select the letter “I” (for interlaced). WinBench 96 automatically enters the refresh rate in the Disclosure Questionnaire window.

NOTE:	If the PC has an interlaced screen, WinBench 96 displays the refresh rate with the notation “(Interlaced)” to the right of the Hz value.

	Most monitors use horizontal scan lines. The above discussion applies to such monitors. Some monitors use vertical scan lines. These are typically monitors you can rotate between landscape and portrait orientations.

	WinBench 96 uses a heuristic test to determine if the monitor uses vertical or horizontal scan lines and modifies the Refresh Rate test appropriately. If WinBench 96 determines the monitor uses horizontal scan lines, it puts an “H” in the Refresh Rate text box. If it determines the monitor uses Vertical scan lines, it puts a “V” in the Refresh Rate text box.

	WinBench 96 won’t always make the correct scan line orientation determination. You can use the “H” and “V” keys to tell WinBench 96 that the monitor uses vertical or horizontal scan lines. These tests will work correctly only if WinBench 96 determines or is told the correct scan line orientation.

	The Refresh Rate and Interlace Detection tests appear a little different from the description above when testing with vertical scan lines. The diagonal line in the Refresh Rate test is rotated 90 degrees and moves up and down instead of left and right. The rectangle in the Interlace Detection dialog is also rotated by 90 degrees. The instructions in the dialog will reflect these differences.

Determining the cursor type� XE "Disclosure:Cursor Type" �� XE "WinBench 96:Disclosure:Cursor Type" �� XE "Cursor Type test" �� XE "WinBench 96:Cursor Type" �

The Cursor Type test determines whether the graphics adapter supports a hardware or software cursor. If the PC’s graphics adapter does not have a hardware cursor, Windows must remove and redraw the cursor when application programs perform a paint operation near it. If the Windows graphics adapter has a hardware cursor, it can avoid this overhead.

To use this feature:

1.	Select the Cursor Type... button from the Display window.

WinBench 96 opens the Cursor Type Detection window� XE "Cursor Type Detection window" �.

2.	Place the mouse cursor over the colored rectangle on the left side of this window.

WinBench 96 continually redraws the rectangle using different colors.

3.	Answer the question in the Cursor Type Detection window.

If the cursor disappears or flashes when you place or move it over the colored rectangle, answer yes. The graphics adapter doesn’t have a hardware cursor, and WinBench 96 automatically enters Software in the Cursor Type field in the Display window.

If the cursor remains steady and doesn’t disappear or flash, answer no. The graphics adapter has a hardware cursor, and WinBench 96 automatically enters Hardware in the Cursor Type field in the Display window.

Determining the color reproduction information� XE "Color Reproduction" �� XE "WinBench 96:Color Reproduction" �� XE "Disclosure:Color Reproduction" �� XE "WinBench 96:Disclosure:Color Reproduction" �

To determine the techniques the PC’s display device driver uses to render color on the display, choose the Color Reproduction... button from the Display window.

The Color Reproduction test determines if the PC’s video card is in a true-color mode or dithering mode.

If it’s in true-color mode� XE "True-color mode" �, the test tells you how many shades of red, green, and blue are actually stored in the frame buffer.

If the card is in dithering mode� XE "Dithering mode" �, the test tells you how large the dither pattern is, the maximum number of colors used in a single dither pattern, how many shades of red, green, and blue the pattern will support, and whether the pattern matches the pattern the VGA device driver uses.

You may want to use the Color Reproduction test if you’re comparing different video cards and want to be certain they all use the same color reproduction method.

When the test completes, WinBench 96 adds the color reproduction information to the Disclosure Questionnaire.

NOTE:	WinBench 96 displays this information in the text box to the right of the Color Reproduction... button. You may not, however, be able to read all the information in the box. To view all the information, use the right-arrow key to scroll the information horizontally or choose the Disclosure icon and look for “Display Color Reproduction” in the Disclosure information.

CPU/Memory� XE "Disclosure:CPU and Memory" �� XE "WinBench 96:Disclosure:CPU and Memory" �

To display information about the PC’s CPU and memory, select CPU/Memory from the Disclosure Questionnaire window.

First, WinBench 96 displays information about the PC’s processor, its speed, the amount of off chip cache, and the amount of memory. WinBench 96 does the best it can to determine this information. It’s possible, however, WinBench 96 may not be able to narrow down the specific type of processor the PC uses. For example, WinBench 96 may be able to determine the processor is a 386, but it can’t tell if it’s a DX or SX. You can add to or correct the processor information by typing in the correct information.

NOTE:	WinBench 96 can’t determine the size of the off-chip processor cache� XE "Off-chip processor cache" �.

Next, WinBench 96 displays information about the PC’s coprocessor. If it can, it determines the coprocessor type.

Finally, WinBench 96 lists the type of bus the PC uses.

If WinBench 96 can’t determine some of these values, it enters either “Unknown” or a question mark (?) in the field it can’t determine.

NOTE:	WinBench 96 can’t detect a VESA Local Bus.

Disk� XE "Disclosure:Disk" �� XE "WinBench 96:Disclosure:Disk" �

When you select the Disk group from the Disclosure Questionnaire window, WinBench 96 changes the display to show information about the PC’s disk drives.

This window contains information about the PC’s hard disk, hard disk controller, operating system software cache, and Windows software cache.

NOTE:	WinBench 96 only detects the SMARTDrive� XE "SMARTDrive" � OS Software Cache. If the PC uses other types of caches, WinBench 96 won’t automatically detect those.

If WinBench 96 can’t determine some of these values, it enters either “Unknown” or a question mark (?) in the field it can’t determine. To add to or change any of this information, just type in the information in the correct field.

Multimedia� XE "Disclosure:Multimedia" �� XE "WinBench 96:Disclosure:Multimedia" �

When you select the Multimedia group from the Disclosure Questionnaire window, WinBench 96 changes the display to show information about the PC’s CD-ROM drive(s), controller, and software cache as well as information on the PC’s sound adapter.

If WinBench 96 can’t determine some of these values, it enters either “Unknown” or a question mark (?) in the field it can’t determine. To add to or change any of this information, just type in the information in the correct field.

Computer� XE "Disclosure:Computer" �� XE "WinBench 96:Disclosure:Computer" �

When you select Computer, WinBench 96 changes the display to show general information about the PC.

In this window, WinBench 96 displays information about the PC’s make and model, the BIOS manufacturer, power management, and the PC’s name.

The Computer window also includes an area where you can enter notes about the PC or about a particular test run.

If WinBench 96 can’t determine these values, it enters “Unknown” in the field it can’t determine. To add to or change any of this information, just type in the information in the correct field. (In most cases, you’ll need to enter the information for the PC in the Computer window, because it’s difficult for WinBench 96 to determine this type of information.)

Software� XE "Disclosure:Software" �� XE "WinBench 96:Disclosure:Software" �

When you select Software, WinBench 96 changes the display to show information about the operating system and Windows software installed on the PC and any emulation software used to allow Windows to run on non-PC hardware platforms.

To add to or change this information, type the new information in the appropriate fields.

Tester Info� XE "Disclosure:Tester Info" �� XE "WinBench 96:Disclosure:Tester Info" �

When you select Tester Info, WinBench 96 changes the display to show the project identification number� XE "Project identification number" � (PIN� XE "PIN" \t "See Project identification number" �), project name, and variants for the test run.

When our labs run WinBench 96, they use project identification numbers (PINs), project names, and variants to help identify different WinBench 96 test runs on the same machine. The Tester Info section of the Disclosure Questionnaire lets you enter a PIN and up to five variants, as well as a project name. You can use any combination of letters, numbers, or symbols. Variants can be a maximum of three characters, PINs a maximum of seven, and project names a maximum of ten.

This window also lets you change the tester’s name and the organization if you choose to do so. (You entered the tester name and organization when you licensed WinBench 96. There may be a case, however, where the person running the test isn’t the same person who licensed the software.)

Printing Disclosure information� XE "Disclosure:Printing" �� XE "Printing:Disclosure" �� XE "WinBench 96:Disclosure:Printing" �

To print Disclosure information:

1.	Select Print from the File menu in the main window.

2.	From the Print submenu, select the Disclosure... option.

When you print the Disclosure information, WinBench 96 prints the information currently displayed in the Disclosure window.

NOTE:	If you’re displaying results for several different types of machines, you can print disclosure information for each of them. To specify the set of comparison results for which you want to print the Disclosure, change the Description listed above the Disclosure information in the Disclosure window and then select Print from the File menu.

End of Chapter

�Chapter 13: �Working with Custom Suites

A custom suite is a collection of tests you create that contains just the suites and/or tests you want to run. When you create a custom suite, you save it as a file. You can then add that suite’s name to the list of available suites during any WinBench 96 session. So, you can use custom suites in multiple WinBench 96 sessions, even if those WinBench 96 sessions are on different PCs.

NOTE: 	While you can create your own suites, you can’t assign weights to the tests in those suites.

Sections in this chapter

� REF _Ref300382296 \* MERGEFORMAT �Creating custom suites�

� REF _Ref300392007 \* MERGEFORMAT �Editing a custom suite�

� REF _Ref300392066 \* MERGEFORMAT �Adding a custom suite name to the list of available suites�

� REF _Ref300382347 \* MERGEFORMAT �Removing a custom suite name from the list of available suites�

Creating custom suites

� XE "WinBench 96:Custom suites:Creating" �� XE "Custom suites:Creating" �� XE "Creating a custom suite" �A custom suite can include any combination of WinBench 96’s built�in suites or tests. To create a custom suite:

1.	Select Create... from the Suite menu.

WinBench 96 then displays its Create Custom Suite dialog box� XE "Create Custom Suite dialog box" �.

�NOTE:	WinBench 96 automatically displays the names of all the tests included in the currently selected suite under Selected Tests. These are the tests that make up the suite name selected from the list of available suites in the box to the right of the Run function button.

	For example, if you’ve selected Graphics WinMark 96 from the list of available suites to the right of the Run function button, WinBench 96 lists the tests that make up the Graphics WinMark 96 under Selected Tests.

	So, if you’re creating a suite that is similar to an existing suite, make sure to select the existing suite’s name from the list of suites available. (If you don’t want to use any of these tests, choose the Remove All button.)

2.	Enter the name you want to call the test suite under Suite Name. You can use any combination of characters and spaces for this name.

The name you enter here will appear in the drop�down list to the right of the Run button and in the Test Suites list in the Select Tests dialog box once you’ve added the custom suite’s name to the list of available suites.

3.	Build the custom suite by adding suite or test names to the list of Selected Tests. You can add tests to the list by double�clicking on the test names or by choosing a name and then choosing the Add button.

You can select any existing suite or test for a custom suite. If you select an existing suite, WinBench 96 lists all the tests that make up that suite under Selected Tests.

NOTE:	WinBench 96 doesn’t save settings for CD-ROM, disk, and video tests with a custom suite. To specify settings for any of these tests in a custom suite, you must first select the suite’s name from the drop�down list to the right of the Run function button and then select Settings from the Edit menu.

To remove a test from the list, highlight it and then choose the Remove button. To remove all the tests, choose the Remove All button.

4.	Choose OK when you have all the tests you want listed in the Selected Test window. WinBench 96 displays the Save Suite in File dialog box.� XE "WinBench 96:Custom Suites:Saving" �� XE "Custom suites:Saving" �� XE "Saving a custom suite" �

NOTE:	At this point, you have a suite you can run during this WinBench 96 session. You don’t have to save the suite to a file. If, however, you want to run this suite during other sessions, you’ll need to save the suite to a file. If you want to save your suite, go to the next step. If you don’t, choose Cancel.

�5.	Enter a file name for the suite with a .WBS extension. The file name you enter should have a .WBS extension.

You can change the directory and drive where you want to save the file. By default, WinBench 96 saves the file in its SUITES subdirectory� XE "SUITES subdirectory" �. (You must follow DOS file name conventions when you enter the name for this file.)

NOTE:	If you save the suite to a file, WinBench 96 associates a file name with the suite you create. That file name must follow DOS file name conventions. Later, when you want to load the suite, you’ll need to select the DOS file name, not the actual suite name.

	For example, suppose you create a suite named “Rosco Test 1” and save it as a file named ROSCO1.WBS. When you want to load that suite, WinBench 96 displays a dialog box with the file name ROSCO1.WBS in it, not the suite name “Rosco Test 1.”

6.	Choose OK. WinBench 96 automatically adds the name of the suite you just created to the list of available suites in both the drop�down list to the right of the Run function button and the Test Suites list in the Select Tests window.

Editing a custom suite� XE "WinBench 95:Custom suite:Editing" �� XE "Custom suite:Editing" �� XE "Editing a custom suite" �

You can change a custom suite by adding or deleting tests. To edit a custom suite:

1.	Select the suite name for the custom suite you want to modify from the drop�down list to the right of the Run function button. (You can’t edit WinBench 96’s built-in test suites.)

2.	Select Edit from the Suite menu. WinBench 96 displays the Edit Custom Suite dialog box.

3.	Change the list of tests associated with your suite by adding or deleting tests from the Selected Tests list.

4.	Choose OK after you’ve modified the suite. WinBench 96 then displays the Save Suite in File dialog box.

NOTE:	You don’t have to save the suite to a file. If, however, you want to run this modified suite during other sessions, you’ll need to save the suite to a file. If you want to save your suite, go to the next step. If you don’t want to save the suite, choose Cancel.

�5.	Enter a file name for the modified suite. You can overwrite the existing file, or you can enter a new file name for the edited suite. You can also change the directory and drive. By default, WinBench 96 saves the file in the SUITES subdirectory.

NOTE:	The file name you supply should have a .WBS extension and must follow DOS file name conventions. 

6.	Choose OK.

Adding a custom suite name to the list of available suites� XE "WinBench 95:Custom suite:Adding to list" �� XE "Custom suite:Adding to list" �� XE "Adding a custom suite to the test list" �

Before you can run a custom suite, you’ll first need add that suite’s name to the list of available suites to the right of the Run function button. To add a custom suite name to the list of available suites:

1.	Choose Load from the Suite menu in the main window.

WinBench 96 displays the Load Suite from File dialog box.� XE "WinBench 96:Custom suite:Loading" �� XE "Loading a custom suite" �� XE "Custom suite:Loading" �

2.	Enter the name of the suite file you want to add to the list of available suites.

You can change the directory and drive if you need to. WinBench 96 displays the names of all of the files in the current directory that have a .WBS extension.

NOTE:	WinBench 96 doesn’t display the suite names in this window. Instead, it displays the DOS file names associated with the suites.

3.	Choose OK.

WinBench 96 adds the suite name to the list of available suites in both the drop�down list to the right of the Run function button and the Test Suites list in the Select Tests window.

Removing a custom suite name from the list of available suites� XE "WinBench 95:Custom suite:Removing from list" �� XE "Custom suite:Removing from list" �� XE "Removing a custom suite from the test list" �

To remove a custom suite name from the list of available suites:

1.	Select the suite name from the drop-down list to the right of the Run function button.

�2.	Select Delete from the Suite menu in the main window.

WinBench 96 asks you if you’re sure you want to remove the suite from the list of available suites. Choose “Yes.”

WinBench 96 removes the selected suite from the list, but it doesn’t permanently delete the suite’s .WBS file from the hard disk. To permanently delete a suite file, you’ll need to use the Windows File Manager or the DEL command from the DOS command line.

End of Chapter

�Part 4: �Analyzing Results

Chapter 14:	� REF Chapter13UsingResultsDatabase \* MERGEFORMAT �Using the Results Database��Explains how to save, view, print, and merge results.

Chapter 15:	� REF Chapter14WhatNumsMean \* MERGEFORMAT �What Do All These Numbers Mean��Discusses what WinBench 96’s results mean about a PC’s performance.

Chapter 16:	� REF Chapter15WhatCanAffectResults \* MERGEFORMAT �What Can Affect Results��Discusses different areas of a PC’s setup and configuration that can affect WinBench 96’s results.

Chapter 17:	� REF Chapter16Publishing \* MERGEFORMAT �Publishing Results��Explains what information you need to include if you publish WinBench 96’s results.

�Chapter 14: �Using the Results Database

This chapter explains in detail how to use the common results database. It also explains how you can export results to file formats other than .DBF.

NOTE:	Consult Appendix A, “� REF AppendixADatabaseFiles \* MERGEFORMAT �The Database Files�” beginning on page � PAGEREF AppendixADatabaseFiles �183� for details about the database files.

Sections in this chapter

� REF _Ref302352875 \* MERGEFORMAT �Facts about the database�

� REF _Ref298743402 \* MERGEFORMAT �Saving results�

� REF _Ref333808477 \* MERGEFORMAT �Viewing results�

� REF _Ref333808492 \* MERGEFORMAT �Deleting results permanently from the database�

� REF _Ref333808494 \* MERGEFORMAT �Printing results�

� REF _Ref333895517 \* MERGEFORMAT �Merging results into one database�

� REF _Ref298744197 \* MERGEFORMAT �Exporting results�

Facts about the database� XE "Database:Facts about the database" �� XE "WinBench 96:Database:Facts about the database" �

WinBench 96 saves results and disclosure information in a database format it shares with Winstone 96. You use results stored in a database as comparison machines in the Chart and Table of Results windows.

WinBench 96 stores results in a database directory. The database directory typically has an extension of .ZDB. The database directory contains many dBASE(�compatible tables and indexes.

When you’re working with database files:

Always treat a database directory as a single object.

Always move, copy, or delete the entire directory.

Never move, copy, delete, or rename the files in a database directory.

Never use a dBASE-compatible database management system to edit the database directory. Doing so may break the relationship between the files and the benchmark, and you’ll lose the results.

NOTE:	You can merge the contents of one database into another using the Merge Databases... option from the File drop-down menu. WinBench 96 copies all results from the source database to the target database. (For more information, see page � PAGEREF _Ref333895517 �104�.)

� XE "WinBench 96:Database:Keys" �WinBench 96 stores results in a database using a key consisting of the Description, Variant1�5, PIN, and Project fields of the Disclosure. You can store many sets of results using the same key. WinBench 96 distinguishes the results by a unique time stamp.

NOTE:	Many of the fields of the disclosure that uniquely identify a machine configuration and that should not normally change from run to run must be the same when saving results using an already existing key. For example, the Processor field and Processor RAM fields must be identical for all results stored using the same key. If these fields don’t match the fields already in the database with the same key, you’ll receive a warning message.

If you installed WinBench 96 in a subdirectory of \ZDBENCH, the setup program creates a database directory called \ZDBENCH\RESULT96.ZDB� XE "RESULT96.ZDB" �. WinBench 96 shares this database directory with Winstone 96 if you also installed that benchmark in its default \ZDBENCH directory.

If you didn’t install WinBench 96 under a common \ZDBENCH directory, it creates the RESULT96.ZDB database directory in the directory where you installed the program files. WinBench 96 can’t then share the database with Winstone 96.

Saving results

� XE "WinBench 96:Results:Saving" �� XE "Results:Saving" �� XE "Saving results" �After WinBench 96 finishes a test, it automatically displays that test’s results in the Chart and Table of Results windows.

To save results to a database:

1.	Choose either the Save function button or the Save... option from the File drop-down menu.

Either of these actions displays the Save to Database dialog box.

This dialog box displays the directory name for the database directory and some basic information about the test PC taken from the Disclosure Questionnaire.

NOTE:	The more information you add to the Disclosure Questionnaire, the more information WinBench 96 displays in this dialog box. For example, if you define a PIN number or variants to the questionnaire, WinBench 96 will display that information in the Save to Database dialog box. (For more details on how to edit the Disclosure Questionnaire, see page � PAGEREF _Ref298830710 �78�.)

2.	Choose the Save button in the Save to Database dialog box.

WinBench 96 saves its results to the database directory using the Description you supplied in the Disclosure Questionnaire.

NOTE	You can also export results to other file formats. For more information, see page � PAGEREF _Ref298744197 �105�.

Changing the database directory� XE "WinBench 96:Results:Changing the database directory" �� XE "WinBench 96:Database:Changing the database directory" �� XE "Database:Changing the database directory" �� XE "Results:Changing the database directory" �

If you want to save results to a different database directory:

1.	Choose either the Save function button or the Save... option from the File drop-down menu to open the Save to Database dialog box.

2.	Choose the Database... button in the Save in this dialog box.

WinBench 96 then displays its Select a Database dialog box� XE "Select a Database dialog box" �

3.	Select the database directory where you wish to save the PC’s results. (You can change the drive or directory if you need to do so.)

4.	Choose the OK button.

Viewing results� XE "WinBench 96:Results:Viewing" �� XE "Results:Viewing" �� XE "Viewing results" �� XE "Chart of Results:Viewing" �� XE "Table of Results:Viewing" �

You can view results saved to a database from the Chart and Table of Results. You can also view WinBench 96 results for other PCs whose records you’ve merged into the database.

After you run a test, WinBench 96 automatically displays the results for that test in the Chart of Results. The Chart of Results shows the name of the test and its result in a horizontal bar graph. When you add results to the display, WinBench 96 displays those results in the Chart of Results also.

The Table of Results also contains results for the current test. WinBench 96 doesn’t, however, automatically display this table. Instead, you’ll find an icon for the Table of Results in the lower, left-hand corner of the main window. To open the Table of Results window, choose this icon.

While the Chart of Results displays results in a graph, the Table of Results displays results in column format. The first column lists the name of the test. Each column thereafter lists the corresponding result for each comparison machine in the display. The last column displays the units for the test.

For example, if you’ve added two sets of results to the display, there will be five columns in the Table of Results—one for the test name, one for the current results, one each for the two sets of comparison results, and the final units column.

The sections that follow explain how to set or change the baseline system for the display and how to add results to and remove results from the display.

Setting or changing the baseline machine� XE "Database:Setting the baseline system" �� XE "Baseline system:Setting or changing" �� XE "WinBench 96:Results:Baseline system" �� XE "WinBench 96:Database:Baseline system" �� XE "Results:Baseline system" �

When you display results, you can choose which set of results you want to use as a baseline machine. With a baseline machine, you can quickly compare all the results to that one set of results in WinBench 96’s Chart of Results.

When you select a baseline machine, WinBench 96 sets that machine’s results to 1.00 and displays all other results as a percentage of the baseline machine’s results. When you use a baseline machine, you can quickly determine from the graphs how results for different PCs compare.

For example, once you’ve set the baseline machine, the bar graph for a set of results that is faster than the baseline machine will be more than 1.00, while the bar graph for a set of results that is slower than the baseline machine will be less than 1.00.

To set a baseline machine or to change the current baseline machine:

1.	Select Baseline... from the Chart menu.

NOTE:	To select Baseline... from the Chart menu, the Chart of Results must be open and you must have normalized results displayed in the chart (select Chart | Normalized). Otherwise, the Baseline... option is dimmed (you can’t select it).

WinBench 96 displays the Baseline Machine dialog box� XE "Baseline Machine dialog box" �.

You can select any set of results WinBench 96 is currently displaying as the baseline machine. To see a list of the currently displayed results, select the down arrow to the right of the Baseline text box.

2.	Set or change the baseline machine by selecting the set of results you want WinBench 96 to use as the baseline machine.

3.	Once you’ve selected the machine, choose OK.

Adding results to the display

� XE "Database:Adding results to the display" �� XE "Comparison machines:Adding to the display" �� XE "Database:Comparing results" �� XE "Chart of Results:Adding results to the display" �� XE "Table of Results:Adding results to the display" �� XE "Results:Adding to the display" �� XE "WinBench 96:Results:Adding results to the display" �� XE "WinBench 96:Comparing machines" �� XE "Adding results to the display" �� XE "Comparing results" �WinBench 96 automatically displays a PC’s current results in the Chart and Table of Results. You only need to add results to these windows if you want to view results other than the current results. You can display up to five sets of comparison results in the Chart and Table of Results.

Remember, WinBench 96 doesn’t automatically display the Table of Results. If you want to view the Table of Results, you’ll have to open the window manually by choosing its icon or by selecting the Table of Results option from the Window menu.

To add WinBench 96 results to the Chart and Table of Results, choose the Compare... button in the Functions window. WinBench 96 displays the Comparison Machines dialog box� XE "Comparison Machines dialog box" �.

From the Comparison Machines dialog box, you can add results from:

A database by choosing the Add from Database... button.

An exported file by choosing the Import from File... button. (For more information on how to export results, see page � PAGEREF _Ref298744197 �105�.)

�Adding results from a database� XE "Results:Adding from a database" �� XE "WinBench 96:Results:Adding from a database" �� XE "Adding results from a database" �

To add results from a database:

1.	Choose the Add from Database... button.

WinBench 96 displays the Select Results from Database dialog box� XE "Select Results from Database dialog box" �.

WinBench 96 lists the directory name of the current database and the names of all the records in that database. Each record represents a set of results. (If you want to change the database, choose the Database... button and select a different database.)

2.	Select the set of results you wish to add to the display.

3.	Choose OK.

Importing results from a file� XE "Importing results from a file" �� XE "Results:Importing from a file" �� XE "WinBench 96:Results:Importing from a file" �

To import results from a file:

1.	Choose the Import from File... button.

WinBench 96 displays the Import Results from File dialog box� XE "Import Results from File dialog box" �.

2.	Select the name of the file you wish to import in the File Name text box.

You can change the drive and directory if you need to do so.

3.	After you’ve entered the name, choose OK.

WinBench 96 adds the results from the file into the Chart and Table of Results displays.

Removing results from the display

� XE "Removing results from the display" �� XE "Comparison machines:Removing results from the display" �� XE "Chart of Results:Removing results from the display" �� XE "Table of Results:Removing results from the display" �� XE "WinBench 96:Results:Removing from the display" �� XE "Results:Removing from the display" �If you’d like to remove a set of results from the Chart and Table of Results:

1.	Open the Comparison Machines dialog box by choosing the Compare... button in WinBench 96’s Functions window.

This dialog box lists all the results currently displayed in the Chart and Table of Results. (You can display up to five sets of comparison results.)

2.	Select the set of results you’d like to remove from the display.

�3.	Choose Remove.

WinBench 96 removes that set of results from the Chart and Table of Results. It doesn’t, however, permanently delete those results from the database. The next section tells you how to permanently remove results records from the database.

Deleting results permanently from the database

� XE "Deleting results records" �� XE "Database:Deleting records permanently" �� XE "Results:Deleting" �� XE "WinBench 96:Results:Deleting" �To permanently delete a set of results from the database:

1.	Select Delete... from the File menu in the main menu bar.

WinBench 96 displays its Delete Results from Database dialog box� XE "Delete Results from Database dialog box" �.

When you open this dialog box, WinBench 96 automatically displays all the records in the current database in the Filtered Records section of the box. (To change the database, choose the Database... button.)

You can use the Record Selection Filter� XE "Record Selection Filter" �� XE "Database:Record Selection Filter" �� XE "WinBench 96:Database:Record Selection Filter" �� XE "WinBench 96:Results:Record Selection Filter" � section of the dialog box to locate a specific record in the list or to narrow the list to make the record easier to find. You can also change the database by choosing the Database... button.

For example, if you know the record you want to delete is for a PC with a 486 CPU with a 66 MHz processor speed, you can enter that information in the appropriate fields, choose Apply Filter, and WinBench 96 displays only the records for 486 CPUs with a 66 MHz processor speed. Then, select the record you want to delete, and choose Delete. Using the Record Selection Filter can cut the total list of records down to a size where finding the one record you want to delete is an easier task.

2.	Select the record or records you wish to delete.

To select more than one record, hold down the Shift key then click on the additional record name(s).

3.	Choose OK.

WinBench 96 prompts you with a warning asking if you’re sure you want to delete the selected record. Choose Yes, and WinBench 96 removes that entry from its database.

Printing results� XE "Database:Printing results" �� XE "Results:Printing" �� XE "Printing:Results" �� XE "WinBench 96:Results:Printing" �

You can print the current results, the Chart and Table of Results, and the Disclosure Questionnaire using the Print option from the File menu.

If you want to print . . .�Then choose . . .��The results and Disclosure information for tests run during the current session.�Current results.��The current contents of the Chart of Results and/or the Table of Results.�Chart of Results and/or Table of Results.��Disclosure information.�Disclosure. (WinBench 96 prints the Disclosure information for the current results. If you want to print Disclosure information for other sets of comparison results, change the Description listed at the top of the Disclosure window before selecting Print from the File menu.)��When you choose one of these options, WinBench 96 prints to the default printer.

Merging results into one database

� XE "Database:Merging results" �� XE "Results:Merging" �� XE "WinBench 96:Results:Merging" �� XE "Merging results" �To merge databases:

1.	Select Merge Databases... from the File menu in the main menu bar.

WinBench 96 displays its Merge Databases dialog box� XE "Merge Databases dialog box" �.

2.	Specify a target � XE "Target database" �and source� XE "Source database" � database.

When you merge two databases, you specify a target database and a source database. The target database is the database to which you wish to add results. The source database contains the records you wish to add to the target database.� XE "Database:Source" �� XE "Database:Target" �� XE "WinBench 96:Database:Target" �� XE "WinBench 96:Database:Source" �

3.	Choose Merge.

WinBench 96 adds all the records from the source database to the target database. To view these records, you need to add them to the display (see page � PAGEREF _Ref299779478 �100�).

NOTE:	Depending on the number of records in your source database, it may take a while to merge the records from one database to another.

Exporting results

� XE "WinBench 96:Results:Exporting to a file" �� XE "Exporting results" �� XE "Database:Exporting results" �� XE "Results:Exporting" �In addition to saving results to a database, you can export results to an ASCII text file (.TXT), a Lotus 1-2-3 spreadsheet� XE "Lotus 1-2-3 spreadsheet" � (.CSV), an Excel spreadsheet� XE "Excel spreadsheet" � (.XLS), or a Windows Metafile� XE "Windows Metafile" � (.WMF) for use in other applications. You can also export WinBench 96’s Test Screen to a .BMP file.

To export results:

1.	Select Export from the File menu.

You can export:�Which contains:�To this format:��Current Results�Results and Disclosure for the tests run in the current session�.TXT, .CSV, or .XLS��Chart of Results�Results the Chart of Results currently displays�.WMF��Table of Results�Results currently listed in the Table of Results�.TXT��Disclosure�The information currently listed in the Disclosure window�.TXT��Test Screen�The contents of the Test Screen�.BMP��Choosing any of the above options from the Export submenu displays the Export Results to File dialog box.

2.	Enter the name of the file in the File Name dialog box. (You can change the drive and directories using the Drives and Directories portions of this dialog box.)

3.	Choose OK.

WinBench 96 saves the results to the file name and format you specified.

End of Chapter

�Chapter 15: �What Do All These Numbers Mean?

This chapter explains how to read and interpret the Chart and Table of Results. It also explains what the result for WinBench 96’s main tests means about a PC’s performance and what you can do with those results.

Sections in this chapter

� REF _Ref335795146 \* MERGEFORMAT �Bigger Marks mean better performance:  Comparing WinBench 96 results�

� REF _Ref335798296 \* MERGEFORMAT �The units WinBench 96 uses�

� REF _Ref337875727 \* MERGEFORMAT �What WinBench 96’s results mean about a PC’s performance�

� REF _Ref333810798 \* MERGEFORMAT �Making sure a comparison is valid�

� REF _Ref336145331 \* MERGEFORMAT �Using on-line services�

Bigger Marks mean better performance:  Comparing WinBench 96 results

� XE "Chart of Results:Reading" �� XE "Table of Results:Reading" �� XE "WinBench 96:Results:Interpreting" �� XE "Results:Interpreting" �When you first look at WinBench 96’s Chart of Results, the numbers may seem a little overwhelming. The most important thing to remember, however, is that with WinBench 96’s Mark results, bigger numbers mean better performance.

�NOTE:	“Bigger is better” doesn’t apply to all of WinBench 96 results. For example, with some video test results, lower numbers actually indicate better performance. For more information on what the video test results can tell you, see page � PAGEREF _Ref330276046 �111�.

To make it easier to understand a PC’s results, you can choose a set of results to use as a baseline machine. When you select a baseline machine, WinBench 96 sets that machine’s results to 1 and displays all other results as a fraction of the baseline machine’s results.� XE "WinBench 96:Results:Baseline system" �� XE "Results:Baseline system" �� XE "Baseline system" �

When you set a baseline machine, the bar graph for a set of results that is faster (or better) than the baseline machine’s will be more than 1, while the bar graph for a set of results that is slower (or worse) than the baseline machine’s will be less than 1.

The units WinBench 96 uses

� XE "WinBench 96:Results:Units" �� XE "Results:Units" �� XE "Units" �WinBench 96 has five different types of tests:  CD-ROM, disk, graphics, processor, and video.

This type of test:�Produces results using this unit of measurement:��CD-ROM sequential and random read�Thousand Bytes/Sec� XE "Thousand Bytes/Sec" ���CD-ROM Access Time�Milliseconds� XE "Milliseconds" ���CD-ROM CPU Utilization�Percent Used� XE "Percent Used" ���disk�Thousand Bytes/Sec��graphics�Million Pixels/Sec� XE "Million Pixels/Sec" ���video*�Frames Dropped� XE "Frames Dropped" ��Audio Breaks� XE "Audio Breaks" ��Percent Nominal Speed� XE "Percent Nominal Speed" ��Frames/Sec� XE "Frames/Sec" ��Percent Used� XE "Percent Used" ���NOTE:	The processor tests produce relative results—the numbers are normalized, unitless numbers meaningful only when compared to other WinBench 96 processor test results.� XE "Processor tests:Units" �

�What WinBench 96’s results mean about a PC’s performance

WinBench 96 is a subsystem-level benchmark you can use to measure the performance of a PC’s graphics, disk, processor, video, and CD�ROM subsystems in a Windows-based environment. This section explains what the results for the main tests can tell you about a PC’s performance.

Remember, a PC’s configuration will affect its WinBench 96 results. Comparing results for two machines with different configurations is at best a potentially confusing experience. For more information on how to make the most accurate comparison possible, see page � PAGEREF _Ref333810798 �113�.

The Graphics WinMark 96

� XE "WinMark 96:Graphics" �� XE "Graphics WinMark 96" �� XE "WinBench 96:Graphics WinMark 96" �The Graphics WinMark suite gives you an overall comparative measure of the performance of a PC’s graphics subsystem by focusing on graphics operations. It performs a mix of Graphics Device Interface� XE "Graphics Device Interface" � (GDI� XE "GDI" \t "See Graphics Device Interface" �) painting operations that top�selling Windows�based applications use. The tests the Graphics WinMark includes perform operations such as memory to screen BitBlts� XE "BitBlts" � and screen to screen BitBlts and operations that draw both geometric objects (such as lines, circles, and rectangles) and text.

The Graphics WinMark 96 result tells you the number of mil� XE "Million Pixels/Sec" �lions of pixels per second the PC was able to draw during the test. With this result, bigger numbers mean better performance.

You can use the Graphics WinMark 96 result to determine how to optimize the PC’s graphics subsystem to best suit your needs. For example, the Graphics WinMark can help you determine how effectively graphics accelerator cards operate in a Windows environment and process Windows GDI calls. Windows applications use GDI operations to display and draw objects on the screen.

�The Graphics WinMark suite also lets you determine the relative speeds of different screen resolutions and color depths on a single graphics card. For example, you can run the Graphics WinMark suite multiple times on the same PC, changing the screen resolution or color depth each time, and then compare the results for the different test runs.

The Disk WinMark 96

� XE "WinMark 96:Disk" �� XE "Disk WinMark 96" �� XE "WinBench 96:Disk WinMark 96" �The Disk WinMark 96 suite focuses on disk operations and provides an overall comparative measure of the performance of a PC’s disk subsystem.

The Disk WinMark 96 result tells you the number of thousands of bytes per second � XE "Thousand Bytes/Sec" �the PC was able to transfer during the test. With this result, bigger numbers mean better performance.

The Disk WinMark results can tell you how well the PC’s disk subsystem performs when executing these disk operations. Because the test mimics the kind of work applications do, you can use the results as a guide to the kind of throughput you can expect to see when working with the PC’s disk subsystem.

The processor tests:  CPUmark32 and CPUmark16

WinBench 96’s processor tests—CPUmark32� XE "CPUmark32" � and CPUmark16� XE "CPUmark16" �—focus solely on a PC’s processor subsystem and provide an overall measure of the performance of x86 processors running different workloads. (The processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.)

Both processor suites produce relative results:  Their results are normalized, unitless numbers meaningful only when you compare them to other WinBench 96 processor CPUmark results. With these results, bigger numbers mean better performance.

The processor suites can tell you how well the PC’s processor subsystem performs when running 16-bit and 32-bit Windows applications.

�The CD-ROM WinMark 96

The CD-ROM WinMark 96 suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem. (When you run the CD-ROM WinMark 96 suite, the CD�ROM that includes WinBench 96 must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

The CD-ROM WinMark 96 result tells you the number of thousands of bytes per second � XE "Thousand Bytes/Sec" �the PC was able to transfer during the text. With this result, bigger numbers mean better performance.

The CD-ROM WinMark 96 results can tell you how well the PC’s CD-ROM subsystem performs these CD-ROM operations. Because the test mimics the kind of work applications do, you can use the results as a guide to the kind of performance you can expect to see when working with the PC’s CD-ROM subsystem.

The video tests

WinBench 96’s video tests provide concrete measures of a PC’s ability to play full-motion video. Video playback functions stress multiple areas of the PC, including the PC’s processor and graphics subsystems, as well as the CD-ROM or disk subsystems, depending on the location of the video clips you’re playing. (The CD�ROM that includes WinBench 96 also includes WinBench 96’s video clips. When you run a video test, that CD�ROM must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

For each video test, WinBench 96 produces five results. In most other tests, the larger the WinBench 96 test result, the better the performance. With WinBench 96’s video tests, however, bigger numbers do not always mean better performance. The chart on the next page explains what a video test result can tell you.

�





This video test result:�Tells you about:�And you want to see:��Frames Dropped� XE "Frames Dropped" ��The PC’s ability to keep up while playing the test’s video clip.�Lower numbers are better, because the fewer frames the PC drops during the video clip, the better the subjective quality of the picture. WinBench 96 also adds a note to the Table of Results indicating the total number of frames for the video clip.��Audio Breaks� XE "Audio Breaks" ��The PC’s ability to play the video clip’s audio without gaps in the sound.�Lower numbers are better, because the fewer breaks in the audio, the better the subjective quality of the sound.��Percent Nominal Speed� XE "Percent Nominal Speed" ��The speed at which the video clip ran versus the speed at which it should have run, shown as a percentage.�The ideal percentage is 100.

•	If the percentage is greater than 100, it took the PC less time to run the video clip than the actual length of the video clip.

•	If the percentage is less than 100, it took the PC more time to run the video clip than the actual length of the video clip.

All video clips are 15 seconds long except for one long video clip, which runs 120 seconds. If you’re hearing a high number of audio breaks, then the Percent Nominal Speed will probably be less than 100 percent.��Frames/Sec� XE "Frames/Sec" ��The number of frames per second the PC was able to display during the video clip when WinBench 96 plays every frame of the video clip as fast as it possibly can without sound.�Higher numbers are better, because the more frames per second the PC can display, the more time it has to do other things.��Percent Used� XE "Percent Used" ��The percentage of the total processor time the PC spends running the video clip.�Lower numbers are better, because the less time the CPU spends running the video clip, the more time it has to do other things. To determine how much CPU time is available to other 16-bit applications for other work while WinBench 96 played the video clip, subtract the Percent Used result from 100.��Making sure a comparison is valid

� XE "WinBench 96:Results:Valid comparisons" �� XE "Results:Valid comparisons" �Once you’ve run WinBench 96, you’ll want to use its results to judge a PC’s performance. You should, however, remember a few very important details before you begin making any comparisons:

1.	IMPORTANT!  You can’t meaningfully compare the most current release’s results with results from previous versions of WinBench. Each new version of WinBench includes substantial changes, and those changes affect results. So, you should always compare results from the same version of WinBench.

2.	If you have time, read through the sections “� REF _Ref335798296 \* MERGEFORMAT �The units WinBench 96 uses�” on page � PAGEREF _Ref335798296 �108�, and “� REF _Ref337875727 \* MERGEFORMAT �What WinBench 96’s results mean about a PC’s performance�” beginning on page � PAGEREF _Ref335799106 �108�. Those sections explain the units for each of WinBench 96’s main tests and whether bigger or smaller numbers indicate better performance.

3.	If you’re trying to determine which of two PCs outperforms the other, keep in mind that a PC’s hardware and software setup affects its performance. To find out about a PC’s system information at the time you ran WinBench 96, you can view its Disclosure information (for more details, see page � PAGEREF _Ref298830697 �77�).

Finding comparison results

Once you run WinBench 96 and have results for the PC, you have several options for places to find comparison results. This section explains where to find WinBench 96 results to use for comparison.

Checking Ziff-Davis publications� XE "Ziff-Davis:Publications" �� XE "WinBench 96:Results:Ziff-Davis publications" �� XE "Results:Ziff-Davis publications" �

A good way to determine how a PC compares to other PCs is to check published WinBench 96 results in Ziff-Davis publications. Many ZD publications provide PC reviews that include WinBench 96 performance results.

�You can find published results in “First Looks™” articles, comparative reviews, and other stories in such Ziff-Davis publications as:

United States

Computer Life™�Computer Gaming World™�Computer Shopper®�Family PC™�Inter@ctive Week™�PC/Computing®�PC Magazine®�PC Week®�Windows® Sources™�ZD Internet Life™

United Kingdom

Computer Life™�PC Direct®�PC Magazine®

France

PC Direct®�PC Expert®

Germany

PC Direkt®�PC Professionell®

Mexico

PC/Computing® en Español

People’s Republic of China

PC Magazine®�PC/Computing®

You can also find articles about Ziff-Davis benchmarks on Computer Library’s Computer Select® CD�ROM, a database of computer-related product information.

Using on-line services

� XE "ZD Net" �� XE "Ziff-Davis:Benchmark forum" �� XE "Ziff-Davis:On-line service" �� XE "CompuServe" �� XE "World Wide Web" �� XE "WinBench 96:Results:Ziff-Davis on-line services" �� XE "Results:Ziff-Davis on-line services" �If you have a modem and some sort of communications software, you can access Ziff�Davis’ on-line services:

ZD Net™/CompuServe( Edition (GO ZDNET)

ZD Net/World Wide Web Edition (http://www.zdnet.com)

Using the ZD Net forum, you can discuss benchmark results with other testers and with ZD’s benchmark developers.

End of Chapter

�Chapter 16: �What Can Affect Results

This chapter lists some of the many factors about a PC’s configuration that can influence a benchmark’s results for a PC.� XE "WinBench 96:Results:What can affect results" \r "WhatAffectsResults" �

Sections in this chapter

� REF _Ref299443068 \* MERGEFORMAT �What this chapter covers�

� REF _Ref336154279 \* MERGEFORMAT �Our benchmarks work with subsystems, not individual components�

� REF _Ref336249894 \* MERGEFORMAT �The graphics subsystem�

� REF _Ref299443206 \* MERGEFORMAT �The disk subsystem�

� REF _Ref336249900 \* MERGEFORMAT �The processor subsystem�

� REF _Ref333820553 \* MERGEFORMAT �The CD-ROM subsystem�

� REF _Ref296939614 \* MERGEFORMAT �Testing tips�

What this chapter covers

Many factors, both hardware and software, can affect a benchmark’s results. For example, a PC’s CPU speed obviously affects results. Perhaps less obvious is that if a PC has a fragmented disk, its results may often be lower than if you reformat or defragment the disk before you run each test.

�There are also facets of a computer’s architecture you may not normally consider that can affect results. For example, some PCs in the ZDBOp research center showed improved performance if we replaced single SIMMs with multiple SIMMs. One PC ran tests faster with four 4MB 72-bit SIMMs instead of one 16MB 72-bit SIMM.

Understanding the configuration of a PC is very important when you begin to analyze a benchmark’s results. For information on how WinBench 96 determines a PC’s configuration and how to view those statistics, see page � PAGEREF Chapter12WorkingwithDisclosure �77�.

This chapter contains as much useful information as is practical. It can’t, however, cover everything there is to know about PCs and how they work.

So, this chapter specifically serves as a starting point. It briefly explains each of a PC’s main subsystems, the components of that subsystem, how it interacts with other subsystems, and how all this can affect a benchmark’s results.

Our benchmarks work with subsystems, not individual components� XE "WinBench 96:Subsystems" �� XE "Subsystems" �

WinBench 96 measures the performance of subsystems, not the performance of individual components. Although WinBench 96’s tests attempt to measure the performance of individual subsystems, all these tests must run on the processor. Thus, the processor subsystem necessarily will affect results for every test. For example, the hard disk is part of the disk subsystem and will not affect the results for graphics tests. So, instead of talking about individual components, it makes more sense to talk about a PC’s subsystems and what composes those subsystems.

As we see it, a PC has four basic subsystems:  graphics, disk, processor, and CD-ROM. (WinBench 96’s video tests use the graphics, processor, and either the disk or CD-ROM subsystems.)

The next sections discuss each individual subsystem, enumerating the components in each subsystem, and describes factors that may affect test results.

The graphics subsystem� XE "Subsystems:Graphics" �� XE "Graphics subsystem" �

A PC’s graphics subsystem includes the:

Monitor

Graphics adapter

Graphics driver

Bus used to carry information from the graphics adapter to and from the processor subsystem.

Factors about the graphics subsystem that can affect benchmark results include the:

Refresh rate� XE "Refresh rate" �� XE "WinBench 96:Refresh rate" �, resolution� XE "Resolution" �� XE "WinBench 96:Resolution" �, and color depth � XE "Color depth" �� XE "WinBench 96:Color depth" �of the monitor.

More colors can slow down a PC’s performance. While higher resolutions can also slow down performance, they usually do so to a lesser extent. Although a higher refresh rate will reduce screen flicker, it will generally slow performance if the PC has a DRAM graphics adapter.

NOTE:	� XE "Graphics cards:Comparing" �� XE "Comparing graphics cards" �To compare two graphics cards fairly, both should generally use the same refresh rate. WinBench 96 includes a test that lets you determine or verify the monitor’s refresh rate (see page � PAGEREF _Ref299784387 �80� for more information).

Amount and type of graphics adapter RAM� XE "Graphics adapter RAM" �.

The graphics adapter card uses Dynamic RAM� XE "RAM" � (DRAM) chips or Video RAM (VRAM) chips on the graphics adapter. VRAM� XE "VRAM" � chips have two access ports compared to a single access port for DRAM. VRAM is generally better than DRAM, although more expensive. VRAM allows faster access to the RAM by the CPU or graphics accelerator.

A local�bus architecture, which links the CPU with the graphics subsystem, can speed up drawing, because the PC doesn’t have to route the data through a slower expansion bus.

The disk subsystem� XE "Subsystems:Disk" �� XE "Disk subsystem" �

The disk subsystem includes the:

Hard disk

Disk controller

Disk device drivers

Any disk caches� XE "Disk cache" �� XE "Cache:Disk" � (hardware or software) you have installed

Bus used to carry information from the disk controller to and from the processor subsystem.

Factors about the disk subsystem that can affect a PC’s performance include:

Presence of a hardware disk cache and its size.

Presence of a software disk cache and its size.

Whether the software disk cache is caching writes.

Disk subsystem performance generally improves when caching writes.

Disk compression.

Operating system software.

How much free disk space is available on the hard disk.

Whether the hard disk is fragmented.� XE "Disk:Fragmented" �� XE "Fragmentation" �

We recommend you defragment a PC’s hard disk each time you run any benchmark test. A fragmented hard disk can slow everything down. The hard disk becomes fragmented as you free space and then save files whose data doesn’t fit into one connected space on the hard disk.

Is 32-bit disk access� XE "32-bit disk access" � turned on?

Is 32-bit file access� XE "32-bit file access" � turned on for Windows for Workgroups?

For Windows 95� XE "Windows 95" �, does the PC use protected mode drivers to access the disk?

To find out if the PC uses any real mode drivers, look in the Performance tab of the System control panel.

The processor subsystem� XE "Subsystems:Processor" �� XE "Processor subsystem" �

The components of the processor subsystem include the:

CPU

FPU� XE "FPU" �

Memory (RAM� XE "RAM" �)

External caches� XE "External caches" �� XE "Cache:External" �

Memory bus architecture, which is the pathway along which data shuttles between RAM and the CPU.

Factors about the processing subsystem that can affect a benchmark’s results include:

The memory speed.

Whether the memory is interleaved.

The memory type (for example, EDO DRAM� XE "EDO DRAM" � versus fast-page mode DRAM� XE "DRAM" �).

Amount of memory.

A general rule of thumb for Windows is the more RAM the better.

You can set aside some parts of RAM for disk caches, although this reduces the amount of RAM available to applications.

You also need to consider the speed and organization of the RAM, though this isn’t a critical factor. There’s no easy way, however, to determine these factors. The invoice or specification for the PC may list its RAM speed. Determining the RAM’s organization may be more difficult. (It may be interleaved, allowing for faster sequential access by the CPU. Whether the memory is 16-, 32-, or 64-bits wide will also affect performance.)

The CPU model and clock speed.

Some PCs also have a TURBO button� XE "TURBO button" � on the front of the machine. If the PC has a TURBO button, you want to keep it turned on.

Any internal or external CPU RAM caches� XE "Cache:Internal" �� XE "Cache, external" �, their organizations (for example, direct-mapped or set-associative), whether they are write through or write back, and whether they are enabled.

If the cache is set associative instead of direct mapped, the CPU’s access time to data may be better. Also, whether the cache supports write back or write through processing can affect the speed at which the CPU can write data to memory. (With write back cache� XE "Write back cache" �� XE "Cache:Write back" �, the CPU writes data into cache first and then into memory later, thus speeding up the writes. With write through cache, the CPU writes data directly to cache and memory, causing writes to be slower.)

Whether the PC has a math coprocessor.

A math coprocessor� XE "Math coprocessor" � helps speed certain mathematical calculations (such as those in spreadsheets) in 8088, 8086, 80286, 80386, and 80486 SX CPU’s. 80486 DX and Pentium CPUs have the coprocessor circuitry built in.

The CD-ROM subsystem� XE "Subsystems:CD-ROM" �� XE "CD-ROM subsystem" �

The CD-ROM includes the:

CD-ROM drive

Adapter to which the drive is connected

Software drivers it requires to operate

Any software caches� XE "Cache:Software" �

Bus used to carry information from the controller to and from the processor subsystem.

You should remember the following important facts about a PC’s CD-ROM subsystem.

Presence of a hardware CD-ROM cache and its size.

Presence of a software CD-ROM cache and its size.

Operating system software.

For Windows 95� XE "Windows 95" �, does the PC use protected mode drivers to access the CD-ROM?

To find out if the PC uses any real mode drivers, look in the Performance tab of the System control panel.

Clean the CD-ROM.

Testing tips� XE "WinBench 96:Testing tips" \r "Tips" �� XE "Testing tips" \r "Tips" �� XE "Results:Testing tips" \r "Tips" �

The way to get the best and most accurate and repeatable results is to follow the same standard testing procedure each time you run WinBench 96. Each time you run WinBench 96, you should:� XE "WinBench 96:Standard test procedures" �� XE "Results:Standard test procedures" �� XE "Standard testing procedures" �

1.	Defragment your hard disk.

2.	Free as much RAM as reasonably possible by removing any statements from the PC’s AUTOEXEC.BAT� XE "AUTOEXEC.BAT" � and CONFIG.SYS� XE "CONFIG.SYS" � files that load programs or drivers it doesn’t need.

3.	Reboot the PC by turning it off and then turning it back on.

4.	Restart WinBench 96 immediately.

The sections that follow list other ways you might improve a PC’s performance and possibly achieve better benchmark results.

Background tasks� XE "Background tasks" �� XE "WinBench 96:Background tasks" �

Halt any minimized or background tasks before you run WinBench 96. Ideally, you should disable all such tasks and clear system memory, including any caches other than SMARTDrive� XE "SMARTDrive" � and the 32-bit file access� XE "32-bit file access" � cache (if you’re running Windows for Workgroups), by rebooting the PC.

NOTE:	WinBench 96 will report any background tasks that are running when you start a test. WinBench 96 won’t, however, automatically terminate those tasks nor will it halt its tests because those tasks are running.

Batch mode

� XE "WinBench 96:Batch mode" �� XE "Batch mode" �To get the most repeatable results, run WinBench 96 in batch mode from the DOS prompt using a command such as:

WIN C:\ZDBENCH\WB96\WB96.EXE AUTO C:\ZDBENCH\WB96\batch.ini

where batch.ini is the name of a batch mode .INI file. See the RUNWB.INI� XE "RUNWB.INI" � file or the WinBench 96 documentation for an explanation of the batch mode .INI file.

Disk subsystem� XE "Subsystems:Disk" �� XE "Disk subsystem" �

For best performance, the hard disk partition on which you run WinBench 96 should contain as much contiguous free disk space as possible. You should defragment the hard disk with a defragmentation tool before you run each test.

With some older ST-506 or ESDI hard disks, you may improve the WinBench 96 results by performing a low-level initialization first and adjusting the disk sector interleave factor for optimal performance.

When you use SMARTDrive� XE "SMARTDrive" � or any other disk-cache software of your choice, you should set the disk cache for optimal performance based on the amount of physical memory in the PC. You should also turn on write caching for the drive you’re testing.

NOTE:	Remember, disk-cache software can compete with Windows for available system RAM. Also, remember to check that SMARTDrive has completed all write-caching before you turn off the PC.

Disk compression programs may actually slow system performance.

Turn on 32-bit disk access� XE "32-bit disk access" �.

If you’re running Windows for Workgroups 3.11, turn on 32-bit file access� XE "32-bit file access" �.

Enable write caching in the software disk cache.

Network client software

Background tasks� XE "Background tasks" �, such as network activity, can influence WinBench 96’s results. A typical network client spends some CPU time processing network data packets and interrupts even when applications on the client aren’t using the network. High volumes of such packets (such as network broadcasts) can reduce WinBench 96’s results by consuming system resources during test suites.

If you run WinBench 96 across a network, try to do so in an isolated test network or when the volume of network traffic is low.

Operating systems

For the most repeatable results, you should stop all other programs and disable any network connections. You should also reboot the PC before running WinBench 96, use an automated mechanism to start WinBench 96, and use batch mode to run your tests. Under these operating systems, other tasks can preemptively run during WinBench 96’s tests, thus affecting the results. So you’ll want to eliminate as many of these types of tasks as possible.

We also suggest you run the tests at least twice to verify that the results are reproducible. We believe that, if you follow consistent testing procedures and don’t have other tasks running, your results will be reproducible. We’re continuing to investigate ways to test WinBench 96 under each of these operating systems.

Windows 95

You’ll need to set the Windows 95� XE "Windows 95" � Task Bar to Auto Hide mode in order to run the WinBench 96 graphics tests.  Also, you must maximize WinBench 96 to the full size of the screen to run the graphics tests.

OS/2 Warp� XE "OS/2 Warp" �

If you’re running the Processor/32-Bit� XE "Tests:Processor/32-Bit" � test or the CPUmark32� XE "CPUmark32" �,  make sure you use an enhanced mode Win-OS/2� XE "Win-OS/2" � session and install Win32s� XE "Win32s" � version 1.1. The SETUP.EXE file is in the \WIN32S\11\DISK1 directory on the CD-ROM.

Processor subsystem� XE "Subsystems:Processor" �� XE "Processor subsystem" �

Before you run WinBench 96, you should make sure your CPU is running at the highest possible speed. If the PC has a TURBO� XE "TURBO" � button, make sure it’s turned on.

Physical memory (RAM� XE "RAM" �)

Enable processor caches.

Maximize free memory before you execute WinBench 96.

Reduce memory usage by disabling processes such as automatic network connection utilities and application start-up utilities.

Allocate as much RAM as possible to extended memory. (Refer to the Microsoft Windows Users Guide for information on optimizing the memory caching system for Windows.)

Windows

Before you install Windows on the PC, check the Microsoft Windows Users Guide for optimization guidelines appropriate to the PCs processor and other resources.

Check the load= and run= statements in the WIN.INI� XE "WIN.INI" � file and the StartUp Program Manager Group. You should ideally have no tasks other than WinBench 96 running when you run a suite.

Modes for Windows

You can run WinBench 96 in Windows in either standard � XE "Standard mode" �� XE "Windows:Standard mode" �or enhanced mode� XE "Enhanced mode" �� XE "Windows:Enhanced mode" �. Generally, standard mode is faster than enhanced mode. The Processor/32-Bit� XE "Tests:Processor/32-Bit" � and the CPUmark32� XE "CPUmark32" � tests will not run in standard mode.

NOTE:	If you’re running WinBench 96 under Windows for Workgroups 3.11, you should use enhanced mode and enable 32-bit file access� XE "32-bit file access" � for improved results.

Video tests� XE "Tests:Video" �� XE "Video tests" �� XE "WinBench 96:Tests:Video" �

The following sections provide a few tips on how to used WinBench 96’s video tests to measure the video subsystem’s performance.

Picking video clips

If you want to measure video subsystem performance for typical applications, pick single or double speed (150 or 300KB/S) and 15 or 30 fps (frames per second) video clips. Most applications assume single speed drives and use 15 fps, although some newer applications are starting to require double speed drives. Higher frames per second or a lower data rate will decrease the quality of individual frames

If you want to stress the video subsystem, choose one of the higher data rate video clips (for example, a quad speed clip at 600KB/S).

Should you play the video clips from the CD-ROM or hard disk?

In most cases, you should play all clips directly from the CD-ROM when measuring system performance.

If you want to measure graphics adapter performance in a graphics card roundup (leaving the rest of the system constant), you should copy the clips to the test PC’s hard disk to eliminate any bottlenecks introduced by the CD-ROM drive.

What video test measurement do you report?

The most important video test measurement to report is Frames Dropped.

If all the test PC produce very good results for Frames Dropped� XE "Frames Dropped" � (close to zero), you can differentiate the PCs by using the CPU Utilization measurement. This measurement indicates the amount of CPU bandwidth consumed when playing the video clip (lower results are better).

Another measurement you can use to differentiate systems is the Max Frame Rate. This measurement indicates the number of frames per second the PC’s video subsystem can display (without audio). You should use this measurement only if the bandwidth of the drive (CD or hard disk) that contains the video clip is significantly faster than the actual data rate of the video clip (i.e., use a single speed video clip in a double or quad speed CD�ROM drive). Do not use this measurement when the video clip’s data rate is equal to the CD�ROM drive’s data rate. Otherwise the video clip itself, and not the video subsystem, will be limiting the maximum frame rate.

End of Chapter

�Chapter 17: �Publishing Results

This chapter explains what the license agreement requires and what information you must therefore include with each result you publish.

Sections in this chapter

� REF _Ref297003163 \* MERGEFORMAT �What the license agreement requires�

� REF _Ref336759355 \* MERGEFORMAT �Rereading the license agreement�

What the license agreement requires

� XE "WinBench 96:Results:Publishing" �� XE "Results:Publishing" �� XE "Publishing results" �The WinBench 96 license agreement requires you to include certain information about a PC with any WinBench 96 results you publish. If you publish a PC’s WinBench 96 results, you would need to say something similar to:

Ziff-Davis’ WinBench® 96 Version 1.0 produced a score of X Graphics WinMark™ 96 on WXY PC Corp. Model 466 with a 66�MHz Intel 486DX2�66 CPU, 8MB of RAM, 64KB RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache. The test PC used XYZ Corp. XYZ Graphics adapter with 2MB VRAM and XYZ.DRV version 1.1 driver, a refresh rate of 72 Hz, Microsoft Video for Windows version 1.1e, and Intel Indeo™ Video version 3.2 CODEC. The test PC used XYZ Corp. XYZ CD�ROM Quad-Speed drive, XYZ Corp. CD-ROM controller, with no controller RAM cache and no CD-ROM specific software cache. The test PC also used MS�DOS 5.0, Microsoft Windows 3.1, SMARTDrive 2MB cache, a resolution and color depth of 800 by 600 pixels with 256 colors, and disk compression utility ABC version 1.0 enabled. All products used in the test were shipping versions available to the general public, and Ziff�Davis did not verify the test and its results.

WinBench® is a registered trademark and WinMark™ is a trademark of Ziff�Davis Publishing Company.

You can find most of this information in WinBench 96’s Disclosure window (see the section “� REF _Ref298830697 \* MERGEFORMAT �Viewing Disclosure information�” beginning on page � PAGEREF _Ref298830697 �77� for more information).

Rereading the license agreement

To reread the WinBench 96 license agreement:

Choose License from the Help drop-down menu in the main window. WinBench 96 then displays the license agreement.

Look at the front of this manual.

Read the README.WRI file. There’s a Read Me icon in the Ziff-Davis Benchmarks program group.

End of Chapter

�Part 5: �Looking Under the Hood—�How WinBench 96 Works

Chapter 18:	� REF Chapter17HowWeDeveloped \* MERGEFORMAT �How We Developed WinBench 96’s Tests��Explains the design concepts behind Ziff-Davis’ WinBench 96 development.

Chapter 19:	� REF Chapter18WhattheSuitesDo \* MERGEFORMAT �What the Tests Do��Discusses in detail what the WinBench 96 tests do when you run them.

Chapter 20:	� REF Chapter19CalculatesScore \* MERGEFORMAT �How WinBench 96 Computes Its Results��Explains how WinBench 96 calculates its results.

�Chapter 18: �How We Developed WinBench 96’s Tests

Ziff-Davis understands that measuring system performance in an accurate and repeatable way is important to you. So, before we release a benchmark, we do our homework. We research current trends in the PC market, analyze new software and hardware that’s available, and figure out what is important to a typical user of that software and hardware.

This chapter explains why WinBench 96 measures performance the way it does.

Sections in this chapter

� REF _Ref293907228 \* MERGEFORMAT �Using a market-centered approach to research�

� REF _Ref335803674 \* MERGEFORMAT �Profiling is key�

� REF _Ref297004905 \* MERGEFORMAT �Parameter distributions�

Using a market-centered approach to research

� XE "Market-centered research" �� XE "WinBench 96:Market-centered research" �When we began researching today’s Windows PC market to determine what types of functions and tasks WinBench 96’s tests should perform, we used a “market�centered” approach. All WinBench 96’s tests specifically focus on the types of use best-selling applications actually receive on PCs today.

While WinBench 96 can’t duplicate the exact functions you perform on the PC with your applications, it does reflect the way typical users use top�selling applications. For example, instead of targeting our tests for particular groups of specialized users, such as engineers who spend all day running simulations and CAD programs, WinBench 96’s tests aim for users who use applications closer to the center of the sales market. This approach lets WinBench 96 reflect the center of the software market. and provides you with a more realistic view of a PC’s performance.

Profiling is key

� XE "WinBench 96:Profiling" �WinBench 96’s tests mimic the operations performed by today’s most popular Windows applications.

At this point, you may be thinking “doing what real applications do is a good thing, but how can I be sure WinBench 96 accurately mimics real applications?”

The answer is profiling. Profiling is a means of monitoring an application as it executes and then recording the subsystem-level operations it performs. Profiling has been an important foundation of our benchmarks for years. We use both commercially available and in�house profiling tools to profile many different top-selling applications as they perform typical tasks.

The results of those profiling efforts determined the way the tests in WinBench 96 work. We designed each test to reflect the statistical profiles of a set of target applications. So, WinBench 96 doesn’t just give you a random number that has little to do with how your PC performs on a day-to-day basis. WinBench 96’s tests reflect the way real-world applications perform typical tasks.

Parameter distributions

� XE "WinBench 95:Parameter distributions" �� XE "Parameter distributions" �Application profiling determined the distribution of operations and the parameters of those operations in the WinBench 96 tests. WinBench 96 models the distribution of operations in the profiled applications.

Distribution is the process of varying parameters for operations and the operations themselves to reflect how applications actually perform them. WinBench 96’s tests reflect the varied ways applications use these operations by assigning different parameters to the same operations.

So, WinBench 96’s tests don’t do the same operations over and over again. For any given operation, the benchmark varies the parameters of that operation and makes each operation a little different.

End of Chapter

�Chapter 19: �What the Tests Do

To better understand WinBench 96’s results for a PC, it helps to know what the test that gave you those results did when you ran it. This chapter explains what WinBench 96’s key tests do.

Sections in this chapter

� REF _Ref293284669 \* MERGEFORMAT �What the main test suites do�

� REF _Ref335811208 \* MERGEFORMAT �What other test suites do�

� REF _Ref336143637 \* MERGEFORMAT �What the different types of tests do�

What the main test suites do

� XE "WinBench 96:What the main tests do" \r "WhatMainTestsDo" �To make testing a PC as convenient as possible and to give you the best way to get repeatable results, WinBench 96 provides several key test suites—the Graphics, Disk, and CD-ROM WinMark 96 suites and the CPUmark16 and CPUmark32 suites. Each of these suites lets you run a test or group of tests by clicking only a few buttons.

The next sections tell you about each of these main test suites.

The Graphics WinMark 96� XE "WinMark 96:Graphics" �� XE "Graphics WinMark 96" �� XE "WinBench 96:Graphics WinMark 96" �

The Graphics WinMark suite gives you an overall comparative measure of the performance of a PC’s graphics subsystem by focusing on graphics operations. (For a list of the components that make up the graphics subsystem and what about that subsystem can affect results, see page � PAGEREF _Ref337879188 �119�.)

The Graphics WinMark 96 suite performs a mix of Graphics Device Interface (GDI) painting operations that top�selling Windows�based applications use. The tests the Graphics WinMark includes perform operations such as memory to screen BitBlts and screen to screen BitBlts and operations that draw both geometric objects (such as lines, circles, and rectangles) and text.

How we created the suite

To determine which graphics operations to include in the Graphics WinMark suite, we profiled the 13 Windows�based applications Winstone 96� XE "Winstone 96" � uses in its overall test. The application profiles determine the distribution, frequency, and typical parameters of these operations.

To make certain our profiling� XE "Profiling" � was as accurate as possible, we developed a tool that records application drawing operations without interfering or modifying the original application. Using this tool, we recorded the graphics operations for each of the 13 applications.

What the suite does when you run it

The Graphics WinMark suite consists of 13 Combined GWM tests� XE "Combined GWM tests" �� XE "Tests:Combined GWM" � (Combined GWM 1 through Combined GWM13). Each of the Combined GWM tests executes a different set of graphics tests. When you choose the Graphics WinMark suite, WinBench 96 runs each of the Combined GWM tests, beginning with Combined GWM 1 and moving sequentially through the tests to Combined GWM13.

� XE "Tests:Graphics" �Each graphics test included in a Combined GWM test executes a series of graphics functions. What you’ll see on the PC’s screen is WinBench 96 drawing many types of shapes, pictures, and text. The Combined GWM tests use a mixture of GDI functions to make sure WinBench 96 doesn’t execute the same graphics function over and over. For example, instead of drawing a line of the same length in the same place many times, the tests draw lines of many different lengths at many different locations on the screen intermingled with other types of drawing operations.

The results it produces

After all the Combined GWM tests complete, WinBench 96 returns a single result called the Graphics WinMark 96. This result is a weighted harmonic mean� XE "Weighted harmonic mean" � of the 13 Combined GWM tests results.

The Graphics WinMark 96 result tells you the million of pixels per second (Million Pixels/Sec� XE "second (Million Pixels/Sec" �) the PC was able to draw during the test. With this result, bigger numbers mean better performance.

You can use the Graphics WinMark 96 result to determine how to optimize the PC’s graphics subsystem to best suit your needs. For example, the Graphics WinMark can help you determine how effectively graphics accelerator cards operate in a Windows environment and process Windows GDI calls. Windows applications use GDI operations to display and draw objects on the screen.

The Graphics WinMark suite also lets you determine the relative speeds of different screen resolutions and color depths on a single graphics card. For example, you can run the Graphics WinMark suite multiple times on the same PC, changing the screen resolution or color depth each time, and then compare the results for the different test runs.

The graphics tests the Graphics WinMark 96 suite executes

The following table gives you a breakdown of the graphics tests each Combined GWM test executes when you run the Graphics WinMark 96 suite. (The section “� REF _Ref300634777 \* MERGEFORMAT �The graphics tests�” on page � PAGEREF _Ref300634777 �159� explains generally what a graphics test does.)

This test:�Is a combination of these graphics tests:��Combined GWM 1�GWM/S/ExtTextOut, Rectangle���GWM/S/Text, Sans Serif Bold 13, Clip���GWM/S/PatBlt, PATCOPY, Clip���GWM/S/PatBlt, PATCOPY��Combined GWM 2�GWM/S/PatBlt, Others���GWM/S/Text, Sans Serif 13���GWM/S/Text, Times Roman 15���GWM/CToS/BitBlt, SRCCOPY���GWM/S/ExtTextOut, Rectangle, Clip���GWM/S/Text, System 16���GWM/C/ExtTextOut, Rectangle���GWM/S/Text, Arial 16��Combined GWM 3�GWM/S/PatBlt, MonoPATCOPY, Clip���GWM/S/PatBlt, MonoPATCOPY���GWM/S/PatBlt, MonoOthers���

This test:�Is a combination of these graphics tests:��Combined GWM 4�GWM/C/Line, Vertical���GWM/CToC/BitBlt, Others���GWM/S/Rectangle���GWM/S/Rectangle, Clip���GWM/S/PatBlt, Others, Clip���GWM/S/Polygon, Few-sides, Clip���GWM/C/Line, Horizontal���GWM/S/Line, Horizontal, Clip���GWM/S/GetPixel���GWM/MToS/BitBlt, SRCCOPY, Clip���GWM/CToS/BitBlt, SRCCOPY, Clip���GWM/S/Line, Vertical, Clip���GWM/S/PatBlt, DSTINVERT���GWM/S/SetPixel���GWM/S/Line, Horizontal���GWM/S/Line, Vertical���GWM/S/Text, Sans Serif 16��Combined GWM 5�GWM/C/PatBlt, PATCOPY���GWM/C/Text, Arial 16���GWM/C/ExtTextOut, Rectangle, Clip���GWM/S/PatBlt, WHITENESS���GWM/MToC/BitBlt, Others���GWM/MToS/BitBlt, Others���GWM/C/Rectangle���GWM/S/Polygon, Few-sides���GWM/CToS/BitBlt, Others���GWM/S/Text, Times Roman 19���

�This test:�Is a combination of these graphics tests:��Combined GWM 6�GWM/C/Rectangle, Clip���GWM/C/Polygon, Few-sides���GWM/M/PatBlt, WHITENESS, Clip���GWM/M/Text, Times Roman 15���GWM/S/Line, Diagonal���GWM/M/PatBlt, ROP(FA)���GWM/SToS/BitBlt, SRCCOPY���GWM/SToC/BitBlt, SRCCOPY���GWM/C/PatBlt, PATCOPY, Clip���GWM/C/Text, Times Roman 15, Clip���GWM/C/SetDIBitsBlt, 4 bpp���GWM/S/InvertRgn���GWM/S/Text, Times Roman 29���GWM/M/Text, Times Roman 16, Clip���GWM/S/StretchDIBits, 4 bpp, SRCCOPY���GWM/S/PolyLine���GWM/M/PatBlt, WHITENESS��Combined GWM 7�GWM/C/PatBlt, MonoPATCOPY, Clip���GWM/C/PatBlt, MonoOthers���GWM/C/PatBlt, MonoPATCOPY���GWM/S/PatBlt, MonoOthers, Clip��Combined GWM 8�GWM/M/Text, System 16���GWM/S/Polygon, Many-sides���GWM/S/PolyPolygon���GWM/MToC/BitBlt, SRCAND, Clip���GWM/CToM/BitBlt, Others���GWM/SToS/BitBlt, SRCCOPY, Clip���GWM/S/PatBlt, WHITENESS, Clip���GWM/S/PaintRgn���GWM/S/Rectangle, Rounded���GWM/S/PatBlt, DSTINVERT, Clip���GWM/C/Text, Times Roman 16���GWM/C/Polygon, Few-sides, Clip���GWM/CToC/BitBlt, Others, Clip���GWM/M/PatBlt, Others���GWM/C/PolyLine���

This test:�Is a combination of these graphics tests:��Combined GWM 9�GWM/M/ExtTextOut, Rectangle���GWM/S/Polygon, Many-sides, Clip���GWM/M/Rectangle, Clip���GWM/C/SetPixel���GWM/C/Polygon, Many-sides���GWM/M/SetDIBitsBlt, 1 bpp���GWM/MToS/BitBlt, Others, Clip���GWM/C/PatBlt, Others���GWM/M/Rectangle���GWM/C/Text, Times Roman 40���GWM/C/Text, Arial Bold 24���GWM/CToS/BitBlt, Others, Clip��Combined GWM 10�GWM/C/Ellipse���GWM/C/Line, Diagonal���GWM/S/Pie, Elliptical���GWM/SToM/BitBlt, SRCCOPY���GWM/C/Line, Vertical, Clip���GWM/S/FillRgn���GWM/C/Line, Diagonal, Clip���GWM/M/Text, Times Roman Bold 17���GWM/C/SetDIBitsBlt, 8 bpp���GWM/CToS/StretchBlt, SRCCOPY, Clip���GWM/M/Text, Times Roman Bold 19���GWM/S/SetDIBitsToDevice, 4 bpp��Combined GWM 11�GWM/S/StretchDIBits, 8 bpp, SRCCOPY���GWM/MToM/BitBlt, Others���GWM/CToM/BitBlt, SRCCOPY, Clip���GWM/S/StretchDIBits, 4 bpp, SRCCOPY, Clip���GWM/CToS/StretchBlt, SRCCOPY���GWM/C/InvertRgn���GWM/C/PatBlt, DESTINVERT, Clip��Combined GWM 12�GWM/C/StretchDIBits, 4 bpp, SRCCOPY���GWM/S/Ellipse���GWM/S/Ellipse, Clip��Combined GWM 13�GWM/C/BltDIBits, 8 bpp, SRCCOPY���GWM/S/Arc, Elliptical, Complete���GWM/S/Circle��The Disk WinMark 96� XE "WinMark 96:Disk" �� XE "Disk WinMark 96" �� XE "WinBench 96:Disk WinMark 96" �

The Disk WinMark 96 suite focuses on disk operations and provides an overall comparative measure of the performance of a PC’s disk subsystem. (For a list of the components that make up the disk subsystem and what about that subsystem can affect results, see page � PAGEREF _Ref299443206 �119�.)

How we created the suite

The Disk Mix consists of 13 different sections. Each section executes a set of disk operations corresponding to the operations performed by one of the 13 applications included in Winstone 96� XE "Winstone 96" �. Each of the 13 sections has two phases. In the first phase of each section, WinBench 96 creates the files and directories it needs for the test. (WinBench 96 doesn’t time this phase of the test.) In the second phase of each section, WinBench 96 times how long it takes the PC to complete the disk operations.

We gathered information on what types of disk operations Windows�based applications perform by profiling� XE "profiling" � the 13 top�selling applications Winstone 96 runs during its overall test. The Disk WinMark is an almost exact playback of these disk operations.

To make certain our profiling was as accurate as possible, we developed a tool that records application I/O operations, including hard disk operations and CD-ROM operations, without interfering or modifying the original application. Using this tool, we recorded the disk operations for each of the 13 applications and then combined these into one disk mix.

What the suite does when you run it

When you run the Disk WinMark 96 suite, you actually run a single large test called the Disk Mix. The Disk Mix� XE "Disk Mix" �� XE "Tests:Disk Mix" �� XE "WinBench 96:Tests:Disk Mix" � executes a series of disk operations similar to typical disk operations that leading applications perform. It creates and deletes files, moves data in chunks of different sizes, intersperses write and read operations, and works with multiple files at the same time. While the suite is running, WinBench 96 displays a status dialog box on the PC’s screen.

The results it produces

The Disk WinMark 96 suite returns a single result called the Disk WinMark. When the suite finishes, there are 13 numbers—one for each timed section. As WinBench 96 completes each section’s timed phase, it computes the bytes per second rate for that section. The bytes per second rate is the rate at which the PC performs the disk operations in that section of the test. WinBench uses a harmonic mean, with the same weights Winstone uses for these applications, to average these 13 numbers.

The Disk WinMark 96 result tells you the number of thousands of bytes per second � XE "Thousand Bytes/Sec" �the PC was able to transfer during the test. With this result, bigger numbers mean better performance.

The Disk WinMark results can tell you how well the PC’s disk subsystem performs when executing these disk operations. Because the test mimics the kind of work applications do, you can use the results as a guide to the kind of throughput you can expect to see when working with the PC’s disk subsystem.

The processor tests:  CPUmark32 and CPUmark16

� XE "Processor tests" �The CPUmark32� XE "CPUmark32" � and CPUmark16� XE "CPUmark16" � � XE "Tests:CPUmark32" �� XE "Tests:CPUmark16" �tests measure the performance of x86 processors running different workloads.

The CPUmark32 measures the processor subsystem’s speed at running 32-bit Windows applications.

The CPUmark16 measures the processor subsystem’s speed at running 16-bit Windows applications.

When you run one of these processor tests, WinBench 96 runs a large instruction mix that carefully emulates the processor activity of real-world applications. The CPUmark32 executes 32-bit operations, and the CPUmark16 executes 16�bit operations.

Both tests are useful tools for measuring how well a PC’s processor subsystem—its CPU, RAM, cache, and cache controller—will perform when running 32-bit and 16-bit Windows software. (For a list of the components that make up the processor subsystem and what about that subsystem can affect results, see page � PAGEREF _Ref336249900 �120�.) Each processor test focuses solely on a PC’s processor subsystem. They perform no I/O operations or other functions that might involve a PC’s graphics or disk subsystems.

How we created these tests

The workload for each processor test is not all one type of work, but rather, a carefully weighted combination of many different modules. Each module does one or more types of real work, such as compressing data, adjusting dates, analyzing words, or formatting text. The combined overall workload simulates the processor behavior of leading Windows applications.

�� XE "Profiling" �To make certain the workload these tests simulate are accurate, we worked with the major x86 processor vendors to profile a variety of leading 32- and 16-bit applications. The application profiles contained a large set of statistics about how those applications interacted with the processor. Those statistics include such important facts as the types of instructions the applications execute, the frequency of each instruction type, and how often the processor was able to find the data it needed in its RAM cache.

The CPUmark32 test reflects the results of the profiling process for 32-bit applications. During the development process, we fine-tuned the suites behavior to correlate highly with the profiled 32-bit application behavior. Similarly, the CPUmark16 test reflects the results of this process for 16-bit applications.

The results it produces

Both processor tests produce relative results:  Their results are normalized, unitless numbers meaningful only when you compare them to other WinBench 96 processor CPUmark results. With these results, bigger numbers mean better performance.

The CD-ROM WinMark 96� XE "WinMark 96:CD-ROM" �� XE "CD-ROM WinMark 96" �� XE "WinBench 96:CD-ROM WinMark 96" �

The CD-ROM WinMark 96 suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem. When you run the CD-ROM WinMark 96 suite, the CD�ROM that includes WinBench 96 must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test. (For a list of the components that make up the CD-ROM subsystem and what about that subsystem can affect results, see page � PAGEREF _Ref333820553 �122�.)

How we created the suite

� XE "Profiling" �To create the CD-ROM WinMark suite, we profiled six of today’s most popular Windows CD�ROM applications. To make certain our profiling was as accurate as possible, we developed a tool that records application I/O operations, including hard disk operations and CD-ROM operations, without interfering or modifying the original application. Using this tool, we recorded the CD-ROM operations for each of the six applications and then combined these into one CD-ROM mix.

We wanted to represent a wide variety of applications and to use some of the most popular CD-ROM applications available today. So, we began by grouping CD-ROM applications into three general categories:  Business and Productivity, Games and Entertainment, and Reference and Education. Then, based on market research, we chose two of the most popular Windows-based applications from each group.

Here is an alphabetized list of the applications we profiled:

Business and Productivity	Corel GALLERY™ 2�Quicken® for Windows CD-ROM Deluxe Edition™

Games and Entertainment	Disney’s Animated StoryBook—The Lion King�Myst™

Reference and Education	Compton’s Interactive Encyclopedia™�Microsoft® Encarta™ ’95

What the suite does when you run it

When you run the CD-ROM WinMark 96 suite, you actually run a single large test called the CD-ROM Mix� XE "CD-ROM Mix" �� XE "Tests:CD-ROM Mix" �� XE "WinBench 96:Tests:CD-ROM Mix" �. The CD-ROM Mix consists of six different sections. Each section executes a set of CD-ROM operations corresponding to the operations performed by one of the six profiled applications. While the suite is running, WinBench 96 displays a status dialog box on the PC’s screen.

The results it produces

The CD-ROM WinMark 96 suite returns a single result called the CD-ROM WinMark. When the suite finishes, there are six numbers—one for each section of the suite. As WinBench 96 completes each section, it computes the average transfer rate for that section. WinBench 96 then uses a weighted harmonic mean to calculate the average transfer rate for the PC’s CD�ROM subsystem in thousands of bytes per second� XE "Thousand Bytes/Sec" �. The weighted transfer rate gives you a number closely tied to the way popular Windows-based CD-ROM programs use the PC’s CD-ROM subsystem.

The CD-ROM WinMark 96 result tells you the number of thousands of bytes per second the PC was able to transfer during the test. With this result, bigger numbers mean better performance.

What other test suites do

In addition to the key suites, WinBench 96 includes several other suites to make testing a PC more convenient. These suites let you test different components of a PC’s subsystems. The other suites that come with WinBench 96 are:

Additional Graphics Tests

All Tests

CD-ROM Tests

Disk Tests

GWM Tests

Processor Tests

Video Data Rate Tests

Video Matrix Tests

Video Scaling Tests

Video Tests

The sections that follow briefly describe each of these suites. (If you just want to understand what a graphics, disk, processor, CD-ROM, or video test does when you run it, see page � PAGEREF _Ref293284749 �158�.)

The Additional Graphics Tests suite� XE "Additional Graphics Tests" �� XE "Suites:Additional Graphics Tests" �� XE "WinBench 96:Suites:Additional Graphics Tests" �

The Additional Graphics Tests suite contains tests of GDI drawing operations the Graphics WinMark 96 does not include. These tests also use GDI operations not included in the profile logs for leading applications.

This suite also includes some of the same operations the Combined GWM Tests perform. Unlike the Combined GWM Tests, however, this suite uses essentially the same parameters for similar tests. So, these tests don’t reflect application profiling. Within the groups of tests that make up the suite, the parameter distributions for similar tests are equivalent. This way, you can compare the relative speeds of different operations. For example, you can compare screen�to�screen BitBlt� XE "BitBlt" � tests with memory-to-screen and screen-to-memory BitBlt tests.

The results it produces

The Additional Graphics Tests suite returns results for each of its graphics tests. (For a list of the tests included in the suite, see the next section, “The tests it runs.”) WinBench 96 reports graphics tests results in million of pixels per second.� XE "Million Pixels/Sec" �

�The tests it runs

The Additional Graphics Tests suite executes tests in several different types of categories. Each category represents a different type of drawing operation. The following list breaks down the tests into each of these categories.

Ellipse drawing tests� XE "Ellipse drawing tests" �� XE "Tests:Ellipse drawing" �. These tests draw GDI objects based on ellipses or parts of ellipses. For example, you can use the Arc tests to compare the difference in performance in graphics cards or drivers that have hardware or accelerated curve drawing operations and cards or drivers that don’t. The tests WinBench 96 includes in this category are:

S/Arc, Circular, Complete�S/Arc, Circular, Partial�S/Arc, Elliptical, Complete�S/Arc, Elliptical, Partial�S/Chord, Circular�S/Chord, Elliptical�S/Circle�S/Ellipse�S/Pie, Circular�S/Pie, Elliptical

The PatBlt tests.� XE "PatBlt tests" � � XE "Tests:PatBlt" �These tests draw patterns on the screen using several different parameters. PatBlt is a simple version of a BitBlt; however, PatBlt just uses a brush to draw the objects. It does not have a source the way BitBlt does. PATCOPY is a relatively important operation that draws the background of Windows.

The WHITENESS test fills the background with white. PatBlt doesn’t use a brush in this test. Since the distribution of parameters in these tests is the same, you can compare the PatBlt tests results with each other.

The tests included in this category are:

S/PatBlt, All ROPs�S/PatBlt, DESTINVERT�S/PatBlt, PATCOPY�S/PatBlt, WHITENESS

Polygon drawing. This set of tests consists of geometric shapes you can draw with GDI calls. The Polygon tests� XE "Polygon tests" �� XE "Tests:Polygon" � exercise polygon filling operations business graphics and drawing software often use. The tests in this category are:

S/Polygon, Few-sides�S/Polygon, Many-sides�S/Polygon, Trapezoid�S/Polygon, Triangle

Text drawing operations� XE "Text drawing operations" �.� XE "Tests:Text drawing operations" � These tests use the Times New Roman font to draw text at horizontal (0 degrees), vertical (90-degrees), and diagonal (45-degrees) angles. (The number “16” indicates the font height in pixels). You can use these tests to see how much longer it takes the PC to draw text at an angle. The tests in this category are:

S/DrawText, Times Roman 16�S/GrayString, Times Roman 16�S/TabbedTextOut, Times Roman 16�S/Text, Times Roman 16�S/Text, Times Roman 16, 45�S/Text, Times Roman 16, 90

BitBlt tests (screen to screen).� XE "BitBlt tests (screen to screen)" � � XE "Tests:BitBlt (screen to screen)" �These tests perform Boolean operations� XE "Boolean operations" � between a source and destination area of the screen. The source copy (SRCCOPY� XE "SRCCOPY" �) operation is important because scrolling uses that operation. WinBench 96 defines two rectangles of the same size on the screen, one as the source and the other as the destination. The tests then move blocks from the source to the destination. Since all BitBlt tests use the same parameter distributions, you can compare the results of these tests to the results of other BitBlt tests. The tests in this category are:

SToS/BitBlt, All ROPs�SToS/BitBlt, SRCCOPY

BitBlt tests (memory to screen)� XE "BitBlt tests (memory to screen)" �� XE "Tests:BitBlt tests (memory to screen)" �. These tests perform BitBlt operations between an off-screen bitmap and the screen. You can compare the results of these tests to the results of other BitBlt tests. The tests in this category are:

CToS/BitBlt, All ROPs�CToS/BitBlt, SRCCOPY�MToS/BitBlt, All ROPs�MToS/BitBlt, SRCCOPY

StretchBlt tests� XE "StretchBlt tests" �� XE "Tests:StretchBlt" �. These tests are like the BitBlt tests except the source and destination areas don’t need to be the same size. WinBench 96 can stretch or shrink the source into the destination. These tests are normally slower than the BitBlt tests. You can compare the results of different StretchBlt Tests with each other. The tests in this category are:

StretchBlt tests (screen to screen):�SToS/StretchBlt, All ROPs�SToS/StretchBlt, SRCCOPY

StretchBlt tests (memory to screen):�CToS/StretchBlt, All ROPs�CToS/StretchBlt, SRCCOPY�MToS/StretchBlt, All ROPs�MToS/StretchBlt, SRCCOPY

Device Independent Bitmap (DIB) tests� XE "Device Independent Bitmap (DIB) tests" �� XE "Tests:Device Independent Bitmap (DIB)" �. These tests measure the speed at which WinBench 96 can draw DIBs on the screen. DIBs are bitmap images like those produced by Paintbrush. You can compute the speed of drawing DIBs with different color depths (1, 4, 8, or 24 bits per pixel) using the various operations GDI supplies. The tests in this category are:

S/BltDIBits, 1 bpp, SRCCOPY�S/BltDIBits, 24 bpp, SRCCOPY�S/BltDIBits, 4 bpp, SRCCOPY�S/BltDIBits, 8 bpp, SRCCOPY�S/SetDIBitsBlt, 1 bpp�S/SetDIBitsBlt, 24 bpp�S/SetDIBitsBlt, 4 bpp�S/SetDIBitsBlt, 8 bpp�S/SetDIBitsToDevice, 1 bpp�S/SetDIBitsToDevice, 24 bpp�S/SetDIBitsToDevice, 4 bpp�S/SetDIBitsToDevice, 8 bpp�S/StretchDIBits, 1 bpp, SRCCOPY�S/StretchDIBits, 24 bpp, SRCCOPY�S/StretchDIBits, 4 bpp, SRCCOPY�S/StretchDIBits, 8 bpp, SRCCOPY

Line drawing tests� XE "Line drawing tests" �� XE "Tests:Line drawing" �. Line drawing operations are some of the most frequently used Windows graphics operations. One way you can use the line drawing tests is to see the difference in performance between graphics cards that have hardware support for line drawing operations and those cards that don’t. The diagonal, horizontal, and vertical tests use lines that are the same length. This approach lets you compare the results from these tests. The tests in this category are:

S/Line, Diagonal�S/Line, Horizontal�S/Line, Vertical

Flood Fill tests� XE "Flood Fill tests" �� XE "Tests:Flood Fill" �. These tests involve filling an area on a screen until the GDI call reaches a border on the screen that is a particular color or reaches an area on the screen that is a different color from the fill color. The ExtFlood Fill, Border test starts at a point on the screen and fills the screen with a color until it reaches a black border. The ExtFloodFill, Surface test starts at a point on the screen and fills the screen with a new color as long as the original color remains the same. The FloodFill test is an older GDI call that is equivalent to the ExtFloodFill, Border test. The tests in this category are:

S/ExtFloodFill, Border�S/ExtFloodFill, Surface�S/FloodFill

Region tests� XE "Region tests" �� XE "Tests:Region" �. These tests invert, fill, and frame regions. A region consists of an area composed of an arbitrary set of rectangles. For these tests, regions are composed of one rectangle. The tests in this category are:

S/FillRgn�S/FrameRgn�S/InvertRgn�S/PaintRgn

Rectangular tests� XE "Rectangular tests" �� XE "Tests:Rectangular" �. These tests invert, fill, and frame rectangles and are comparable to the Region tests.

S/FillRect�S/FrameRect�S/InvertRect

Miscellaneous tests� XE "Miscellaneous tests" �� XE "Tests:Miscellaneous" �.

S/DrawFocusRect�S/DrawIcon�S/FastWindowFrame�S/GetNearestColor�S/MoveTo�S/MoveToEx�S/ScrollDC

The All Tests suite� XE "All Tests" �� XE "Suites:All Tests" �� XE "WinBench 96:Suites:All Tests" �

When you run the All Tests suite, WinBench 96 runs every WinBench 96 test in alphabetical order one after the other.

The results it produces

The All Tests suite returns results for each test. Since it runs all the tests necessary to compute the Graphics, Disk, and CD-ROM WinMark 96 results and the CPUmark16 and CPUmark32 results, it also returns those results when you run all the tests.

The CD-ROM Tests suite� XE "CD-ROM Tests" �� XE "Suites:CD-ROM Tests" �� XE "WinBench 96:Suites:CD-ROM Tests" �

When you run the CD-ROM Tests suite, WinBench 96 runs the CD-ROM Mix and 16 other CD-ROM tests. These 16 CD-ROM tests consist of seven random read tests, seven sequential read tests, the CD-ROM CPU Utilization test, and the CD-ROM Access Time test. The random and sequential read tests as well as the utilization test read from a single large file on the CD-ROM. The CD�ROM test name indicates the block size the test reads. (For example, the test CD�ROM/Random, 512 bytes reads blocks of data 512 bytes in size.) The Mix test uses the directories 0, 1, 2, 3, 4, and 5 on the CD-ROM, and the Access Time test uses the entire CD-ROM image by calling MSCDEX directly.

For each CD-ROM test, WinBench 96 reads data from the CD-ROM and records the time it takes the PC’s CD�ROM subsystem to perform the reads.

The results it produces

The CD-ROM Tests suite returns results for each of WinBench 96’s CD-ROM tests (the CD�ROM Mix and the 16 CD-ROM tests). (For a list of the tests included in the suite, see the next section, “The tests it runs.”) Since WinBench 96 runs the CD-ROM Mix as part of this suite, the suite also returns a CD-ROM WinMark 96 result. The following chart explains the units each type of CD-ROM test produces:

This test:�Produces this result:�And tells you:��CD-ROM/Access Time (MSCDEX)�Milliseconds� XE "Milliseconds" �� XE "Results:Milliseconds" �� XE "WinBench 96:Results:Milliseconds" ��The average access time in milliseconds.��CD-ROM/CPU Utilization�Percent Used� XE "Percent Used" �� XE "Results:Percent Used" �� XE "WinBench 96:Results:Percent Used" ��The percentage of the total processor time the PC spends retrieving data from the CD-ROM subsystem.��CD-ROM/Mix�Thousand Bytes/Sec� XE "Thousand Bytes/Sec" �� XE "Results:Thousand Bytes/Sec" �� XE "WinBench 96:Results:Thousand Bytes/Sec" ��The number of thousands of bytes per second the PC was able to transfer during the test.��CD-ROM/Random or �CD/ROM Sequential�Thousand Bytes/Sec�The number of thousands of bytes per second the PC was able to transfer during the test.��The tests it runs

The CD-ROM Tests suite executes four different types of tests:  random read, sequential read, access time, and CPU utilization. The following list breaks down the tests into each of these categories.

CD-ROM/Access Time test� XE "CD-ROM/Access Time test" �� XE "Tests:CD-ROM/Access Time" �. The CD-ROM Access Time test performs random accesses on the entire CD-ROM and then reports the average access time in milliseconds. Each access is a 2KB read from a random sector on the CD-ROM. Unlike the Random Read test, the CD-ROM Access Time test uses low-level reads and uses the entire CD-ROM. The average stroke distance is 1/3 of the CD-ROM image.

CD-ROM/CPU Utilization test� XE "CD-ROM/CPU Utilization test" �� XE "Tests:CD-ROM/CPU Utilization" �. The CD-ROM CPU utilization for a given computer system is the measure of the percentage of the total processor time a PC spends retrieving data from the CD-ROM subsystem.  For example, if WinBench 96 calculates a PC’s CD�ROM CPU utilization to be 35%, then the CPU spends 35% of its time reading data from the CD-ROM subsystem, leaving 65% of its time to actually do something with the data it’s reading (such as displaying that data on the monitor in the form of video).

The CPU Utilization test uses a default read block size of 16KB for all CD-ROM drives, regardless of a CD-ROM drive’s speed. The MPC specification suggests that single speed CD-ROM drives should generate no more than 40% CPU utilization for reads of 8KB to 24KB at a data rate of 150KB/S. Thus, the CPU Utilization test uses a default read block size of 16KB.

You may wish to compare the CD-ROM subsystem utilization to the Multimedia PC (MPC) specifications. Many vendors include the MPC specifications on their CD-ROM drives. MPC specifies a utilization of less than 40% for a transfer rate of 150KB per second. MPC II specifies the same, but also suggests that the utilization for a 300KB per second transfer rate should be less than 60%. The new MPC III specification suggests no more than 40% utilization for a 600KB per second transfer rate and 20% for a 300KB per second transfer rate.

CD-ROM/Mix test� XE "CD-ROM/Mix test" �� XE "Tests:CD-ROM/Mix" �. The CD-ROM Mix consists of six different sections. Each section executes a set of CD-ROM operations corresponding to the operations performed by one of the six profiled applications. The CD-ROM Mix result tells you the number of thousands of bytes per second the PC was able to transfer during the test.

CD-ROM/Random Read tests� XE "CD-ROM/Random Read tests" �� XE "Tests:CD-ROM/Random Read" �. The CD-ROM Random Read tests perform random reads from a large file on the CD-ROM. There are seven different random read tests, each using a different block size ranging from 200 bytes to 32KB. WinBench 96 reports the transfer rate in thousands of bytes per second. The random read transfer rate will be substantially smaller than the sequential read rate because the sequential read operations don't have the overhead of having to seek large distances on the CD-ROM. The tests WinBench 96 includes in this category are:

CD-ROM/Random, 16384 bytes�CD-ROM/Random, 200 bytes�CD-ROM/Random, 2048 bytes�CD-ROM/Random, 32768 bytes�CD-ROM/Random, 4096 bytes�CD-ROM/Random, 512 bytes�CD-ROM/Random, 8192 bytes

CD-ROM/Sequential Read tests� XE "CD-ROM/Sequential Read tests" �� XE "Tests:CD-ROM/Sequential Read" �. The CD-ROM Sequential Read tests perform sequential reads from the CD-ROM. There are seven different sequential read tests, each using a different block size. The block sizes range from 200 bytes to 32KB. WinBench 96 reports the transfer rate for each test in thousands of bytes per second.

When you run WinBench 96's CD-ROM Sequential Read tests, the larger block size tests should produce the highest transfer rates. The following rules of thumb will often prove useful.

If you are testing a 2X CD-ROM, the highest transfer rate should be around 307 thousand bytes per second.

If you are using a 3X CD-ROM, the highest transfer rate should be around 460 thousand bytes per second. For each “X” in the CD-ROM name, the transfer rate should increase by 153 thousand bytes per second. So, the transfer rate for a 4X CD�ROM should be 150KB/S faster than the rate for a 3X CD-ROM (i.e., 600KB/S).

The tests WinBench 96 includes in this category are:

CD-ROM/Sequential, 16384 bytes�CD-ROM/Sequential, 200 bytes�CD-ROM/Sequential, 2048 bytes�CD-ROM/Sequential, 32768 bytes�CD-ROM/Sequential, 4096 bytes�CD-ROM/Sequential, 512 bytes�CD-ROM/Sequential, 8192 bytes

The Disk Tests suite� XE "Disk Tests" �� XE "Suites:Disk Tests" �� XE "WinBench 96:Suites:Disk Tests" �

When you run the Disk Tests suite, WinBench 96 runs the Disk Mix and 16 other disk tests. Each of these 16 disk tests creates a 16MB file. WinBench 96 then accesses those files using fixed�length records in either a sequential or random fashion.

The Disk Tests suite includes both read and write tests. If you run the suite without a disk�compression product on the PC and without hardware or software disk caches, the Disk/Read, Random, 512-byte test could give you an indication of the mechanical positioning speed, and the Disk/Read, Sequential, 4096-byte test could give you an indication of the maximum sustained data throughput capabilities of the PC’s disk subsystem.

The results it produces

The Disk Tests suite returns results for each of WinBench 96’s disk tests (the Disk Mix and the 16 disk tests). (For a list of the tests included in the suite, see the next section, “The tests it runs.”) Since WinBench 96 runs the Disk Mix as part of this suite, the suite also returns a Disk WinMark 96 result. WinBench 96 reports disk tests results in units of thousands of bytes � XE "Thousand Bytes/Sec" �per second.

The tests it runs

The Disk Tests suite executes the following tests:

Disk WinMark 96�Disk/Read, Sequential, 200 bytes�Disk/Read, Sequential, 2048 bytes�Disk/Read, Sequential, 4096 bytes�Disk/Read, Sequential, 512 bytes�Disk/Read, Random, 200 bytes�Disk/Read, Random, 2048 bytes�Disk/Read, Random, 4096 bytes�Disk/Read, Random, 512 bytes�Disk/Write, Sequential, 200 bytes�Disk/Write, Sequential, 2048 bytes�Disk/Write, Sequential, 4096 bytes�Disk/Write, Sequential, 512 bytes�Disk/Write, Random, 200 bytes�Disk/Write, Random, 2048 bytes�Disk/Write, Random, 4096 bytes�Disk/Write, Random, 512 bytes

The GWM Tests suite� XE "GWM Tests" �� XE "Suites:GWM Tests" �� XE "WinBench 96:Suites:GWM Tests" �

The GWM Tests is a suite that contains 115 tests, each of which performs a single GDI operation.

These tests are the same tests WinBench 96 combines based on profiling data to create the Combined GWM tests that make up the Graphics WinMark 96. The difference between the GWM Tests suite and the Combined GWM Tests is that the GWM Tests perform the operations one after the other while each Combined GWM Test intermingles the operations it contains.

So, you can’t use the GWM Tests to compute the Graphics WinMark 96, but you can use the GWM Tests to help determine why different PCs have different Graphics WinMark 96 results. For example, if you run the GWM Tests suite on several PCs, you can see which operations execute faster on each of those PCs.

The GWM Tests suite includes each of the graphics operations the profiled applications used, and the parameter distributions for the individual GWM tests reflect information from the application profiles.

The results it produces

The GWM Tests suite returns results for each of its graphics tests. (For a list of the tests included in this suite, see the next section, “The tests it runs.”) WinBench 96 reports graphics tests results in units of millions of pixels per second.� XE "Million Pixels/Sec" �

When the suite finishes, WinBench 96 automatically displays its results in the Chart of Results.

The tests it runs

The following is an alphabetical list of all the tests in the GWM Tests suite.

GWM/C/BltDIBits, 8 bpp, SRCCOPY�GWM/C/Ellipse�GWM/C/ExtTextOut, Rectangle�GWM/C/ExtTextOut, Rectangle, Clip�GWM/C/InvertRgn�GWM/C/Line, Diagonal�GWM/C/Line, Diagonal, Clip�GWM/C/Line, Horizontal�GWM/C/Line, Vertical�GWM/C/Line, Vertical, Clip�GWM/C/PatBlt, DESTINVERT, Clip�GWM/C/PatBlt, MonoOthers�GWM/C/PatBlt, MonoPATCOPY�GWM/C/PatBlt, MonoPATCOPY, Clip�GWM/C/PatBlt, Others�GWM/C/PatBlt, PATCOPY�GWM/C/PatBlt, PATCOPY, Clip�GWM/C/PolyLine�GWM/C/Polygon, Few-sides�GWM/C/Polygon, Few-sides, Clip�GWM/C/Polygon, Many-sides�GWM/C/Rectangle�GWM/C/Rectangle, Clip�GWM/C/SetDIBitsBlt, 4 bpp�GWM/C/SetDIBitsBlt, 8 bpp�GWM/C/SetPixel�GWM/C/StretchDIBits, 4 bpp, SRCCOPY�GWM/C/Text, Arial 16�GWM/C/Text, Arial Bold 24�GWM/C/Text, Times Roman 15, Clip�GWM/C/Text, Times Roman 16�GWM/C/Text, Times Roman 40�GWM/CToC/BitBlt, Others�GWM/CToC/BitBlt, Others, Clip�GWM/CToM/BitBlt, Others�GWM/CToM/BitBlt, SRCCOPY, Clip�GWM/CToS/BitBlt, Others�GWM/CToS/BitBlt, Others, Clip�GWM/CToS/BitBlt, SRCCOPY�GWM/CToS/BitBlt, SRCCOPY, Clip�GWM/CToS/StretchBlt, SRCCOPY�GWM/CToS/StretchBlt, SRCCOPY, Clip�GWM/M/ExtTextOut, Rectangle�GWM/M/PatBlt, Others�GWM/M/PatBlt, ROP(FA)�GWM/M/PatBlt, WHITENESS�GWM/M/PatBlt, WHITENESS, Clip�GWM/M/Rectangle�GWM/M/Rectangle, Clip�GWM/M/SetDIBitsBlt, 1 bpp�GWM/M/Text, System 16�GWM/M/Text, Times Roman 15�GWM/M/Text, Times Roman 16, Clip�GWM/M/Text, Times Roman Bold 17�GWM/M/Text, Times Roman Bold 19�GWM/MToC/BitBlt, Others�GWM/MToC/BitBlt, SRCAND, Clip�GWM/MToM/BitBlt, Others�GWM/MToS/BitBlt, Others�GWM/MToS/BitBlt, Others, Clip�GWM/MToS/BitBlt, SRCCOPY, Clip�GWM/S/Arc, Elliptical, Complete�GWM/S/Circle�GWM/S/Ellipse�GWM/S/Ellipse, Clip�GWM/S/ExtTextOut, Rectangle�GWM/S/ExtTextOut, Rectangle, Clip�GWM/S/FillRgn�GWM/S/GetPixel�GWM/S/InvertRgn�GWM/S/Line, Diagonal�GWM/S/Line, Horizontal�GWM/S/Line, Horizontal, Clip�GWM/S/Line, Vertical�GWM/S/Line, Vertical, Clip�GWM/S/PaintRgn�GWM/S/PatBlt, DSTINVERT�GWM/S/PatBlt, DSTINVERT, Clip�GWM/S/PatBlt, MonoOthers�GWM/S/PatBlt, MonoOthers, Clip�GWM/S/PatBlt, MonoPATCOPY�GWM/S/PatBlt, MonoPATCOPY, Clip�GWM/S/PatBlt, Others�GWM/S/PatBlt, Others, Clip�GWM/S/PatBlt, PATCOPY�GWM/S/PatBlt, PATCOPY, Clip�GWM/S/PatBlt, WHITENESS�GWM/S/PatBlt, WHITENESS, Clip�GWM/S/Pie, Elliptical�GWM/S/PolyLine�GWM/S/PolyPolygon�GWM/S/Polygon, Few-sides�GWM/S/Polygon, Few-sides, Clip�GWM/S/Polygon, Many-sides�GWM/S/Polygon, Many-sides, Clip�GWM/S/Rectangle�GWM/S/Rectangle, Clip�GWM/S/Rectangle, Rounded�GWM/S/SetDIBitsToDevice, 4 bpp�GWM/S/SetPixel�GWM/S/StretchDIBits, 4 bpp, SRCCOPY�GWM/S/StretchDIBits, 4 bpp, SRCCOPY, Clip�GWM/S/StretchDIBits, 8 bpp, SRCCOPY�GWM/S/Text, Arial 16�GWM/S/Text, Sans Serif 13�GWM/S/Text, Sans Serif 16�GWM/S/Text, Sans Serif Bold 13, Clip�GWM/S/Text, System 16�GWM/S/Text, Times Roman 15�GWM/S/Text, Times Roman 19�GWM/S/Text, Times Roman 29�GWM/SToC/BitBlt, SRCCOPY�GWM/SToM/BitBlt, SRCCOPY�GWM/SToS/BitBlt, SRCCOPY�GWM/SToS/BitBlt, SRCCOPY, Clip

The Processor Tests suite� XE "Processor Tests" �� XE "Suites:Processor Tests" �� XE "WinBench 96:Suites:Processor Tests" �

The Processor Tests suite runs both the 32- and 16-bit processors tests. When you run this suite, you get the same results as if you ran the CPUmark32� XE "CPUmark32" � and CPUmark16� XE "CPUmark16" � tests separately.

The results it produces

Both processor tests produce relative results:  Their results are normalized, unitless numbers meaningful only when you compare them to other WinBench 96 processor CPUmark results. With these results, bigger numbers mean better performance.

The tests it runs

Processor/16-bit� XE "Processor/16-bit" �� XE "Tests:Processor/16-bit" �� XE "Processor Tests:Processor/16-bit" ��Processor/32-Bit� XE "Processor/32-Bit" �� XE "Tests:Processor/32-Bit" �� XE "Processor tests:Processor/32-Bit" �

The Video Data Rate Tests suite� XE "Video Data Rate Tests" �� XE "Suites:Video Data Rate Tests" �� XE "WinBench 96:Suites:Video Data Rate Tests" �

The tests included in the Video Data Rate Tests suite let you measure at which point the PC is no longer able to display the video clip without dropping frames. The tests included in this suite use three different cases of maximum data rates, keeping every other attribute the same. As the data rate increases, look for the point at which the number of dropped frames increases to find the upper limit for the PC.

The results it produces

For each video test, WinBench 96 produces five results. In most other tests, the larger the WinBench 96 test result, the better the performance. With WinBench 96’s video tests, however, bigger numbers do not always mean better performance. For detailed information on what each type of video test result means, see the chart on page � PAGEREF _Ref330276046 �111�.

The tests it runs

Video/Action, Indeo, 320x240, 15fps, 250KB/S�Video/Action, Indeo, 320x240, 15fps, 300KB/S�Video/Action, Indeo, 320x240, 15fps, 450KB/S�Video/Action, Indeo, 320x240, 15fps, 600KB/S�Video/Action, Indeo, 320x240, 25fps, 250KB/S�Video/Action, Indeo, 320x240, 25fps, 300KB/S�Video/Action, Indeo, 320x240, 25fps, 450KB/S�Video/Action, Indeo, 320x240, 25fps, 600KB/S�Video/Action, Indeo, 320x240, 25fps, 750KB/S�Video/Action, Indeo, 320x240, 30fps, 250KB/S�Video/Action, Indeo, 320x240, 30fps, 300KB/S�Video/Action, Indeo, 320x240, 30fps, 450KB/S�Video/Action, Indeo, 320x240, 30fps, 600KB/S�Video/Action, Indeo, 320x240, 30fps, 750KB/S

The Video Matrix Tests suite� XE "Video Matrix Tests" �� XE "Suites:Video Matrix Tests" �� XE "WinBench 96:SuitesVideo Matrix Tests" �

The tests included in the Video Matrix Tests suite vary the type of CODEC and frames per second (fps) rate, using all possible combinations. (The resolution and data rate remain the same.) You can use this suite to see what types of video clip attributes affect the PC’s performance.

The results it produces

For each video test, WinBench 96 produces five results. In most other tests, the larger the WinBench 96 test result, the better the performance. With WinBench 96’s video tests, however, bigger numbers do not always mean better performance. For detailed information on what each type of video test result means, see the chart on page � PAGEREF _Ref330276046 �111�.

The tests it runs

Video/Action, Cinepak, 320x240, 15fps, 300KB/S�Video/Action, Cinepak, 320x240, 25fps, 300KB/S�Video/Action, Cinepak, 320x240, 30fps, 300KB/S�Video/Action, Indeo, 320x240, 15fps, 300KB/S�Video/Action, Indeo, 320x240, 25fps, 300KB/S�Video/Action, Indeo, 320x240, 30fps, 300KB/S�Video/Head, Cinepak, 320x240, 15fps, 300KB/S�Video/Head, Cinepak, 320x240, 25fps, 300KB/S�Video/Head, Cinepak, 320x240, 30fps, 300KB/S�Video/Head, Indeo, 320x240, 15fps, 300KB/S�Video/Head, Indeo, 320x240, 25fps, 300KB/S�Video/Head, Indeo, 320x240, 30fps, 300KB/S

The Video Scaling Tests suite� XE "Video Scaling Tests" �� XE "Suites:Video Scaling Tests" �� XE "WinBench 96:Suites:Video Scaling Tests" �

The Video Scaling Tests suite uses video tests with a particular CODEC, data rate, and resolution and varies the video clip’s scaling. This suite uses five different cases of scaling. You can use this suite to measure how video clip scaling can affect the PC’s performance.

The results it produces

For each video test, WinBench 96 produces five results. In most other tests, the larger the WinBench 96 test result, the better the performance. With WinBench 96’s video tests, however, bigger numbers do not always mean better performance. For detailed information on what each type of video test result means, see the chart on page � PAGEREF _Ref330276046 �111�.

�The tests it runs

Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x�Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x�Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x�Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x�Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full�Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x�Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x�Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x�Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x�Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full�Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x�Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x�Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x�Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x�Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full�Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x�Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x�Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x�Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x�Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full

The Video Tests suite� XE "Video Tests" �� XE "Suites:Video Tests" �� XE "WinBench 96:Suites:Video Tests" �

The Video Tests suite runs every video test, one after the other, in alphabetical order (excluding any user supplied clips).

The results it produces

� XE "WinBench 96:Results:Video tests" �For each video test, WinBench 96 produces five results. In most other tests, the larger the WinBench 96 test result, the better the performance. With WinBench 96’s video tests, however, bigger numbers do not always mean better performance. For detailed information on what each type of video test result means, see the chart on page � PAGEREF _Ref330276046 �111�.

�The tests it runs

When you choose the Video Tests suite, WinBench 96 runs tests from the following suites:

Video Data Rate Tests (see page � PAGEREF _Ref336074244 �156� for a list of these tests).

Video Matrix Tests (see page � PAGEREF _Ref336074262 �157� for a list of these tests).

Video Scaling Tests (see page � PAGEREF _Ref336074266 �158� for a list of these tests).

The Video Tests suite also runs the following individual video tests:

Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S�Video/Action, Cinepak, 640x480, 15fps, 900KB/S�Video/Action, Cinepak, 640x480, 30fps, 900KB/S�Video/Action, Indeo, 640x480, 15fps, 900KB/S�Video/Action, Indeo, 640x480, 30fps, 900KB/S�Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S�Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S�Video/Head, Indeo, 160x120, 30fps, 150KB/S�Video/Head, Indeo, 320x240, 15fps, 150KB/S�Video/Head, Indeo, 320x240, 25fps, 150KB/S�Video/Head, Indeo, 320x240, 30fps, 150KB/S

What the different types of tests do

� XE "WinBench 96:Tests:Different types" \r "TypesTests" �WinBench contains graphics, disk, processor, video, and CD-ROM tests. The sections below give you a general idea of what these types of tests do when you run them. It doesn’t matter whether you run a test as part of a suite or by itself; the test does the same thing.

The graphics tests

WinBench 96’s graphics tests execute Graphics Device Interface (GDI)� XE "Graphics Device Interface (GDI)" � drawing operations. Windows applications use GDI operations to display and draw objects on the screen. These operations involve many different types of painting activities, such as displaying text, moving pixels from memory to screen and screen to memory, and drawing geometric objects (for example, lines, circles, arcs, and so on).

WinBench 96 includes three suites of graphics tests: Graphics WinMark 96, Additional Graphics Tests, and GWM Tests.

NOTE:	For information on what these graphics suites do, see the following sections:

“� REF _Ref336059841 \* MERGEFORMAT �The Graphics WinMark 96�” on page � PAGEREF _Ref336059841 �133�.

“� REF _Ref293368651 \* MERGEFORMAT �The Additional Graphics Tests suite�” on page � PAGEREF _Ref293368651 �143�.

“� REF _Ref293368676 \* MERGEFORMAT �The GWM Tests suite�” on page � PAGEREF _Ref293368676 �152�.

� XE "Profiling" �In developing WinBench 96’s graphics tests, we profiled today’s top-selling Windows applications to see how they use a PC’s graphics subsystem. From information we gathered from the profiling logs, we divided WinBench 96’s suites into two basic categories:

Suites that simulate the GDI operations from the application profile logs:  the Graphics WinMark 96 and GWM Tests suites. These suites vary parameters the same way the profiled applications vary those parameters. So, the results for these suites help you determine how the PC performs when executing GDI operations similar to GDI operations the profiled applications perform.

When you run the Graphics WinMark 96 and GWM Tests suites, you can’t compare results for tests included in these suites, because the parameters for each test differ. So, even if two tests appear to be doing the same thing, they’re not. For example, the tests GWM/Line, Diagonal and the GWM/Line, Vertical have similar names, and at a glance, it appears they do about the same thing. Because of different parameter distributions, however, the tests are very different. You can use the results for the Graphics WinMark 96 and GWM Tests suites to compare the PC’s overall graphics subsystem performance with the performance of other PCs, but you can’t compare the test results within these suites.

A suite that executes GDI operations not included in the application profile logs:  Additional Graphics Tests. This suite is useful for comparing similar operations and evaluating the speed of the operations the profiled applications didn’t use.

The Additional Graphics Tests suite contains a combination of operations, and all the operations use essentially the same distribution of parameters. This suite doesn’t reflect how the applications used these operations, but it does provide a reasonable basis for comparing the results of different individual operations. For example, you could run the suite and then compare the Line, Diagonal and Line, Vertical tests.

Understanding the graphics tests names

In general, the graphics test names consist of the GDI operation name followed by qualifiers that distinguish special cases of the GDI operations or specify something about the parameter distributions.

� XE "Tests:Graphics:Names" �The following guide is useful for decoding the prefixes of the graphics test names:

GWM	an individual profiled test in the Graphics WinMark 96�S	the test draws to the display screen�C	the test draws to a color memory bitmap�M	the test draws to a monochrome memory bitmap�StoS	a screen to screen Blit test�StoC	a screen to color bitmap Blit test�StoM	a screen to monochrome bitmap Blit test�CtoS	a color bitmap to screen Blit test�CtoC	a color bitmap to color bitmap Blit test�CtoM	a color bitmap to monochrome bitmap Blit test�MtoS	a monochrome bitmap to screen Blit test�MtoC	a monochrome bitmap to color bitmap Blit test�MtoM	a monochrome bitmap to monochrome bitmap Blit test

As you look at the different test names, keep in mind that:

The term “rounded” in a test using a square or a rectangle means the corners have been rounded.

The term “other” indicates the test uses several common operations.

In the text tests, WinBench 96 displays the name of the test, the font name, and height of the font in pixels. If there is another number, it is the angle of the text. For example, the test S/Text, Times Roman 16, 90 displays text at a 90 degree angle in Times Roman font that is 16 pixels high. 

The term “System” is the name of a font. For example, the test GWM/S/Text, System 16 is an individual GWM Tests suite that displays text in System font.

All the test names that begin GWM/ are part of the GWM Tests suite. For example, GWM/S/Line, Diagonal is an individual GWM Test that draws diagonal lines.

In the GWM/ExtTextOut, Rectangle test, WinBench 96 doesn’t write any text. It uses this call to draw a rectangle with solid colors (for example, no dithering). The application profile logs indicate many applications use this method for drawing rectangles.

Tests involving squares are actually rectangle operation tests WinBench 96 forced to use squares.

The Text tests use the ExtTextOut GDI operation.

The disk tests

WinBench 96’s disk tests create files in many different directories and then performs typical disk operations on those files. For example, the disk tests perform read, write, append, file lookup, creation, and deletion operations on these files.

There are two suites that include disk tests:  the Disk WinMark 96 and Disk Tests suites. These suites execute a common test called the Disk Mix. The Disk WinMark 96 suite runs only the Disk Mix; while the Disk Tests suite runs the Disk Mix and 16 other disk tests.

NOTE:	For information on what the disk suites do, see the following sections:

“� REF _Ref336060130 \* MERGEFORMAT �The Disk WinMark 96�” on page � PAGEREF _Ref336060130 �139�.

“� REF _Ref336060138 \* MERGEFORMAT �The Disk Tests suite�” on page � PAGEREF _Ref336060138 �151�.

What is the Disk Mix and what does it do?� XE "Disk Mix" �� XE "Disk WinMark 96:Disk Mix" �� XE "WinBench 96:Disk Mix" �� XE "Tests:Disk Mix" �

The Disk Mix mirrors the way applications use a PC’s disk subsystem, because it executes a series of disk operations similar to typical disk operations leading applications perform.

� XE "Profiling" �To determine which disk operations best reflect how applications really work with s PC’s disk subsystem, we profiled 13 top-selling applications to see what kinds of disk operations they actually perform. To create the profile logs for WinBench 96, we used the same top�selling applications Winstone 96� XE "Winstone 96" � uses.

The Disk Mix plays back all the disk operations from these profile logs in 13 timed sections. The test files the Disk Mix uses take data from actual files that vary in compressibility. The Disk Mix reads, writes, and appends data to these files and generally uses a PC’s disk subsystem the way applications do. The data the Disk Mix uses is about as compressible as the data the profiled applications used, so you can get meaningful results from this test even when the PC uses disk compression products.

As the Disk Mix completes each timed section of the test, it computes the bytes per second rate for that section. So, when the test completes, there are 13 separate numbers. WinBench 96 then uses a harmonic mean, with the same weights and base machine times Winstone 96 uses for these applications, to average these numbers. If you’d like more information on how WinBench 96 computes the Disk WinMark 96, see page � PAGEREF _Ref336242527 �169�.

WinBench 96 displays this final result for the Disk Mix as the PC’s Disk WinMark 96 result.

Understanding the disk tests names

� XE "Tests:Disk:Names" �In the disk tests names, the number of bytes indicates the size of the block of data the test uses. For example, Disk, Write, Sequential, 512 bytes writes 512 bytes of data sequentially.

The processor tests

WinBench 96’s processor tests measure a PC’s processor subsystem performance by running instruction mixes that reflect the way applications use a PC’s processor subsystem. Components of the processor subsystem include the PC’s CPU, RAM� XE "RAM" �, cache� XE "Cache" �, and cache controller.

� XE "WinBench 96:Tests:Processor" �There are WinBench 96 two processor tests:  Processor/16-Bit� XE "Processor/16-Bit" �� XE "Tests:Processor/16-bit" � and Processor/32-Bit� XE "Processor/32-Bit" �� XE "Tests:Processor/32-Bit" �. The workload for each processor test is not all one type of work, but rather, a carefully weighted combination of many different modules. Each module does one or more types of real work, such as compressing data, adjusting dates, analyzing words, and formatting text. The combined overall workload simulates the processor behavior of leading Windows applications.

The Processor/32-Bit test reflects the profiling of 32-bit applications, and the Processor/16�Bit test reflects the profiling of 16-bit applications.

The video tests

� XE "WinBench 96:Tests:Video" �� XE "Tests:Video" �� XE "Video tests" �WinBench 96’s video tests provide concrete measures of a PC’s ability to play full-motion video. Video playback functions stress multiple areas of the PC, including the PC’s processor and graphics subsystems, as well as the CD-ROM or disk subsystems, depending on the location of the video clips you’re playing. (The CD�ROM that includes WinBench 96 also includes WinBench 96’s video clips. When you run a video test, that CD�ROM must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

There are four suites that include video tests:  the Video Data Rate Tests, Video Matrix Tests, Video Scaling Tests, and Video Tests suites.

NOTE:	For information on what these suites do, see the following sections:

“� REF _Ref336074499 \* MERGEFORMAT �The Video Data Rate Tests suite�” on page � PAGEREF _Ref336074499 �156�.

“� REF _Ref336074504 \* MERGEFORMAT �The Video Matrix Tests suite�” on page � PAGEREF _Ref336074504 �156�.

“� REF _Ref336074509 \* MERGEFORMAT �The Video Scaling Tests suite�” on page � PAGEREF _Ref336074509 �157�.

“� REF _Ref336074513 \* MERGEFORMAT �The Video Tests suite�” on page � PAGEREF _Ref336074513 �158�.

For each video test, WinBench 96 plays a video clip three times. (If you’d like information on what a video clip does frame�by�frame, see page � PAGEREF _Ref336157074 �209�.) For each video clip, WinBench 96 measures the:

Number of frames dropped, number of audio breaks, and percent nominal speed.

Maximum number of frames per second (fps) the PC can display. In this section of the test, WinBench 96 runs the video clip without sound as fast as it can.

CPU utilization while the video clip is running.

NOTE:	The first time you run a video test, there is a pause between the second and third sections while WinBench 96 computes the performance of the CPU for use in the CPU utilization measurement.

Understanding the video tests names

� XE "Tests:Video:Names" �Each video test name begins with the word “Video.” A standard video test name uses the following construction:

Video/<clip type>, <CODEC>, <resolution>, <frames per second>, <minimum data rate>

This part of the video test name:�Tells you:��<clip type>�The type of video clip (whether it is a talking head or action video clip).��<CODEC>�The name of the CODEC that decompresses the video clip when WinBench 96 plays it.��<resolution>�The screen resolution of the video clip (how wide and how high the picture is, in pixels).��<frames per second>�The number of frames per second (fps) at which the video clip plays.��<minimum data rate>�The data rate (in kilobytes per second or KB/S) for the CD�ROM drive required to support playing the video clip without dropping frames (assuming the rest of the system doesn’t introduce a bottleneck).

The data rate:	Indicates a:

150KB/S	single-speed CD-ROM drive�300KB/S 	double-speed CD-ROM drive�450KB/S 	triple-speed CD-ROM drive�600KB/S 	quad-speed CD-ROM drive�900KB/S	six-speed CD-ROM drive��For example, the test name:

Video/Head, Cinepak, 320x240, 15 fps, 300KB/S

tells you:  the clip is a video test of a talking head, decompressed with the Cinepak CODEC, with a resolution of 320x240 pixels, at 15 frames per second, and playable on a double-speed CD-ROM drive without dropped frames.

A video test name may also provide other information about the test.

If the name �contains this field:��It means WinBench 96:��nx�Scales the video clip (makes it larger) by a factor of n in both dimensions (n2 in area).��Full�Displays the video clip to fill the WinBench 96 main window.��Clipped�Displays a clipping window on top of the video clip while it plays.��Unaligned�Does not align the video clip window on an 8-pixel boundary.��The CD-ROM tests

� XE "CD-ROM tests" �� XE "Tests:CD-ROM" �� XE "WinBench 96:Tests:CD-ROM" �There are four types of CD-ROM tests:  random read, sequential read, access time, and CPU utilization.

The random and sequential read tests as well as the utilization test read from a single large file on the CD-ROM. The Mix test uses the directories 0, 1, 2, 3, 4, and 5 on the CD-ROM, and the Access Time test uses the entire CD-ROM image by calling MSCDEX� XE "MSCDEX" � directly. The CD�ROM test name indicates the block size the test reads. For example, the test CD�ROM/Random, 512 bytes reads blocks of data 512 bytes in size.

For each CD-ROM test, WinBench 96 reads data from the CD-ROM and records the time it takes the PC’s CD�ROM subsystem to perform the reads.

There are two suites that include CD-ROM tests:  the CD-ROM WinMark 96 and the CD�ROM Tests suites.

NOTE:	For information on what these suites do, see the following sections:

“� REF _Ref336143703 \* MERGEFORMAT �The CD-ROM WinMark 96�” on page � PAGEREF _Ref336061768 �140�.

“� REF _Ref336061774 \* MERGEFORMAT �The CD-ROM Tests suite�” on page � PAGEREF _Ref336061774 �148�.

What is the CD-ROM Mix and what does it do?� XE "CD-ROM Mix" �� XE "CD�ROM WinMark 96:CD-ROM Mix" �� XE "WinBench 96:CD-ROM Mix" �� XE "Tests:CD-ROM Mix" �

The CD-ROM Mix mirrors the way applications use a PC’s CD-ROM subsystem, because it executes a series of CD-ROM operations similar to typical CD-ROM operations leading applications perform.

To create the CD-ROM Mix, we profiled six of today’s most popular Windows CD�ROM applications. To make certain our profiling was as accurate as possible, we developed a tool that records application I/O operations, including hard disk operations and CD-ROM operations, without interfering or modifying the original application. Using this tool, we recorded the CD-ROM operations for each of the six applications and then combined these into one CD-ROM mix.

We wanted to represent a wide variety of applications and to use some of the most popular CD-ROM applications available today. So, we began by grouping CD-ROM applications into three general categories:  Business and Productivity, Games and Entertainment, and Reference and Education. Then, based on market research, we chose two of the most popular Windows-based applications from each group.

The CD-ROM Mix consists of six different sections. Each section executes a set of CD-ROM operations corresponding to the operations performed by one of the six profiled applications. As WinBench 96 completes each section, it computes the average transfer rate for that section. So, when the test finishes, there are six numbers—one for each section of the CD�ROM Mix.

WinBench 96 then uses a weighted harmonic mean to calculate the average transfer rate for the PC’s CD�ROM subsystem in thousands of bytes per second. The weighted transfer rate gives you a number closely tied to the way popular Windows-based CD-ROM programs use the PC’s CD-ROM subsystem.

WinBench 96 displays this final result for the CD-ROM Mix as the PC’s CD-ROM WinMark 96 result.

Understanding the CD-ROM tests names

� XE "Tests:CD-ROM:Names" �In the disk tests names, the number of bytes indicates the size of the block of data the test uses. For example, CD-ROM/Sequential, 512 bytes reads 512 bytes of data sequentially.

End of Chapter

�Chapter 20: �How WinBench 96 Computes Its Results

� XE "Results:Calculating" \r "Calculating" �� XE "WinBench 96:Results:Calculating" \r "Calculating" �This chapter explains exactly how WinBench 96 computes results for its Mark test suites:  the Graphics, Disk, and CD-ROM WinMark 96 suites and the CPUmark16 and CPUmark32 suites.

Sections in this chapter

� REF _Ref336075851 \* MERGEFORMAT �Computing the Graphics WinMark 96 result�

� REF _Ref336075853 \* MERGEFORMAT �Computing the Disk WinMark 96 result�

� REF _Ref336075856 \* MERGEFORMAT �Computing the CD-ROM WinMark 96 result�

� REF _Ref336075857 \* MERGEFORMAT �Computing the CPUmark results�

Computing the Graphics WinMark 96 result

� XE "Graphics WinMark 96:Calculating" �� XE "WinBench 96:Graphics WinMark 96:Calculating" �When you run the Graphics WinMark 96 suite, WinBench 96 runs 13 different tests called the Combined GWM� XE "Combined GWM" � tests (Combined GWM 1 through Combined GWM13). Each of these tests mixes the individual GWM tests together, so the combined test maintains the correct relative number of pixels drawn for each operation (so, it maintains the correct weight for each operation).

When the Graphics WinMark 96 suite finishes, WinBench 96 has 13 different intermediate results, one for each of the Combined GWM tests. Each of these intermediate results represents the number of millions of pixels per second the graphics subsystem was able to modify.

How WinBench 96 goes from several numbers to one number

WinBench 96 assigns a weight to the individual graphics operations. We’ve based that weight on the number of pixels each GDI operation draws as shown by our profiling of the Winstone 96 applications.

WinBench 96 bases the weight for each Combined GWM test on the number of pixels drawn by the subset of operations in that test relative to the number of pixels drawn by the subset of operations in the next combined test. For example, consider the following two hypothetical Combined GWM tests:

Combined GWM 1�Test A	(pixel weight determined by profiling applications=Na)�Test B	(pixel weight determined by profiling applications=Nb)�Test C	(pixel weight determined by profiling applications=Nc)

Combined GWM 2�Test D	(pixel weight determined by profiling applications=Nd)�Test E	(pixel weight determined by profiling applications=Ne)�Test F	(pixel weight determined by profiling applications=Nf)�Test G	(pixel weight determined by profiling applicationst=Ng)

Combined GWM 1 is a mix of operations for Tests A, B, and C. For every Na pixels WinBench 96 draws for the Test A operation, it also draws Nb pixels for Test B operation and Nc pixels for the Test C operations.

WinBench 96 executes the mixed operation tests in Combined GWM 1 and determines the test result by dividing the time it took the PC to perform this test by the number of pixels the test painted. WinBench 96 then follows the same process to determine the result for Combined GWM 2.

WinBench 96 determines the weight for the Combined GWM 1 result based on the profiled pixel weight (Na + Nb + Nc) that subset of operations drew as compared to the profiled pixel weight (Nd + Ne + Nf + Ng) of the operations in Combined GWM 2. WinBench 96 does this for each Combined GWM test (GWM1 through GWM13). WinBench 96 then averages the weighted results for these 13 Combined GWM tests using a weighted harmonic mean to get a single number(the Graphics WinMark 96 result.

In general, the order of the Combined GWM tests indicates the importance of the operations. Operations with the highest weights appear in Combined GWM 1, while operations with the lowest weights appear in Combined GWM13.

Using weights to calculate the result

The weights on the most important operations are very large compared to the weights on the least important operations. So, if WinBench 96 put all its graphics operations into one combined test, it would need to execute a very large number of operations with high weights for each operation with low weights. As a result, WinBench 96 would spend inordinate amounts of time executing the operations with high weights so it could get a representative sample of the operations with low weights.

WinBench 96 avoids this problem when it runs the Graphics WinMark 96 suite by using 13 Combined GWM tests, each of which combines individual operations that have similar weights.

We used Winstone 96� XE "Winstone 96" �’s 13 applications to develop the 13 Combined GWM tests. Each test has a weight, and WinBench 96 bases that weight on the total market share for each application and the number of pixels each application drew using that operation.

Computer Intelligence/InfoCorp (CII)� XE "Computer Intelligence/InfoCorp (CII)" �� XE "CII" \t "See Computer Intelligence/InfoCorp (CII)" �� XE "InfoCorp" \t "See Computer Intelligence/InfoCorp (CII)" �, a leading market research company, supplied the research data that determined the actual and projected unit market shares for the categories and the applications within the categories.

Computing the Disk WinMark 96 result

� XE "Disk WinMark 96:Calculating" �� XE "WinBench 96:Disk WinMark 96:Calculating" �When you run the Disk WinMark 96 suite, WinBench 96 runs a single, large test called the Disk Mix. During the test, WinBench 96 plays back and times disk operations (the same disk operations Winstone 96’s 13 applications perform).

When the Disk Mix completes, WinBench 96 has 13 rates representing the speed of the disk operations for each of the 13 applications. WinBench 96 then uses a weighted harmonic mean to combine these 13 rates into one final rate—the Disk WinMark 96 result. (WinBench 96 bases those weights on each application’s execution time on the Winstone 96 base machine and their total market shares. For more information on Winstone 96, see the Understanding and Using Winstone® 96 Version 1.0 manual.)

The effect is to perform the same calculations as Winstone 96 but to yield an absolute rate—the number of kilobytes per second transferred.

Computing the CD-ROM WinMark 96 result

� XE "CD-ROM WinMark 96:Calculating" �� XE "WinBench 96:CD-ROM WinMark 96:Calculating" �When you run the CD-ROM WinMark 96 suite, WinBench 96 runs a single, large test called the CD-ROM Mix. During the test, WinBench 96 plays back and times CD-ROM operations based on our profiling of six of today’s most popular CD-ROM applications.

When the CD-ROM Mix completes, WinBench 96 has six rates representing the speed of the CD-ROM operations for each of the six applications. WinBench 96 then uses a weighted harmonic mean to combine these six rates into one final rate—the CD-ROM WinMark 96 result. (WinBench 96 bases those weights on each application’s total market share.)

Computing the CPUmark results

WinBench 96 includes two processor suites:  CPUmark16� XE "CPUmark16" � and � XE "CPUmark32" �CPUmark32. Each suite runs a single test. The CPUmark16 suite runs the Processor/16-bit test, and the CPUmark32 runs the Processor/32-Bit test.

As WinBench 96 completes a processor test, it computes an unweighted, absolute result for that test. Then, WinBench 96 scales that number to make its meaning more intuitive. Thus, results for the processor tests are unitless, relative numbers—they are meaningful only when you compare them to other WinBench 96 processor results.

End of Chapter

�Part 6: �If You Have a Problem

Chapter 21:	� REF Chapter20Troubleshooting \* MERGEFORMAT �Troubleshooting a Problem��Provides some guidelines for troubleshooting problems you may have with WinBench 96.

Chapter 22:	� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help��Explains how to get technical support.

�Chapter 21: �Troubleshooting a Problem

Normally, WinBench 96 runs without problems. Occasionally, however, you may encounter a problem when you install or run WinBench 96. This chapter gives you some basic information about what to do if you have problems with WinBench 96.

NOTE:	If you have a problem and can’t resolve it after reading this chapter, fill out a Problem Report Form and sent it to WinBench 96 Technical Support as described in the next chapter, “Getting Help,” beginning on page � PAGEREF Chapter21GettingHelp �181�. You can find a Problem Report From at the back of this manual, in the WinBench 96 on-line help, and on CompuServe in the ZD Benchmark forum.

Sections in this chapter

� REF _Ref299791524 \* MERGEFORMAT �Common problems�

� REF _Ref302276072 \* MERGEFORMAT �WinBench 96 error messages�

Common problems

� XE "WinBench 96:Common problems" \r "CommonProblems" �� XE "Troubleshooting:Common problems" \r "CommonProblems" �� XE "Common problems" \r "CommonProblems" �Normally, if WinBench 96 encounters a problem while running a test, it marks that test as “Failed” and continues with the next test. When WinBench 96 displays results for the test in the Chart and Table of Results, you’ll notice it labels tests that didn’t complete with “Failed.”

NOTE:	If you have a problem and can’t resolve it after reading this chapter fill out a Problem Report Form and send it to WinBench 96 Technical Support as described in the next chapter, “� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help�,” beginning on page � PAGEREF Chapter21GettingHelp �181�.

You should be aware of the following potential problems when running WinBench 96’s tests.

If WinBench 96 crashes, it may not clean up the test files

If the PC crashes during a disk test, WinBench 96 may not clean up the test files. You should restart Windows first, and then restart WinBench 96. When you restart WinBench 96. it indicates what system files it couldn’t restore and asks if you want to perform the cleanup. You should answer Yes.

What to do if files are “inaccessible”

If you receive error messages indicating that files are inaccessible or don’t exist while installing WinBench 96’s files, you may not have enough free disk space to install the files. This error can also occur when you’re running on a compressed drive because the disk compression product may be over estimating the compression ratio.

If you are running a disk test and receive an error message saying files are inaccessible� XE "Inaccessible files" � or don’t exist, you may not have enough space for that disk test. This may also occur if you’re running on a compressed drive because the disk compression product could be over estimating the compression ratio.

The CD-ROM/Access Time (MSCDEX) test and Windows NT

This test will not run on Windows NT, because Windows NT� XE "Windows NT" � doesn’t support the complete MSCDEX interface.

Problems with the CD-ROM/CPU Utilization test

It this test completes successfully, WinBench 96 attaches a note to the test in the Chart and Table of Results that indicates the actual transfer rate for the CD-ROM drive. You should verify that the transfer rate WinBench 96 lists is either close to the maximum transfer rate for the CD-ROM drive or the rate you requested by changing the test settings before the test run.

�The CD-ROM/CPU Utilization test may sometimes produce the following error message:

The CD-ROM/CPU Utilization test could not compute the CPU usage.

Clean the CD-ROM with water and a non-abrasive cloth and try the test again.

If the problem persists, contact the Ziff-Davis Benchmark Operation.

If you receive this error message, clean the CD-ROM with water and a non-abrasive cloth and try running the test again. You can also try using another CD-ROM for the test. If the problem persists, it may be due to the drive mechanism. In this case, capture the file \ZDBENCH\CDUTIL.TXT� XE "CDUTIL.TXT" � and send it to ZDBOp as described on page � PAGEREF _Ref296397657 �181�.

Problems with video tests

When you run a video test, WinBench 96 displays the name of the video clip file associated with that test at the bottom of the window. You can find these video clip files in the \VIDEO directory on the CD-ROM that contains WinBench 96.

NOTE:	The test files WinBench 96 uses for the CD-ROM and full�motion video tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM will not contain these tests. In addition, some CD-ROM versions may not include these tests.

	You can use the Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests.

If a video test fails, you should first do the following before contacting ZDBOp:

1.	Determine the movie file WinBench 96 was playing when the failure occurred.

2.	Reboot the machine.

3.	Start the Windows program Media Player (usually located in the Windows Accessories group).

4.	Open the movie file that failed using the File Open menu option in Media Player.

NOTE:	 Skip steps 5 and 6 and move to step 7 if you’re testing on Windows 95� XE "Windows 95" �.

5.	Choose the Device Configure or Device Properties menu item from the Media Player main window.

�6.	Clear the Skip video frames if behind check box and close the dialog.

7.	Play the movie by choosing the play button.

If Media Player can’t play the movie, the problem may be due to the display driver. You may want to report the problem to the display adapter vendor.

If Media Player can play the movie, the problem may be due to WinBench 96, and you should report the problem to ZDBOp as described on page � PAGEREF _Ref296397657 �181�.

Hints and tips

� XE "WinBench 96:Hints and tips" �� XE "Troubleshooting:Hints and tips" �� XE "Hints and tips" �If you have trouble running WinBench 96’s tests, the following sections may help you troubleshoot the problem. (If you can find the answer you need here or in the next section, “WinBench 96 error messages,” please contact ZDBOp as described on page � PAGEREF _Ref337606999 �181�.)

Is the CD-ROM drive running at peak performance?

Non-deterministic mechanical effects and read errors from a CD-ROM drive may affect the results of any WinBench 96 CD-ROM and video tests that involve that drive. We recommend when you run any WinBench 96 CD-ROM or video test, you run the CD-ROM/Sequential, 32768 Bytes test afterwards (without rebooting the PC). You can use the results of this test to verify that the CD-ROM drive is operating at its peak performance. Doing this may let you avoid running the test multiple times on each machine you test.

For example, if you’re running the CD-ROM tests on multiple PCs and the results for one PC seem out-of-line, that PC is probably a good candidate for a rerun.

The CD-ROM/Sequential, 32768 bytes test should produce a result that is very close (within about 5%) to the maximum transfer rate of the drive if you run this test on a sufficiently fast PC. (A double-speed drive’s maximum transfer rate is 307 thousand bytes per second, and a quad�speed drive’s maximum transfer rate is 614 thousand bytes per second.)

If the results for the CD-ROM/Sequential, 32768 Bytes test aren’t within 5% of the drive’s maximum transfer rate, try cleaning the test CD-ROM and then running the test again. If the problem still persists, it may be due to non-optimal settings on the CD-ROM adapter card or software drivers.

General tips for running WinBench 96 under Windows 95, Windows NT, and OS/2 Warp

For the most repeatable results, you should stop all other programs and disable any network connections when you run WinBench 96’s tests on Windows 95� XE "Windows 95" �, Windows NT� XE "Windows NT" �, or OS/2 Warp� XE "OS/2 Warp" �. You should also reboot the test PC before running WinBench 96, use an automated mechanism to start WinBench 96, and use batch mode to run any tests.

Under these operating systems, other tasks may preemptively run during WinBench 96’s tests, thus affecting the results. So you’ll want to eliminate as many of these types of tasks as possible.

If you follow consistent testing procedures and don’t have other tasks running, results should be reproducible.

Windows 95

You’ll need to set the Windows 95 Task Bar to Auto Hide mode in order to run the WinBench 96 graphics tests under Windows 95. Also, you must maximize WinBench 96 to the full size of the screen to run the graphics tests.

OS/2 Warp

If you’re running the Processor/32-Bit test or the CPUmark32� XE "CPUmark32" � test, you must install Win32s� XE "Win32s" � version 1.1. The SETUP.EXE file is in the \WIN32S\11\DISK1 directory on the CD-ROM that contains WinBench 96.

WinBench 96 error messages

� XE "WinBench 96:Error messages" �� XE "Troubleshooting:Error messages" �� XE "Error messages" �The following sections explain the different kinds of messages you may receive while running WinBench 96 and generally what may have happened if you see one of these types of messages. If you receive an error message, first follow the instructions on the screen. (WinBench 96 logs all its error messages in a file called ERRORS.TXT� XE "ERRORS.TXT" � in the directory where you installed the benchmark, probably \ZDBENCH\WB96.)

If you continue to have problems, see the next chapter, “� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help�” beginning on page � PAGEREF Chapter21GettingHelp �181�.

Setup messages

If WinBench 96 has problems during installation, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. Problems that can generate a setup error message include a failed installation, an invalid disk drive or path name, or insufficient disk space.

Messages you can receive when using WinBench 96

If WinBench 96 encounters a problem when you open the main window, run a test, or use any of WinBench 96’s windows and dialog boxes, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. Problems that can generate an error message when you are running WinBench 96 include an invalid command line or directory, no test results to display, or saving unchanged results to the database a second time.

Low system resources messages

WinBench 96 warns you if the test PC’s resources or memory are too low to run a test. If you encounter one of these messages:

1.	Exit WinBench 96.

2.	Halt all other applications except WinBench 96.

3.	Restart Windows.

4.	Restart WinBench 96.

5.	Try running the test again.

Database messages� XE "Database:Messages" �� XE "WinBench 96:Messages:Database" �

If WinBench 96 encounters problems while you are working with database files, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. For example, if WinBench 96 cannot create a database file, it will display an error message.

Disk test messages

If WinBench 96 encounters problems while running a disk test, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. If you receive any of these messages:

1.	Make sure the test PC has the required free disk space available on the drive where the test is running.

2.	Make sure the PC has write access to the drive.

3.	If the drive is compressed, make sure the disk compression product isn’t calculating the compression ratio too high.

Cannot find file messages

If WinBench 96 attempts to find a file that is not accessible, it will display an error message. If you receive one of these messages:

1.	Make sure the file exists.

2.	Make sure you have access to the file and its directory.

3.	Check to see if the file is write protected.

4.	Check to see if the file is corrupt.

Messages concerning paths

If the a path WinBench 96 uses is invalid, it will display an error message. The message that appears on the screen will tell you what happened and what you should do to correct the problem. Problems that can generate a path error message include an invalid base or working path or path names that are too long.

Compatibility messages

If WinBench 96 encounters compatibility problems with a library or the operating system, it will issue an error message. In this case, you should:

1.	Make sure the test PC is using the correct version of the operating system.

2.	Reinstall WinBench 96 to assure the PC has the correct libraries.

Corrupt file messages

If WinBench 96’s files become corrupt, the benchmark will issue an error message. If you get one of these messages:

1.	Exit Windows and reboot the PC.

2.	Restart Windows.

3.	Uninstall WinBench 96

4.	Re-install WinBench 96.

5.	Don’t run other applications while running WinBench 96 except WinBench 96.

If you still have problems running WinBench 96, contact us as described in the next chapter.

End of Chapter

�Chapter 22: �Getting Help

This chapter tells you how to contact ZDBOp if you have problems with or questions about WinBench 96. It also explains how to order benchmark documentation and how to request benchmarks.

Sections in this chapter

� REF _Ref296397657 \* MERGEFORMAT �Submitting a problem report�

� REF _Ref296397666 \* MERGEFORMAT �Information we’d like from you�

� REF _Ref336761345 \* MERGEFORMAT �Requesting a benchmark�

Submitting a problem report� XE "WinBench 96:Submitting a problem report" �� XE "Problem report, submitting" �� XE "Technical support:Submitting a problem report" �� XE "Help" �

If you have problems with WinBench 96, you can report those problems using a Problem Report Form. You can find the Problem Report Form at the back of this manual and on ZD Net/CompuServe� XE "CompuServe" � Edition in the ZD Benchmark forum� XE "ZD Benchmark forum" �.

To submit a report, you can:

Post a message about the problem on the ZD Benchmark forum on ZD Net� XE "ZD Net" �/CompuServe Edition (GO ZDBENCH). Access to CompuServe is available for a fee.

Fax the form directly to WinBench 96 Technical Support (919�380�2879).

�Mail the form to us at the following address:

Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560�Attn.: WinBench 96 Technical Support

Information we’d like from you

When you have a problem, it’s most helpful to us if you provide the following information:

Exactly what was WinBench 96 doing when the problem occurred (if you know)?

If there were any dialog boxes or messages on the screen, what were they?

When you started the test, did WinBench 96 display its Warning dialog box? If so, which items in the box where checked.

Can you reproduce the problem?

Can you send us the PC’s Disclosure information?

Can you send us the contents of the Disclosure window and the ERRORS.TXT� XE "ERRORS.TXT" � file? You can fax this information to us or you can include it in a message on ZD Net.

The Problem Report Form provides space for you to answer these questions. If you don’t want to send in a Problem Report Form, please include the above information in any faxes or communications you send to us.

Requesting a benchmark� XE "Requesting a benchmark" �� XE "WinBench 96:Requesting a benchmark" �� XE "Ziff-Davis:Requesting a benchmark" �

If you’d like to request copies of WinBench 96 or other Ziff-Davis benchmarks, fill out the Benchmark Request Form at the back of this manual. Then, you can:

Fax it to our dedicated benchmark request fax number (919-380-2879)� XE "Ziff-Davis:Fax number" �� XE "Fax number" �

Mail it to us at:

Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560�Attn.:  Distribution Coordinator

End of Chapter

�Appendix A: �The Database Files

� XE "Results:Database files" �� XE "WinBench 96:Results:Database files" �Both WinBench 96 and Winstone 96� XE "Winstone 96" � write their results to a common file format, .DBF. This commonality means the benchmarks now collect all results in one place (by default, \ZDBENCH\RESULT96.ZDB� XE "RESULT96.ZDB" �).

This appendix lists and describes all the database files WinBench 96 creates when you save results to the common database.

NOTE:	You can view the .DBF files WinBench 96 creates from any database application that accepts .DBF or spreadsheet files.

Sections in this appendix

� REF _Ref300459728 \* MERGEFORMAT �Database files WinBench 96 produces�

� REF _Ref303134043 \* MERGEFORMAT �Fields in the WB*_DATA.DBF files�

Database files WinBench 96 produces

When you run a test and save its result to the database, WinBench 96 creates several different types of files. Table A-1 lists all the files WinBench 96 creates when you save results. You’ll find all these files in a database directory.

NOTE:	Each results file has an accompanying index file in FoxPro format. The index files are there to speed up database searches. If you’re using FoxPro to view the .DBF files, then you can use the index files.

�Table A-1:  The files WinBench 96 creates

File�Purpose�Format��COMNSYS.DBF� XE "COMNSYS.DBF" ��Stores system information common to all benchmarks. Used to distinguish one machine from another.�dBase��COMNSYS.CDX� XE "COMNSYS.CDX" ��Index file for COMNSYS.DBF.�FoxPro��WBN_SYS.DBF� XE "WBN_SYS.DBF" ��Stores benchmark-specific information. Used to identify a set of results collected for the machine identified in COMNSYS.DBF.�dBase��WBN_SYS.CDX� XE "WBN_SYS.CDX" ��Index file for WBN_SYS.DBF.�FoxPro��WBN_SYS.FPT� XE "WBN_SYS.FPT" ��Memo file associated with WBN_SYS.DBF.�FoxPro��WB1_DATA.DBF� XE "WB1_DATA.DBF" ��Stores WinBench 96 results. The remaining results are stored in WB2_DATA.DBF and WB3_DATA.DBF.�dBase��WB1_DATA.CDX� XE "WB1_DATA.CDX" ��Index file for WB1_DATA.DBF.�FoxPro��WB2_DATA.DBF� XE "WB2_DATA.DBF" ��Stores WinBench 96 results. The remaining results are stored in WB3_DATA.DBF.�dBase��WB2_DATA.CDX� XE "WB2_DATA.CDX" ��Index file for WB2_DATA.DBF.�FoxPro��WB3_DATA.DBF� XE "WB3_DATA.DBF" ��Stores the remaining WinBench 96 results.�dBase��WB3_DATA.CDX� XE "WB3_DATA.CDX" ��The index file for WB3_DATA.DBF.�FoxPro��Fields in the WB*_DATA.DBF files

The following table lists each WinBench 96 test and corresponding field name in the WB1_DATA.DBF� XE "WB1_DATA.DBF" �, WB2_DATA.DBF� XE "WB2_DATA.DBF" �, and WB3_DATA.DBF� XE "WB3_DATA.DBF" � files.

NOTE:	The following list shows the fields as they appear in the results file. If you use a .DBF-compatible application to view this file, that application may show the fields in a different order.

Table A-2:  The WB1_DATA.DBF field names

Test name:�Field name:��WB1_DATA.DBF��Disk WinMark 96�DISKMARK��Graphics WinMark 96�GRAPHMARK��CD-ROM WinMark 96�MARK3��CPUmark16�MARK4��CPUmark32�MARK5��Disk/Mix �TEST1��Disk/Read, Sequential, 200 bytes �TEST2���

Test name:�Field name:��WB1_DATA.DBF (continued)��Disk/Write, Sequential, 200 bytes �TEST3��Disk/Read, Random, 200 bytes �TEST4��Disk/Write, Random, 200 bytes �TEST5��Disk/Read, Sequential, 512 bytes �TEST6��Disk/Write, Sequential, 512 bytes �TEST7��Disk/Read, Random, 512 bytes �TEST8��Disk/Write, Random, 512 bytes �TEST9��Disk/Read, Sequential, 2048 bytes �TEST10��Disk/Write, Sequential, 2048 bytes �TEST11��Disk/Read, Random, 2048 bytes �TEST12��Disk/Write, Random, 2048 bytes �TEST13��Disk/Read, Sequential, 4096 bytes �TEST14��Disk/Write, Sequential, 4096 bytes �TEST15��Disk/Read, Random, 4096 bytes �TEST16��Disk/Write, Random, 4096 bytes �TEST17��CD-ROM/Sequential, 200 bytes �TEST20��CD-ROM/Sequential, 512 bytes �TEST21��CD-ROM/Sequential, 2048 bytes �TEST22��CD-ROM/Sequential, 4096 bytes �TEST23��CD-ROM/Sequential, 8192 bytes �TEST24��CD-ROM/Sequential, 16384 bytes �TEST25��CD-ROM/Sequential, 32768 bytes �TEST26��CD-ROM/Random, 200 bytes �TEST27��CD-ROM/Random, 512 bytes �TEST28��CD-ROM/Random, 2048 bytes �TEST29��CD-ROM/Random, 4096 bytes �TEST30��CD-ROM/Random, 8192 bytes �TEST31��CD-ROM/Random, 16384 bytes �TEST32��CD-ROM/Random, 32768 bytes �TEST33��CD-ROM/Access Time (MSCDEX) �TEST34��CD-ROM/CPU Utilization �TEST36��CD-ROM/Mix �TEST37���

Test name:�Field name:��WB1_DATA.DBF (continued)��Processor/16-Bit �TEST48��Processor/32-Bit �TEST49��Video/Head, Cinepak, 320x240, 15fps, 300KB/S:Visual Quality �TEST50��Video/Head, Cinepak, 320x240, 15fps, 300KB/S:Audio Quality �TEST51��Video/Head, Cinepak, 320x240, 15fps, 300KB/S:Temporal Quality �TEST52��Video/Head, Cinepak, 320x240, 15fps, 300KB/S:Max Frame Rate �TEST53��Video/Head, Cinepak, 320x240, 15fps, 300KB/S:CPU Utilization �TEST54��Video/Head, Cinepak, 320x240, 25fps, 300KB/S:Visual Quality �TEST55��Video/Head, Cinepak, 320x240, 25fps, 300KB/S:Audio Quality �TEST56��Video/Head, Cinepak, 320x240, 25fps, 300KB/S:Temporal Quality �TEST57��Video/Head, Cinepak, 320x240, 25fps, 300KB/S:Max Frame Rate �TEST58��Video/Head, Cinepak, 320x240, 25fps, 300KB/S:CPU Utilization �TEST59��Video/Head, Cinepak, 320x240, 30fps, 300KB/S:Visual Quality �TEST60��Video/Head, Cinepak, 320x240, 30fps, 300KB/S:Audio Quality �TEST61��Video/Head, Cinepak, 320x240, 30fps, 300KB/S:Temporal Quality �TEST62��Video/Head, Cinepak, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST63��Video/Head, Cinepak, 320x240, 30fps, 300KB/S:CPU Utilization �TEST64��Video/Head, Indeo, 320x240, 15fps, 300KB/S:Visual Quality �TEST65��Video/Head, Indeo, 320x240, 15fps, 300KB/S:Audio Quality �TEST66��Video/Head, Indeo, 320x240, 15fps, 300KB/S:Temporal Quality �TEST67��Video/Head, Indeo, 320x240, 15fps, 300KB/S:Max Frame Rate �TEST68��Video/Head, Indeo, 320x240, 15fps, 300KB/S:CPU Utilization �TEST69��Video/Head, Indeo, 320x240, 25fps, 300KB/S:Visual Quality �TEST70��Video/Head, Indeo, 320x240, 25fps, 300KB/S:Audio Quality �TEST71��Video/Head, Indeo, 320x240, 25fps, 300KB/S:Temporal Quality �TEST72��Video/Head, Indeo, 320x240, 25fps, 300KB/S:Max Frame Rate �TEST73��Video/Head, Indeo, 320x240, 25fps, 300KB/S:CPU Utilization �TEST74��Video/Head, Indeo, 320x240, 30fps, 300KB/S:Visual Quality �TEST75��Video/Head, Indeo, 320x240, 30fps, 300KB/S:Audio Quality �TEST76��Video/Head, Indeo, 320x240, 30fps, 300KB/S:Temporal Quality �TEST77��Video/Head, Indeo, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST78��Video/Head, Indeo, 320x240, 30fps, 300KB/S:CPU Utilization �TEST79��Video/Head, Indeo, 320x240, 15fps, 150KB/S:Visual Quality �TEST80���

Test name:�Field name:��WB1_DATA.DBF (continued)��Video/Head, Indeo, 320x240, 15fps, 150KB/S:Audio Quality �TEST81��Video/Head, Indeo, 320x240, 15fps, 150KB/S:Temporal Quality �TEST82��Video/Head, Indeo, 320x240, 15fps, 150KB/S:Max Frame Rate �TEST83��Video/Head, Indeo, 320x240, 15fps, 150KB/S:CPU Utilization �TEST84��Video/Head, Indeo, 320x240, 25fps, 150KB/S:Visual Quality �TEST85��Video/Head, Indeo, 320x240, 25fps, 150KB/S:Audio Quality �TEST86��Video/Head, Indeo, 320x240, 25fps, 150KB/S:Temporal Quality �TEST87��Video/Head, Indeo, 320x240, 25fps, 150KB/S:Max Frame Rate �TEST88��Video/Head, Indeo, 320x240, 25fps, 150KB/S:CPU Utilization �TEST89��Video/Head, Indeo, 320x240, 30fps, 150KB/S:Visual Quality �TEST90��Video/Head, Indeo, 320x240, 30fps, 150KB/S:Audio Quality �TEST91��Video/Head, Indeo, 320x240, 30fps, 150KB/S:Temporal Quality �TEST92��Video/Head, Indeo, 320x240, 30fps, 150KB/S:Max Frame Rate �TEST93��Video/Head, Indeo, 320x240, 30fps, 150KB/S:CPU Utilization �TEST94��Video/Head, Indeo, 160x120, 30fps, 150KB/S:Visual Quality �TEST95��Video/Head, Indeo, 160x120, 30fps, 150KB/S:Audio Quality �TEST96��Video/Head, Indeo, 160x120, 30fps, 150KB/S:Temporal Quality �TEST97��Video/Head, Indeo, 160x120, 30fps, 150KB/S:Max Frame Rate �TEST98��Video/Head, Indeo, 160x120, 30fps, 150KB/S:CPU Utilization �TEST99��Video/Action, Cinepak, 320x240, 15fps, 300KB/S:Visual Quality �TEST100��Video/Action, Cinepak, 320x240, 15fps, 300KB/S:Audio Quality �TEST101��Video/Action, Cinepak, 320x240, 15fps, 300KB/S:Temporal Quality �TEST102��Video/Action, Cinepak, 320x240, 15fps, 300KB/S:Max Frame Rate �TEST103��Video/Action, Cinepak, 320x240, 15fps, 300KB/S:CPU Utilization �TEST104��Video/Action, Cinepak, 320x240, 25fps, 300KB/S:Visual Quality �TEST105��Video/Action, Cinepak, 320x240, 25fps, 300KB/S:Audio Quality �TEST106��Video/Action, Cinepak, 320x240, 25fps, 300KB/S:Temporal Quality �TEST107��Video/Action, Cinepak, 320x240, 25fps, 300KB/S:Max Frame Rate �TEST108��Video/Action, Cinepak, 320x240, 25fps, 300KB/S:CPU Utilization �TEST109��Video/Action, Cinepak, 320x240, 30fps, 300KB/S:Visual Quality �TEST110��Video/Action, Cinepak, 320x240, 30fps, 300KB/S:Audio Quality �TEST111��Video/Action, Cinepak, 320x240, 30fps, 300KB/S:Temporal Quality �TEST112��Video/Action, Cinepak, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST113���

Test name:�Field name:��WB1_DATA.DBF (continued)��Video/Action, Cinepak, 320x240, 30fps, 300KB/S:CPU Utilization �TEST114��Video/Action, Indeo, 320x240, 15fps, 300KB/S:Visual Quality �TEST115��Video/Action, Indeo, 320x240, 15fps, 300KB/S:Audio Quality �TEST116��Video/Action, Indeo, 320x240, 15fps, 300KB/S:Temporal Quality �TEST117��Video/Action, Indeo, 320x240, 15fps, 300KB/S:Max Frame Rate �TEST118��Video/Action, Indeo, 320x240, 15fps, 300KB/S:CPU Utilization �TEST119��Video/Action, Indeo, 320x240, 25fps, 300KB/S:Visual Quality �TEST120��Video/Action, Indeo, 320x240, 25fps, 300KB/S:Audio Quality �TEST121��Video/Action, Indeo, 320x240, 25fps, 300KB/S:Temporal Quality �TEST122��Video/Action, Indeo, 320x240, 25fps, 300KB/S:Max Frame Rate �TEST123��Video/Action, Indeo, 320x240, 25fps, 300KB/S:CPU Utilization �TEST124��Video/Action, Indeo, 320x240, 30fps, 300KB/S:Visual Quality �TEST125��Video/Action, Indeo, 320x240, 30fps, 300KB/S:Audio Quality �TEST126��Video/Action, Indeo, 320x240, 30fps, 300KB/S:Temporal Quality �TEST127��Video/Action, Indeo, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST128��Video/Action, Indeo, 320x240, 30fps, 300KB/S:CPU Utilization �TEST129��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Visual Quality �TEST130��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Audio Quality �TEST131��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Temporal Quality �TEST132��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Max Frame Rate �TEST133��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:CPU Utilization �TEST134��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Visual Quality �TEST135��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Audio Quality �TEST136��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Temporal Quality �TEST137��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Max Frame Rate �TEST138��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:CPU Utilization �TEST139��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Visual Quality �TEST140��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Audio Quality �TEST141��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Temporal Quality �TEST142��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Max Frame Rate �TEST143��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:CPU Utilization �TEST144��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Visual Quality �TEST145��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Audio Quality �TEST146���

Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Temporal Quality �TEST147��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Max Frame Rate �TEST148��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:CPU Utilization �TEST149��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full:Visual Quality �TEST150��Table A-3:  The WB2_DATA.DBF field names

Test name:�Field name:��WB2_DATA.DBF��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full:Audio Quality �TEST151��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full:Temporal Quality �TEST152��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full:Max Frame Rate �TEST153��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full:CPU Utilization �TEST154��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Visual Quality �TEST155��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Audio Quality �TEST156��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Temporal Quality �TEST157��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Max Frame Rate �TEST158��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x:CPU Utilization �TEST159��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Visual Quality �TEST160��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Audio Quality �TEST161��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Temporal Quality �TEST162��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Max Frame Rate �TEST163��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x:CPU Utilization �TEST164��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Visual Quality �TEST165��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Audio Quality �TEST166��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Temporal Quality �TEST167��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Max Frame Rate �TEST168��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x:CPU Utilization �TEST169��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Visual Quality �TEST170��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Audio Quality �TEST171��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Temporal Quality �TEST172��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Max Frame Rate �TEST173��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x:CPU Utilization �TEST174��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full:Visual Quality �TEST175��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full:Audio Quality �TEST176��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full:Temporal Quality �TEST177���

Test name:�Field name:��WB2_DATA.DBF (continued)��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full:Max Frame Rate �TEST178��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full:CPU Utilization �TEST179��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Visual Quality �TEST180��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Audio Quality �TEST181��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Temporal Quality �TEST182��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:Max Frame Rate �TEST183��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x:CPU Utilization �TEST184��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Visual Quality �TEST185��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Audio Quality �TEST186��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Temporal Quality �TEST187��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:Max Frame Rate �TEST188��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x:CPU Utilization �TEST189��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Visual Quality �TEST190��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Audio Quality �TEST191��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Temporal Quality �TEST192��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:Max Frame Rate �TEST193��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x:CPU Utilization �TEST194��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Visual Quality �TEST195��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Audio Quality �TEST196��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Temporal Quality �TEST197��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:Max Frame Rate �TEST198��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x:CPU Utilization �TEST199��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full:Visual Quality �TEST200��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full:Audio Quality �TEST201��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full:Temporal Quality �TEST202��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full:Max Frame Rate �TEST203��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full:CPU Utilization �TEST204��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Visual Quality �TEST205��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Audio Quality �TEST206��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Temporal Quality �TEST207��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x:Max Frame Rate �TEST208��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x:CPU Utilization �TEST209��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Visual Quality �TEST210���

Test name:�Field name:��WB2_DATA.DBF (continued)��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Audio Quality �TEST211��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Temporal Quality �TEST212��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x:Max Frame Rate �TEST213��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x:CPU Utilization �TEST214��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Visual Quality �TEST215��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Audio Quality �TEST216��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Temporal Quality �TEST217��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x:Max Frame Rate �TEST218��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x:CPU Utilization �TEST219��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Visual Quality �TEST220��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Audio Quality �TEST221��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Temporal Quality �TEST222��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x:Max Frame Rate �TEST223��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x:CPU Utilization �TEST224��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full:Visual Quality �TEST225��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full:Audio Quality �TEST226��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full:Temporal Quality �TEST227��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full:Max Frame Rate �TEST228��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full:CPU Utilization �TEST229��Video/Action, Indeo, 320x240, 15fps, 250KB/S:Visual Quality �TEST230��Video/Action, Indeo, 320x240, 15fps, 250KB/S:Audio Quality �TEST231��Video/Action, Indeo, 320x240, 15fps, 250KB/S:Temporal Quality �TEST232��Video/Action, Indeo, 320x240, 15fps, 250KB/S:Max Frame Rate �TEST233��Video/Action, Indeo, 320x240, 15fps, 250KB/S:CPU Utilization �TEST234��Video/Action, Indeo, 320x240, 25fps, 250KB/S:Visual Quality �TEST235��Video/Action, Indeo, 320x240, 25fps, 250KB/S:Audio Quality �TEST236��Video/Action, Indeo, 320x240, 25fps, 250KB/S:Temporal Quality �TEST237��Video/Action, Indeo, 320x240, 25fps, 250KB/S:Max Frame Rate �TEST238��Video/Action, Indeo, 320x240, 25fps, 250KB/S:CPU Utilization �TEST239��Video/Action, Indeo, 320x240, 30fps, 250KB/S:Visual Quality �TEST240��Video/Action, Indeo, 320x240, 30fps, 250KB/S:Audio Quality �TEST241��Video/Action, Indeo, 320x240, 30fps, 250KB/S:Temporal Quality �TEST242��Video/Action, Indeo, 320x240, 30fps, 250KB/S:Max Frame Rate �TEST243���

Test name:�Field name:��WB2_DATA.DBF (continued)��Video/Action, Indeo, 320x240, 30fps, 250KB/S:CPU Utilization �TEST244��Video/Action, Indeo, 320x240, 15fps, 450KB/S:Visual Quality �TEST245��Video/Action, Indeo, 320x240, 15fps, 450KB/S:Audio Quality �TEST246��Video/Action, Indeo, 320x240, 15fps, 450KB/S:Temporal Quality �TEST247��Video/Action, Indeo, 320x240, 15fps, 450KB/S:Max Frame Rate �TEST248��Video/Action, Indeo, 320x240, 15fps, 450KB/S:CPU Utilization �TEST249��Video/Action, Indeo, 320x240, 25fps, 450KB/S:Visual Quality �TEST250��Video/Action, Indeo, 320x240, 25fps, 450KB/S:Audio Quality �TEST251��Video/Action, Indeo, 320x240, 25fps, 450KB/S:Temporal Quality �TEST252��Video/Action, Indeo, 320x240, 25fps, 450KB/S:Max Frame Rate �TEST253��Video/Action, Indeo, 320x240, 25fps, 450KB/S:CPU Utilization �TEST254��Video/Action, Indeo, 320x240, 30fps, 450KB/S:Visual Quality �TEST255��Video/Action, Indeo, 320x240, 30fps, 450KB/S:Audio Quality �TEST256��Video/Action, Indeo, 320x240, 30fps, 450KB/S:Temporal Quality �TEST257��Video/Action, Indeo, 320x240, 30fps, 450KB/S:Max Frame Rate �TEST258��Video/Action, Indeo, 320x240, 30fps, 450KB/S:CPU Utilization �TEST259��Video/Action, Indeo, 320x240, 15fps, 600KB/S:Visual Quality �TEST260��Video/Action, Indeo, 320x240, 15fps, 600KB/S:Audio Quality �TEST261��Video/Action, Indeo, 320x240, 15fps, 600KB/S:Temporal Quality �TEST262��Video/Action, Indeo, 320x240, 15fps, 600KB/S:Max Frame Rate �TEST263��Video/Action, Indeo, 320x240, 15fps, 600KB/S:CPU Utilization �TEST264��Video/Action, Indeo, 320x240, 25fps, 600KB/S:Visual Quality �TEST265��Video/Action, Indeo, 320x240, 25fps, 600KB/S:Audio Quality �TEST266��Video/Action, Indeo, 320x240, 25fps, 600KB/S:Temporal Quality �TEST267��Video/Action, Indeo, 320x240, 25fps, 600KB/S:Max Frame Rate �TEST268��Video/Action, Indeo, 320x240, 25fps, 600KB/S:CPU Utilization �TEST269��Video/Action, Indeo, 320x240, 30fps, 600KB/S:Visual Quality �TEST270��Video/Action, Indeo, 320x240, 30fps, 600KB/S:Audio Quality �TEST271��Video/Action, Indeo, 320x240, 30fps, 600KB/S:Temporal Quality �TEST272��Video/Action, Indeo, 320x240, 30fps, 600KB/S:Max Frame Rate �TEST273��Video/Action, Indeo, 320x240, 30fps, 600KB/S:CPU Utilization �TEST274��Video/Action, Indeo, 320x240, 25fps, 750KB/S:Visual Quality �TEST275��Video/Action, Indeo, 320x240, 25fps, 750KB/S:Audio Quality �TEST276���

Test name:�Field name:��WB2_DATA.DBF (continued)��Video/Action, Indeo, 320x240, 25fps, 750KB/S:Temporal Quality �TEST277��Video/Action, Indeo, 320x240, 25fps, 750KB/S:Max Frame Rate �TEST278��Video/Action, Indeo, 320x240, 25fps, 750KB/S:CPU Utilization �TEST279��Video/Action, Indeo, 320x240, 30fps, 750KB/S:Visual Quality �TEST280��Video/Action, Indeo, 320x240, 30fps, 750KB/S:Audio Quality �TEST281��Video/Action, Indeo, 320x240, 30fps, 750KB/S:Temporal Quality �TEST282��Video/Action, Indeo, 320x240, 30fps, 750KB/S:Max Frame Rate �TEST283��Video/Action, Indeo, 320x240, 30fps, 750KB/S:CPU Utilization �TEST284��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S:Visual Quality �TEST285��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S:Audio Quality �TEST286��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S:Temporal Quality �TEST287��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST288��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S:CPU Utilization �TEST289��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S:Visual Quality �TEST290��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S:Audio Quality �TEST291��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S:Temporal Quality �TEST292��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST293��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S:CPU Utilization �TEST294��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S:Visual Quality �TEST295��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S:Audio Quality �TEST296��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S:Temporal Quality �TEST297��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S:Max Frame Rate �TEST298��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S:CPU Utilization �TEST299��Video/User Supplied Movie:Visual Quality �TEST300��Video/User Supplied Movie:Audio Quality �TEST301��Video/User Supplied Movie:Temporal Quality �TEST302��Video/User Supplied Movie:Max Frame Rate �TEST303��Video/User Supplied Movie:CPU Utilization �TEST304��Video/Action, Cinepak, 640x480, 15fps, 900kb/s:Visual Quality�TEST305��Video/Action, Cinepak, 640x480, 15fps, 900kb/s:Audio Quality�TEST306��Video/Action, Cinepak, 640x480, 15fps, 900kb/s:Temporal Quality�TEST307��Video/Action, Cinepak, 640x480, 15fps, 900kb/s:Max Frame Rate�TEST308��Video/Action, Cinepak, 640x480, 15fps, 900kb/s:CPU Utilization�TEST309���

Test name:�Field name:��WB2_DATA.DBF (continued)��Video/Action, Cinepak, 640x480, 30fps, 900kb/s:Visual Quality�TEST310��Video/Action, Cinepak, 640x480, 30fps, 900kb/s:Audio Quality�TEST311��Video/Action, Cinepak, 640x480, 30fps, 900kb/s:Temporal Quality�TEST312��Video/Action, Cinepak, 640x480, 30fps, 900kb/s:Max Frame Rate�TEST313��Video/Action, Cinepak, 640x480, 30fps, 900kb/s:CPU Utilization�TEST314��Video/Action, Indeo, 640x480, 15fps, 900kb/s:Visual Quality�TEST315��Video/Action, Indeo, 640x480, 15fps, 900kb/s:Audio Quality�TEST316��Video/Action, Indeo, 640x480, 15fps, 900kb/s:Temporal Quality�TEST317��Video/Action, Indeo, 640x480, 15fps, 900kb/s:Max Frame Rate�TEST318��Video/Action, Indeo, 640x480, 15fps, 900kb/s:CPU Utilization�TEST319��Video/Action, Indeo, 640x480, 30fps, 900kb/s:Visual Quality�TEST320��Video/Action, Indeo, 640x480, 30fps, 900kb/s:Audio Quality�TEST321��Video/Action, Indeo, 640x480, 30fps, 900kb/s:Temporal Quality�TEST322��Video/Action, Indeo, 640x480, 30fps, 900kb/s:Max Frame Rate�TEST323��Video/Action, Indeo, 640x480, 30fps, 900kb/s:CPU Utilization�TEST324��GWM/S/SetPixel �TEST350��GWM/S/GetPixel �TEST351��GWM/S/Polygon, Few-sides �TEST352��GWM/S/Polygon, Few-sides, Clip �TEST353��GWM/S/Polygon, Many-sides �TEST354��GWM/S/Polygon, Many-sides, Clip �TEST355��GWM/S/PolyPolygon �TEST356��GWM/S/PolyLine �TEST357��GWM/S/Line, Horizontal �TEST358��GWM/S/Line, Vertical �TEST359��GWM/S/Line, Diagonal �TEST360��GWM/S/Line, Horizontal, Clip �TEST361��GWM/S/Line, Vertical, Clip �TEST362��GWM/S/Rectangle �TEST363��GWM/S/Rectangle, Clip �TEST364��GWM/S/ExtTextOut, Rectangle �TEST365��GWM/S/ExtTextOut, Rectangle, Clip �TEST366��GWM/S/Arc, Elliptical, Complete �TEST367���

Test name:�Field name:��WB2_DATA.DBF (continued)��GWM/S/Ellipse �TEST368��GWM/S/Ellipse, Clip �TEST369��GWM/S/Circle �TEST370��GWM/S/Pie, Elliptical �TEST371��GWM/S/Rectangle, Rounded �TEST372��GWM/S/PatBlt, PATCOPY �TEST373��GWM/S/PatBlt, WHITENESS �TEST374��GWM/S/PatBlt, DSTINVERT �TEST375��GWM/S/PatBlt, Others �TEST376��GWM/S/PatBlt, PATCOPY, Clip �TEST377��GWM/S/PatBlt, WHITENESS, Clip �TEST378��GWM/S/PatBlt, DSTINVERT, Clip �TEST379��GWM/S/PatBlt, Others, Clip �TEST380��GWM/S/PatBlt, MonoPATCOPY �TEST381��GWM/S/PatBlt, MonoOthers �TEST382��GWM/S/PatBlt, MonoPATCOPY, Clip �TEST383��GWM/S/PatBlt, MonoOthers, Clip �TEST384��GWM/S/StretchDIBits, 4 bpp, SRCCOPY �TEST385��GWM/S/StretchDIBits, 4 bpp, SRCCOPY, Clip �TEST386��GWM/S/StretchDIBits, 8 bpp, SRCCOPY �TEST387��GWM/S/SetDIBitsToDevice, 4 bpp �TEST388��GWM/S/FillRgn �TEST389��GWM/S/InvertRgn �TEST390��GWM/S/PaintRgn �TEST391��GWM/S/Text, Times Roman 29 �TEST392��GWM/S/Text, Times Roman 19 �TEST393���Table A-4:  The WB3_DATA.DBF field names

Test name:�Field name:��WB3_DATA.DBF��GWM/S/Text, Sans Serif 13 �TEST394��GWM/S/Text, Sans Serif 16 �TEST395��GWM/S/Text, Sans Serif Bold 13, Clip �TEST396��GWM/S/Text, Times Roman 15 �TEST397��GWM/S/Text, System 16 �TEST398��GWM/S/Text, Arial 16 �TEST399��GWM/SToS/BitBlt, SRCCOPY �TEST400��GWM/SToS/BitBlt, SRCCOPY, Clip �TEST401��GWM/MToS/BitBlt, Others �TEST402��GWM/MToS/BitBlt, SRCCOPY, Clip �TEST403��GWM/MToS/BitBlt, Others, Clip �TEST404��GWM/CToS/BitBlt, SRCCOPY �TEST405��GWM/CToS/BitBlt, Others �TEST406��GWM/CToS/BitBlt, SRCCOPY, Clip �TEST407��GWM/CToS/BitBlt, Others, Clip �TEST408��GWM/CToS/StretchBlt, SRCCOPY �TEST409��GWM/CToS/StretchBlt, SRCCOPY, Clip �TEST410��GWM/M/Rectangle �TEST411��GWM/M/Rectangle, Clip �TEST412��GWM/M/ExtTextOut, Rectangle �TEST413��GWM/M/PatBlt, WHITENESS �TEST414��GWM/M/PatBlt, ROP(FA) �TEST415��GWM/M/PatBlt, Others �TEST416��GWM/M/PatBlt, WHITENESS, Clip �TEST417��GWM/M/SetDIBitsBlt, 1 bpp �TEST418��GWM/M/Text, Times Roman Bold 17 �TEST419���GWM/M/Text, Times Roman Bold 19 �TEST420��GWM/M/Text, System 16 �TEST421��GWM/M/Text, Times Roman 15 �TEST422��GWM/M/Text, Times Roman 16, Clip �TEST423��GWM/SToM/BitBlt, SRCCOPY �TEST424��GWM/MToM/BitBlt, Others �TEST425���

Test name:�Field name:��WB3_DATA.DBF (continued)��GWM/CToM/BitBlt, Others �TEST426��GWM/CToM/BitBlt, SRCCOPY, Clip �TEST427��GWM/C/SetPixel �TEST428��GWM/C/Polygon, Few-sides �TEST429��GWM/C/Polygon, Few-sides, Clip �TEST430��GWM/C/Polygon, Many-sides �TEST431��GWM/C/PolyLine �TEST432��GWM/C/Line, Horizontal �TEST433��GWM/C/Line, Vertical �TEST434��GWM/C/Line, Diagonal �TEST435��GWM/C/Line, Vertical, Clip �TEST436��GWM/C/Line, Diagonal, Clip �TEST437��GWM/C/Rectangle �TEST438��GWM/C/Rectangle, Clip �TEST439��GWM/C/ExtTextOut, Rectangle �TEST440��GWM/C/ExtTextOut, Rectangle, Clip �TEST441��GWM/C/Ellipse �TEST442��GWM/C/PatBlt, PATCOPY �TEST443��GWM/C/PatBlt, Others �TEST444��GWM/C/PatBlt, PATCOPY, Clip �TEST445��GWM/C/PatBlt, DESTINVERT, Clip �TEST446��GWM/C/PatBlt, MonoPATCOPY �TEST447��GWM/C/PatBlt, MonoOthers �TEST448��GWM/C/PatBlt, MonoPATCOPY, Clip �TEST449��GWM/C/StretchDIBits, 4 bpp, SRCCOPY �TEST450��GWM/C/BltDIBits, 8 bpp, SRCCOPY �TEST451��GWM/C/SetDIBitsBlt, 4 bpp �TEST452���GWM/C/SetDIBitsBlt, 8 bpp �TEST453��GWM/C/InvertRgn �TEST454��GWM/C/Text, Arial Bold 24 �TEST455��GWM/C/Text, Times Roman 16 �TEST456��GWM/C/Text, Times Roman 15, Clip �TEST457��GWM/C/Text, Times Roman 40 �TEST458���

Test name:�Field name:��WB3_DATA.DBF (continued)��GWM/C/Text, Arial 16 �TEST459��GWM/SToC/BitBlt, SRCCOPY �TEST460��GWM/MToC/BitBlt, Others �TEST461��GWM/MToC/BitBlt, SRCAND, Clip �TEST462��GWM/CToC/BitBlt, Others �TEST463��GWM/CToC/BitBlt, Others, Clip �TEST464��S/Arc, Circular, Partial �TEST465��S/Arc, Elliptical, Partial �TEST466��S/Arc, Circular, Complete �TEST467��S/Arc, Elliptical, Complete �TEST468��S/Chord, Circular �TEST469��S/Chord, Elliptical �TEST470��S/Circle �TEST471��S/Ellipse �TEST472��S/Pie, Circular �TEST473��S/Pie, Elliptical �TEST474��S/Line, Horizontal �TEST475��S/Line, Vertical �TEST476��S/Line, Diagonal �TEST477��S/Polygon, Many-sides �TEST478��S/Polygon, Few-sides �TEST479��S/Polygon, Triangle �TEST480��S/Polygon, Trapezoid �TEST481��S/InvertRgn �TEST482��S/PaintRgn �TEST483��S/FillRgn �TEST484��S/FillRect �TEST485���S/InvertRect �TEST486��S/PatBlt, PATCOPY �TEST487��S/PatBlt, WHITENESS �TEST488��S/PatBlt, DESTINVERT �TEST489��S/PatBlt, All ROPs �TEST490��S/FrameRect �TEST491���

Test name:�Field name:��WB3_DATA.DBF (continued)��S/FrameRgn �TEST492��S/DrawFocusRect �TEST493��S/Text, Times Roman 16 �TEST494��S/DrawText, Times Roman 16 �TEST495��S/GrayString, Times Roman 16 �TEST496��S/TabbedTextOut, Times Roman 16 �TEST497��S/Text, Times Roman 16, 45 �TEST498��S/Text, Times Roman 16, 90 �TEST499��S/BltDIBits, 1 bpp, SRCCOPY �TEST500��S/BltDIBits, 4 bpp, SRCCOPY �TEST501��S/BltDIBits, 8 bpp, SRCCOPY �TEST502��S/BltDIBits, 24 bpp, SRCCOPY �TEST503��S/SetDIBitsToDevice, 1 bpp �TEST504��S/SetDIBitsToDevice, 4 bpp �TEST505��S/SetDIBitsToDevice, 8 bpp �TEST506��S/SetDIBitsToDevice, 24 bpp �TEST507��S/SetDIBitsBlt, 1 bpp �TEST508��S/SetDIBitsBlt, 4 bpp �TEST509��S/SetDIBitsBlt, 8 bpp �TEST510��S/SetDIBitsBlt, 24 bpp �TEST511��S/StretchDIBits, 1 bpp, SRCCOPY �TEST512��S/StretchDIBits, 4 bpp, SRCCOPY �TEST513��S/StretchDIBits, 8 bpp, SRCCOPY �TEST514��S/StretchDIBits, 24 bpp, SRCCOPY �TEST515��S/MoveTo �TEST516��S/MoveToEx �TEST517��S/GetNearestColor �TEST518���S/ScrollDC �TEST519��S/ExtFloodFill, Border �TEST520��S/ExtFloodFill, Surface �TEST521��S/FloodFill �TEST522��S/DrawIcon �TEST523��S/FastWindowFrame �TEST524���

Test name:�Field name:��WB3_DATA.DBF (continued)��SToS/BitBlt, SRCCOPY �TEST529��SToS/BitBlt, All ROPs �TEST530��SToS/StretchBlt, SRCCOPY �TEST531��SToS/StretchBlt, All ROPs �TEST532��MToS/BitBlt, SRCCOPY �TEST533��MToS/BitBlt, All ROPs �TEST534��MToS/StretchBlt, SRCCOPY �TEST535��MToS/StretchBlt, All ROPs �TEST536��CToS/BitBlt, SRCCOPY �TEST537��CToS/BitBlt, All ROPs �TEST538��CToS/StretchBlt, SRCCOPY �TEST539��CToS/StretchBlt, All ROPs �TEST540��Combined GWM13 �TEST541��Combined GWM12 �TEST542��Combined GWM11 �TEST543��Combined GWM10 �TEST544��Combined GWM 9 �TEST545��Combined GWM 8 �TEST546��Combined GWM 7 �TEST547��Combined GWM 6 �TEST548��Combined GWM 5 �TEST549��Combined GWM 4 �TEST550��Combined GWM 3 �TEST551��Combined GWM 2 �TEST552��Combined GWM 1 �TEST553��S/SetDIBitsToDevice, User Supplied Bitmap�TEST554��S/SetDIBitsBlt, User Supplied Bitmap�TEST555��S/BltDIBits, SRCCOPY, User Supplied Bitmap�TEST556��S/StretchDIBits, SRCCOPY, User Supplied Bitmap�TEST557��End of Appendix

�Appendix B: �The Custom Configuration File

� XE "Custom Configuration file:Editing" \r "CustomConfigFile" �� XE "WinBench 96:Custom Configuration file:Editing" \r "CustomConfigFile" �You can use WinBench 96’s configuration check to compare the test PC’s setup and configuration to pre-defined settings in a custom configuration file.

This appendix explains how to create a custom configuration file, how WinBench 96 uses a custom configuration file, and summarizes the command set you can use to build the file. Following the list of available commands, you'll find examples you can modify for a custom file.

Sections in this appendix

� REF _Ref336154992 \* MERGEFORMAT �Creating a custom configuration file�

� REF _Ref336154995 \* MERGEFORMAT �How WinBench 96 uses a custom file�

� REF _Ref336154998 \* MERGEFORMAT �Comments�

� REF _Ref336154999 \* MERGEFORMAT �entry = lines�

� REF _Ref336155001 \* MERGEFORMAT �[section] lines�

� REF _Ref336155002 \* MERGEFORMAT �Functions�

� REF _Ref336143498 \* MERGEFORMAT �Expressions�

� REF _Ref336155009 \* MERGEFORMAT �Examples�

Creating a custom configuration file

WinBench 96 includes a prototype configuration file, SAMPLE.CFG� XE "SAMPLE.CFG" �, in the \ZDBENCH\WB96 directory on the CD�ROM.

To create a custom configuration file:

1.	Copy the SAMPLE.CFG file to another file name, such as CUSTOM.CFG.

2.	Edit the new file so it contains the configuration information you want WinBench 96 to check. (The section “� REF _Ref336140506 \* MERGEFORMAT �Functions�” beginning on page � PAGEREF _Ref336140508 �204� provides details on the list of available commands. For a few examples to use as guidelines when you edit the file, see page � PAGEREF _Ref334427900 �207�.)

Once you’ve edited and saved the custom file, you’ll need to load the file during the WinBench 96 session for WinBench 96 to use it during its configuration check (see page � PAGEREF _Ref327694797 �38� for more information).

How WinBench 96 uses a custom file

After you load a custom file, WinBench 96 compares the test PC’s system configuration with the settings in the custom file before each test run.

To increase the speed of execution, WinBench 96 parses the custom configuration file entirely within memory. Thus, a custom configuration file must be less than 64KB in size.

WinBench 96 executes the custom configuration file one line at a time. The file contains five elements:  Comments, Entry = lines, [section] lines, Functions, and Expressions.

The remainder of this appendix describes each of these elements.

Comments

Comments in a custom configuration file explain what each command in the file does. You enter comments in the file using two adjacent slashes (//) at the beginning of the line. The comment can start anywhere on a line and extends until the next new line. WinBench 96 treats double slashes enclosed within quotation marks (“ ”) as part of a literal string and not a comment.

Comments are for your use only; WinBench 96 ignores all text within a comment.

entry = lines

WinBench 96 uses entry = lines to retrieve information from the test PC’s environment variables, the benchmark’s disclosure fields, or the PC’s .INI files. You can specify where the entry = line looks for information by using the #focus( ) function described on page � PAGEREF _Ref336242591 �204�.

All entry = lines have the following general syntax:

entry = [FormatString,] VariableList

Where:

entry is the name of the environment variable, disclosure field, or .INI file entry whose value you want to retrieve. WinBench 96 scans the value of entry as a series of input fields.

FormatString defines a format specifier (similar to the C sscanf( ) function).

The FormatString option recognizes three format specifiers:  %d, %f, and %s. With these three format specifiers the parser can format integers (from -2,147,483,684 to 2,147,483,687), floating point numbers (from 1.7 x 10-308 to 1.7 x 10308), and strings.

You don’t have to specify a FormatString option. If the FormatString is missing, WinBench 96 stores the contents of entry in the one variable you specify. This is useful for reading entire strings, rather than formatting them one token at a time.

VariableList defines where you want WinBench 96 to store the formatted input.

The VariableList option can contain up to 32 variables, separated by commas. Variable names must be unique within the first 31 characters and must follow C rules for naming variables.

Variables are only valid until the next entry = line. The VariableList for each entry = line replaces the VariableList from the previous entry =  line.

[section] lines

A [section] line specifies the section WinBench 96 uses when retrieving entries from an .INI file. You can use [section] lines only if the current focus is an .INI file; otherwise, WinBench 96 will issue an error message because it cannot find the .INI file. You can set the focus using the #focus( ) function (see page � PAGEREF _Ref336242622 �204�).

Functions

The following sections discuss the functions you can use to build a custom configuration file.

#if(expression)

You can use the #if(expression) function to check if certain conditions exist on the test PC. You can use the following BOOL operators in the #if function:

&&	numbers only�||	numbers only�==	numbers and strings�!=	numbers and strings�in	strings only�<	numbers and strings�<=	numbers and strings�>	numbers and strings�>=	numbers and strings

For information on variables you can use in the (expression) see the section “� REF _Ref336143498 \* MERGEFORMAT �Expressions�” on page � PAGEREF _Ref336143498 �206�.

#else

The #else function tells the benchmark what to do if the #if function is not true. The #else function is optional.

#endif

The #endif function marks the end of the #if function.

�#focus(FOCUS)

The #focus(FOCUS) function sets the system location where the benchmark retrieves configuration information.

Valid values for FOCUS are:

Disclosure	benchmark disclosure fields�Environment	environment variables�inifile	.INI file name

#text(FormatString[,VariableList])

The #text(FormatString[,VariableList]) function overrides the default text for the previous entry = line. WinBench 96 displays this text in the top portion of the Configuration Information window. The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are the only allowable format specifiers.

#note(FormatString[,VariableList])

The #note(FormatString[,VariableList]) function links a note to the previous entry = line. WinBench 96 displays this note in the Note section of the Configuration Information window when the tester selects the corresponding text message in top portion of that window.

The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are the only allowable format specifiers.

#notify(void)

The #notify(void) function notifies the benchmark of a conflict. When the benchmark receives a #notify function, it displays either a default text message or text specified in the #text function in the Configuration Information window. If the tester supplies a note, the benchmark displays this note in the Note text box.

Expressions

The general syntax for an expression is:

A operator B

A and B can be any of the following:

A variable name.

A string or numeric constant.

One of the following pre-defined constants:

TRUE	1�FALSE	0�WIN16	TRUE if OS is 16-bit Windows.�WFWG	TRUE if OS is Windows for Workgroups.�WIN95	TRUE if OS is Windows 95.�WINNT	TRUE if OS is Windows NT.�DISKSPACE	Amount of free space on the working drive.�FREEMEM	Amount of free memory.�SYSTEMRAM	Amount of processor RAM.

Another expression.

The operator can be any one of the following:

<	less than�<=	less than or equal to�>	greater than�>=	greater than or equal to�==	equal to�!=	not equal to�&&	logical AND�||	logical OR�in	tests if A is a substring of B

Examples

This section provides examples you can build upon for a custom configuration file (see the SAMPLE.CFG file in the \ZDBENCH\WB96 directory).

Checking DOS environment variables

If you want WinBench 96’s system to check to verify DOS environment variables before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the DOS environment variables.�#focus(Environment)�// Read the "TEMP" variable as a string and store the value�// in ENVVAR.�TEMP = envvar�// If ENVVAR is empty, set NOTE and call NOTIFY to update �// the Configuration Information Window.�#if (envvar != "")�#else�	#note(“You need to set the TEMP environment variable in the AUTOEXEC.BAT file. For example, ‘TEMP=C:\DOS’.”�	#notify()�#endif

Checking entries in WIN.INI

If you want WinBench 96’s system to check to verify entries in the PC’s WIN.INI file before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the WIN.INI file.�#focus("win.ini")�// Set the topic to the [windows] section of the WIN.INI�// file.�[windows]�// Read the "run" entry in the [windows] section as a �// string and store the value in RUNVAR.�run = runvar�// If RUNVAR is not empty, set NOTE and call NOTIFY to �// update the Configuration Information Window.�#if (runvar != "")�	#note ("The 'run =' line in the WIN.INI file should be empty.")�	#notify()�#endif�// Read the "load" entry in the [windows] section as a �// string and store the value in LOADVAR.�load = loadvar�// If LOADVAR is not empty, set NOTE and call NOTIFY to �// update the Configuration Information Window.�#if (loadvar != "")�	#note ("The 'load =' line in the WIN.INI file should be empty.")�	#notify()�#endif

Checking entries in SYSTEM.INI

If you want WinBench 96’s system to check to verify entries in the PC’s SYSTEM.INI file before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the SYSTEM.INI file.�#focus("system.ini")�// Set the topic to the [boot] section of the SYSTEM.INI �// file.�[boot]�// Read the "shell" entry in the [boot] section as a string �//and store the value in SHELLVAR.�shell = "%s", shellvar�// If SHELLVAR is not equal to "PROGMAN.EXE", set NOTE and �// call NOTIFY.�#if (shellvar != "progman.exe")�	#note("We've only tested WinBench 96 on systems running Windows PROGMAN.EXE as the shell program.")�	#notify()�#endif

End of Appendix

�Appendix C: �The Video Clips

� XE "WinBench 96:Tests:Video clip files" \r "VideoClips" �� XE "Video clip files" \r "VideoClips" �� XE "Tests:Video:Clip files" \r "VideoClips" �� XE "Video tests:Clip files" \r "VideoClips" �This appendix briefly explains what you should see at certain frame numbers during each type of video test. This appendix includes this level of detail because when you first run a WinBench 96 video test, it may be difficult to distinguish between actual display problems and the editing of the video. (For information on how to run a video test, see the section “� REF _Ref330197959 \* MERGEFORMAT �Running the full-motion video tests�” on page � PAGEREF _Ref330197959 �52�.)

This appendix also provides a chart that maps each video test name to the .AVI video clip file that test runs and a chart that lists the attributes for each .AVI video clip file.

Sections in this appendix

� REF _Ref336157074 \* MERGEFORMAT �Frame by frame—What you’ll see in the video clips�

� REF _Ref336157077 \* MERGEFORMAT �Mapping the video test names to the video clip file names�

� REF _Ref336157079 \* MERGEFORMAT �Video clip attributes�

Frame by frame—What you’ll see in the video clips

WinBench 96 includes two types of video clips:  talking head and action. The WinBench 96 talking head video clip is a movie of a person talking. The WinBench 96 action video clip is a movie of a running carousel.

Talking head video clips� XE "Talking head video" �� XE "Video tests:Talking head" �� XE "WinBench 96:Tests:Talking head" �

Each talking head video clip is 15 seconds long and shows a person reciting the following lines:

What you are watching is a WinBench test of the PC’s ability to play full-motion video. You should look for three things:  The motion should appear smooth, the sound should not have any unexpected breaks, and the audio should be synchronized with the video.

Action video clips� XE "Action video" �� XE "Video tests:Action" �� XE "WinBench 96:Tests:Action" �

Each action video clip is 15 seconds long except for one long video clip that lasts 120 seconds. The action video clips show different scenes of a moving carousel and include background music. The following tables list the different scenes in the action video clips.

NOTE:	The numbers listed in these tables identify the frame number per second using the following format:  <minutes>:<seconds>:<frame number>. Frame numbers run from 0-29, or 30 frames per second. (30 fps is the industry-standard frames per second rate.) For example, the number 14:29 indicates the 29th (last) frame at the 14-second mark of the video clip, and the number 01:10:05 indicates the 5th frame at the 1 minute and 10-second mark of the video clip.

Table 1:  15-second video clips

In these frame numbers:�You’ll see:��00:00—04:29�The carousel accelerating.��05:00�A cut to a different scene.��05:00—9:29�The carousel running at full speed. Two carousel rabbits cross the frame.��10:00�A cut to a different scene.��10:00—14:29�The carousel slowing down.��Table 2:  120-second video clip

In these frame numbers:�You’ll see:��00:00:00—00:04:29�The carousel accelerating.��00:05:00—00:06:11�Screen splits to reveal shot of carousel horse’s head.��00:06:12—00:07:14�Still shot of the carousel horse’s head.��00:07:15—00:08:22�Hole opens in center to reveal the running carousel.��00:08:23—00:12:13�Carousel runs.��00:12:14—00:13:28�8-sectioned wipe to a carousel horse’s head.���

Table 2:  120-second video clip (continued)

In these frame numbers:�You’ll see:��00:13:29—00:14:29�Still shot of the carousel horse’s head.��00:15:00—00:16:14�Clock-sweep wipe to reveal the running carousel.��00:16:15—00:19:29�Carousel runs.��00:20:00—00:21:13�Jagged-edge wipe from upper-left corner to reveal carousel horse’s head.��00:21:14—00:22:14�Still shot of the carousel horse’s head.��00:22:15—00:22:22�Fade to the running carousel.��00:22:23—00:25:00�Carousel horse passes through the frame.��00:25:01—00:25:09�Fade to a brown carousel horse.��00:25:10—00:29:02�Carousel horse passes through the frame.��00:29:03—00:29:10�Fade to carousel rabbits.��00:29:11—00:34:13�Carousel rabbits pass through the frame.��00:34:14—00:34:21�Fade to a carousel horse.��00:34:22—00:36:14�Carousel horse passes through the frame.��00:36:15—00:36:24�Flash to a carousel tiger’s head.��00:36:25—00:38:21�Still shot of the carousel tiger’s head.��00:38:22—00:40:04�Psychedelic wipe to the running carousel.��00:40:05—00:46:07�Carousel runs.��00:46:08—00:46:29�Circular wipe from upper-right and lower-left corners to reveal carousel horse’s head.��00:47:00—00:47:20�Still shot of carousel horse’s head.��00:47:21—00:48:12�Jagged-burst wipe from center to reveal carousel horse’s head bobbing up and down.��00:48:13—00:54:08�The carousel horse’s head bobs up and down.��00:54:09—00:54:16�Fade to a carousel bird’s head.��00:54:17—01:01:02�The carousel bird’s head bobs up and down.��01:01:03—01:01:11�Fade to two carousel horse’s heads.��01:01:12—01:03:04�The carousel horses’ heads bob up and down.��01:03:04—01:03:12�Fade to a carousel cat with a fish in its mouth.��01:03:13—01:06:02�The carousel cat’s head bobs up and down.��01:06:03—01:06:10�Fade to two carousel horses.��01:06:11—01:09:10�The carousel horses’ heads bob up and down.��01:09:11—01:10:04�Heart-shaped wipe from center to reveal a carousel giraffe’s head.���

Table 2:  120-second video clip (continued)

In these frame numbers:�You’ll see:��01:10:05—01:11:15�Still shot of a carousel giraffe’s head.��01:11:16—01:12:08�Page-turn wipe to the carousel running as seen from the inside of the carousel.��01:12:09—01:21:09�Carousel runs.��01:21:10—01:21:28�Building-block wipe from left side to carousel horse’s head.��01:21:29—01:22:29�Still shot of carousel horse’s head.��01:23:00—01:23:22�Rectangular wipe from upper-left to the running carousel.��01:23:23—01:29:12�Carousel runs.��01:29:13—01:30:09�Jagged, multisection wipe reveal carousel bird’s head.��01:30:10—01:32:07�Still shot of carousel bird’s head.��01:32:08—01:33:05�Carousel bird’s head shrinks and flips into center to reveal the running carousel.��01:33:06—01:43:20�Carousel runs.��01:43:21—01:44:13�Wavy, rotating wipe from center to the carousel slowing down.��01:44:14—01:59:29�Carousel slows almost to a stop.��Mapping the video test names to the video clip file names

The following chart lists the .AVI video clip file name WinBench 96 runs for each video test.

NOTE:	You can find the .AVI video clips in the \VIDEO directory on the CD-ROM that contains WinBench 96.

Test name:�Video clip file name:��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S�INAC3L3L.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full�CPAC3S3S.AVI��Video/Action, Cinepak, 320x240, 15fps, 300KB/S�CPAC1L3S.AVI��Video/Action, Cinepak, 320x240, 25fps, 300KB/S�CPAC2L3S.AVI���

Test name:�Video clip file name:��Video/Action, Cinepak, 320x240, 30fps, 300KB/S�CPAC3L3S.AVI��Video/Action, Cinepak, 640x480, 15fps, 900KB/S�CPAC1H9S.AVI���Video/Action, Cinepak, 640x480, 30fps, 900KB/S�CPAC3H9S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full�INAC3S3S.AVI��Video/Action, Indeo, 320x240, 15fps, 250KB/S�INAC1L2S.AVI��Video/Action, Indeo, 320x240, 15fps, 300KB/S�INAC1L3S.AVI��Video/Action, Indeo, 320x240, 15fps, 450KB/S�INAC1L4S.AVI��Video/Action, Indeo, 320x240, 15fps, 600KB/S�INAC1L6S.AVI��Video/Action, Indeo, 320x240, 25fps, 250KB/S�INAC2L2S.AVI��Video/Action, Indeo, 320x240, 25fps, 300KB/S�INAC2L3S.AVI��Video/Action, Indeo, 320x240, 25fps, 450KB/S�INAC2L4S.AVI��Video/Action, Indeo, 320x240, 25fps, 600KB/S�INAC2L6S.AVI��Video/Action, Indeo, 320x240, 25fps, 750KB/S�INAC2L7S.AVI��Video/Action, Indeo, 320x240, 30fps, 250KB/S�INAC3L2S.AVI��Video/Action, Indeo, 320x240, 30fps, 300KB/S�INAC3L3S.AVI��Video/Action, Indeo, 320x240, 30fps, 450KB/S�INAC3L4S.AVI��Video/Action, Indeo, 320x240, 30fps, 600KB/S�INAC3L6S.AVI��Video/Action, Indeo, 320x240, 30fps, 750KB/S�INAC3L7S.AVI��Video/Action, Indeo, 640x480, 15fps, 900KB/S�INAC1H9S.AVI��Video/Action, Indeo, 640x480, 30fps, 900KB/S�INAC3H9S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full�CPTK3S3S.AVI��Video/Head, Cinepak, 320x240, 15fps, 300KB/S�CPTK1L3S.AVI��Video/Head, Cinepak, 320x240, 25fps, 300KB/S�CPTK2L3S.AVI��Video/Head, Cinepak, 320x240, 30fps, 300KB/S�CPTK3L3S.AVI��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S�CPTK3L3S.AVI���

Test name:�Video clip file name:��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S�CPTK3L3S.AVI��Video/Head, Indeo, 160x120, 30fps, 150KB/S�INTK3S1S.AVI���Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full�INTK3S3S.AVI��Video/Head, Indeo, 320x240, 15fps, 150KB/S�INTK1L1S.AVI��Video/Head, Indeo, 320x240, 15fps, 300KB/S�INTK1L3S.AVI��Video/Head, Indeo, 320x240, 25fps, 150KB/S�INTK2L1S.AVI��Video/Head, Indeo, 320x240, 25fps, 300KB/S�INTK2L3S.AVI��Video/Head, Indeo, 320x240, 30fps, 150KB/S�INTK3L1S.AVI��Video/Head, Indeo, 320x240, 30fps, 300KB/S�INTK3L3S.AVI��Video clip attributes

The following chart list the video attributes for each .AVI video clip file.

File name�Type�Secs*�Compression�Resolution�fps† �KB/S‡�Audio Format��CPAC1H9S.AVI�Action�15�Cinepak�640x480�15�901�16bit 22KHz S��CPAC1L3S.AVI�Action�15�Cinepak�320x240�15�261�8bit  22KHz S��CPAC2L3S.AVI�Action�15�Cinepak�320x240�25�257�8bit  22KHz S��CPAC3H9S.AVI�Action�15�Cinepak�640x480�30�911�16bit 22KHz S��CPAC3L3S.AVI�Action�15�Cinepak�320x240�30�263�8bit  22KHz S��CPAC3S3S.AVI�Action�15�Cinepak�160x120�30�253�8bit  22KHz S��CPTK1L3S.AVI�Talking Head�15�Cinepak�320x240�15�265�8bit  22KHz M��CPTK2L3S.AVI�Talking Head�15�Cinepak�320x240�25�258�8bit  22KHz M��CPTK3L3S.AVI�Talking Head�15�Cinepak�320x240�30�262�8bit  22KHz M��CPTK3S3S.AVI�Talking Head�15�Cinepak�160x120�30�247�8bit  22KHz M���

File name�Type�Secs*�Compression�Resolution�fps†�KB/S‡�Audio Format��INAC1H9S.AVI�Action�15�Indeo�640x480�15�917�16bit 22KHz S��INAC1L2S.AVI�Action�15�Indeo�320x240�15�216�8bit  22KHz S��INAC1L3S.AVI�Action�15�Indeo�320x240�15�256�8bit  22KHz S���INAC1L4S.AVI�Action�15�Indeo�320x240�15�389�16bit 22KHz S��INAC1L6S.AVI�Action�15�Indeo�320x240�15�515�16bit 22KHz S��INAC1L7S.AVI�Action�15�Indeo�320x240�15�525�16bit 22KHz S��INAC2L2S.AVI�Action�15�Indeo�320x240�25�225�8bit  22KHz S��INAC2L3S.AVI�Action�15�Indeo�320x240�25�256�8bit  22KHz S��INAC2L4S.AVI�Action�15�Indeo�320x240�25�384�16bit 22KHz S��INAC2L6S.AVI�Action�15�Indeo�320x240�25�524�16bit 22KHz S��INAC2L7S.AVI�Action�15�Indeo�320x240�25�782�16bit 22KHz S��INAC3H9S.AVI�Action�15�Indeo�640x480�30�914�16bit 22KHz S��INAC3L2S.AVI�Action�15�Indeo�320x240�30�219�8bit  22KHz S��INAC3L3L.AVI�Action�120�Indeo�320x240�30�257�8bit  22KHz S��INAC3L3S.AVI�Action�15�Indeo�320x240�30�260�8bit  22KHz S��INAC3L4S.AVI�Action�15�Indeo�320x240�30�389�16bit 22KHz S��INAC3L6S.AVI�Action�15�Indeo�320x240�30�529�16bit 22KHz S��INAC3L7S.AVI�Action�15�Indeo�320x240�30�790�16bit 22KHz S��INAC3S3S.AVI�Action�15�Indeo�160x120�30�258�8bit  22KHz S��INTK1L1S.AVI�Talking Head�15�Indeo�320x240�15�130�8bit  22KHz M��INTK1L3S.AVI�Talking Head�15�Indeo�320x240�15�162�8bit  22KHz M��INTK2L1S.AVI�Talking Head�15�Indeo�320x240�25�132�8bit  22KHz M��INTK2L3S.AVI�Talking Head�15�Indeo�320x240�25�260�8bit  22KHz M��INTK3L1S.AVI�Talking Head�15�Indeo�320x240�30�145�8bit  22KHz M��INTK3L3S.AVI�Talking Head�15�Indeo�320x240�30�259�8bit  22KHz M��INTK3S1S.AVI�Talking Head�15�Indeo�160x120�30�129�8bit  22KHz M��INTK3S3S.AVI�Talking Head�15�Indeo�160x120�30�145�8bit  22KHz M��End of Appendix

�Glossary� XE "Glossary" �

Baseline system� XE "Baseline system" �

When you display results, you can choose which set of results you want to use as a baseline system. With a baseline system, you can quickly compare all the results to that one set of results in WinBench 96’s Chart of Results.

When you select a baseline system, WinBench 96 sets that system’s results to 1.00 and displays all other results as a fraction of the baseline system’s results. When you use a baseline system, you can quickly determine from the graphs how results for different PCs compare.

For example, once you’ve set the baseline system, the bar graph for a set of results that is faster (or better) than the baseline system’s will be more than 1.00, while the bar graph for a set of results that is slower (or worse) than the baseline system’s will be less than 1.00.

To specify which set of results you want WinBench 96 to use as the baseline system or to change the current baseline system, select Baseline... from the Chart menu.

Batch mode� XE "Batch mode" �

You don’t have to sit at the PC and click the buttons to run WinBench 96’s tests. To make the best use of your time, you may decide to run WinBench 96 in batch mode. When you run WinBench 96 this way, it gets the information it needs to run the tests from a file called RUNWB.INI� XE "RUNWB.INI" �. This file supplies the environment settings, the names of the tests WinBench 96 will run, and the names for the database files it produces. WinBench 96 includes a prototype RUNWB.INI file in the \ZDBENCH\WB96 directory on the CD-ROM.

CD-ROM WinMark 96� XE "CD-ROM WinMark 96" �� XE "WinBench 96:CD-ROM WinMark 96" �

The CD-ROM WinMark 96 suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem. (When you run the CD-ROM WinMark 96 suite, the CD�ROM that includes WinBench 96 must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

When you run the CD-ROM WinMark 96 suite, you actually run a single large test called the CD-ROM Mix. The CD-ROM Mix consists of six different sections. Each section executes a set of CD-ROM operations corresponding to the operations performed by one of the six profiled applications.

For information on what the CD-ROM WinMark 96 suite does when you run it, see page � PAGEREF _Ref336143703 �141�. If you want to run the CD-ROM WinMark 96 suite, see page � PAGEREF _Ref333742898 �51�.

Chart of Results� XE "Chart of Results" �

When you run any of WinBench 96’s tests, it automatically displays its results in the Chart of Results.

WinBench 96 displays the name of the test and a horizontal bar graph showing its result.

You can also add results for other machines to the Chart of Results. If you do this, then WinBench 96 displays a horizontal bar graph for each machine in the chart. The Chart of Results groups results together by test. You can display up to five sets of comparison results in this chart.

CPUmark16� XE "CPUmark16" �

The CPUmark16 is a 16-bit test that reflects the processor usage of 16-bit applications and focuses solely on a PC’s processor subsystem. (The processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.) The CPUmark16 is a synthetic test that stresses the processor subsystem by running a workload that simulates the processor behavior of leading Windows applications. The CPUmark16 workload includes such real work as compressing data, adjusting dates, analyzing words, and formatting text.

CPUmark32

� XE "CPUmark32" �The CPUmark32 is a 32-bit test that reflects the processor usage of 32-bit applications and focuses solely on a PC’s processor subsystem. (The processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.) The CPUmark32 is a synthetic test that stresses the processor subsystem by running a workload that simulates the processor behavior of leading Windows applications. The CPUmark32 workload includes such real work as compressing data, adjusting dates, analyzing words, and formatting text

Custom suite� XE "Custom suite" �

A custom suite is one you create containing just the suites and/or tests you want to run. When you create a custom suite, you save it as a file. You can then add that suite’s name to the list of available suites during any WinBench 96 session. So, you can use custom suites in multiple WinBench 96 sessions, even if those sessions are on different PCs.

NOTE:	While you can create your own suites, you can’t assign weights to the tests in those suites.

A custom suite can include any combination of WinBench 96’s built�in suites or tests.

Disclosure� XE "Disclosure" �

The Disclosure window displays information about a PC’s configuration. You can also view system information about comparison machines from the Disclosure window. To open this window, choose its icon from the WinBench 95 main window or the Disclosure option from the Window menu.

Disclosure Questionnaire� XE "Disclosure Questionnaire" �

When you need to edit Disclosure information, you use WinBench 96’s Disclosure Questionnaire window. This window lets you edit information about a PC’s configuration. To open this window, choose Disclosure Questionnaire... from the Edit menu in the WinBench 96 main menu bar.

Disk WinMark 96� XE "Disk WinMark 96" �

The Disk WinMark 96 gives you an overall comparative measure of a PC’s disk subsystem. The components of that subsystem are the hard disk, the disk controller, any device driver software, and any hardware and software disk caches the PC uses.

When you run WinBench 96’s Disk WinMark 96 suite, you actually run a single large test called the Disk Mix. The Disk Mix executes a series of disk operations similar to typical disk operations leading applications perform. WinBench 96 times how long the test PC takes to perform the Disk Mix and then returns a Disk WinMark 96 result in thousands of bytes per second.

Full-motion video tests

WinBench 96’s video tests provide concrete measures of a PC’s ability to play full-motion video. Video playback functions stress multiple areas of the PC, including the PC’s processor and graphics subsystems, as well as the CD-ROM or disk subsystems, depending on the location of the video clips you’re playing. (The CD�ROM that includes WinBench 96 may also include WinBench 96’s video clips. When you run a video test, that CD�ROM must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

Unlike other WinBench 96 tests that focus on a specific subsystem’s performance, the new video tests stress many different parts of the PC’s hardware and software.

Functions window� XE "Functions window" �

The Functions window is the portion of WinBench 96’s main window that contains the function buttons. The section “� REF _Ref298751138 \* MERGEFORMAT �Using the Functions buttons�” on page � PAGEREF _Ref298751138 �72� explains what each function button does when you choose it.

Graphics WinMark 96� XE "Graphics WinMark 96" �

The Graphics WinMark 96 gives you an overall comparative measure of a PC’s graphics subsystem. The components of that subsystem are the graphics adapter, whether on the motherboard or a plug-in graphics card, its Windows device driver, as well as the PC’s monitor.

The Graphics WinMark suite gives you an overall comparative measure of the performance of a PC’s graphics subsystem by focusing on graphics operations. It performs a mix of Graphics Device Interface (GDI) painting operations that top�selling Windows�based applications use. The tests the Graphics WinMark includes perform operations such as memory to screen BitBlts and screen to screen BitBlts and operations that draw both geometric objects (such as lines, circles, and rectangles) and text.

Main window� XE "Main window" �

WinBench 96’s main window is the window that appears when you first start WinBench 96. The Functions window is inside the main window.

Normalized� XE "Normalized" �� XE "WinBench 96:Normalized" �

If you select Normalized from the Chart menu, WinBench 96 displays all the results as a percentage of the results for the baseline machine. By default, the baseline machine is the current set of results. You can set the baseline machine to any set of results currently displayed.

Profiling� XE "Profiling" �

Profiling is a means of monitoring an application as it executes and then recording the subsystem-level operations it performs.

Result

A result is an actual measure of the amount of work the benchmark was able to do in a given period of time. A result, for example, might be the number of characters per second or the number of operations per second an individual test or suite was able to execute.

Source database� XE "Source database" �

When you merge databases, you must pick a target and source database. The source database is the database from which you wish to get results records.

Suite

See Test Suite.

Swapping� XE "Swapping" �

Windows isn’t limited to the amount of RAM in the PC. If your RAM is full and you ask Windows to load another program, it takes part of some application that isn’t presently running and moves it to the hard disk. If you access that part of the application again, Windows reloads it from the disk into memory. The process is called swapping and the file to which the memory is written is known as a swap file.

If, however, you find Windows swaps a lot of data, it’s a better idea to add more RAM than to increase the swap file size. The swap file, since it’s on the hard disk, will always be slower than RAM. A permanent swap file is better than a temporary one. In either case, it works best when there’s large amounts of contiguous free space on the hard disk. More RAM, though, will always be faster than a swap file.

Synthetic benchmark� XE "Synthetic benchmark" �

WinBench 96 doesn’t run actual applications. Instead, it is a synthetic benchmark:  rather than executing sets of actual applications, it contains specially written tests that mimic the way leading applications work with subsystems. One advantage to using a synthetic benchmark is it typically takes much less time to run than executing actual applications, yet it still reflects the major operations numerous applications perform.

�Table of Results� XE "Table of Results" �

When you run one of WinBench 96’s tests, it includes the result for that test in the Table of Results. WinBench 96 doesn’t, however, automatically display the Table of Results as it does the Chart of Results. To open this window, choose its icon in the WinBench 96 main window or the Table of Results option in the Window menu.

Information in the Table of Results is in a column format grouped into sets of results by test.

You can add up to five sets of comparison results to the Table of Results. If you do this, WinBench 96 displays the PC’s current results in the first column. WinBench 96 displays results for the comparison machines in the columns that follow the current results. You may need to use the scroll bars to view all the comparison results in the table.

Test Screen� XE "Test Screen" �

When WinBench 96 runs a graphics test, it opens a window for the test called the Test Screen. After the test completes, WinBench 96 leaves the last screen image it displayed during that test run in the Test Screen. To open the Test Screen, choose it from the WinBench 96 main window.

If you have problems while running one of WinBench 96’s graphics tests, you can use the Test Screen to make sure the test finished successfully by comparing the test screen from a test you know was successful with the current Test Screen. (If you do this, you’ll need to make sure the graphics driver uses the same resolution and options for the current test as for the successful test.)

Test suite� XE "Test suite" �

A test suite is a test or group of tests you can run at one time by choosing Run from the File menu or by choosing the Run button. For example, WinBench 96 includes the following built�in test suites:  the Graphics, Disk, and CD-ROM WinMarks and the CPUmark16 and CPUmark32.

Target database� XE "Target database" �

When you merge databases, you must pick a target and source database. The target database is the database to which you want to add results.

�WinBench 96

WinBench 96 is a subsystem-level benchmark that measures the performance of a PC’s graphics, disk, processor, video, and CD�ROM subsystems in a Windows-based environment. WinBench 96’s tests perform many of the same operations applications commonly execute. For WinBench 96, we profiled the same Windows-based applications Winstone 96 uses. These applications cover top-selling Windows product areas, including database, business graphics and desktop publishing, spreadsheet, and word processing.

NOTE:	WinBench 96 doesn’t run actual applications during its tests. Instead, the tests mimic the operations leading Windows-based applications perform.

WinBench 96 returns five main results that provide an overview of a PC’s graphics, disk, processor, and CD�ROM subsystems performance—the Graphics WinMark 96, Disk WinMark 96, the CPUmark�16��� and CPUmark�32�, and the CD-ROM WinMark 96. In addition, the benchmark includes full-motion video tests to measure the PC’s video subsystem performance.

Winstone 96� XE "Winstone 96" �

Winstone 96 is a benchmark that runs test suites of Windows-based applications. In developing Winstone 96’s suites, we did extensive research into which applications are leaders in today’s software market. We also did usability surveys and tests to determine how typical users work with these applications. The result of this research is an accurate and repeatable benchmark you can use to determine a PC’s overall performance when running today’s top-selling Windows�based applications.

Winstone 96 doesn’t mimic applications; it actually runs applications. When you choose one of Winstone 96’s test suites, it runs the application scripts associated with that suite. Each application script starts its application, performs tasks within that application, and exits the application. Winstone 96 times how long it takes each application script to complete and then computes a single, relative score for that test suite. You can compare a PC’s score with the scores of other PCs—higher scores mean faster overall performance.

ZDBOp� XE "ZDBOp" �

The Ziff�Davis Benchmark Operation (ZDBOp) is a division of Ziff-Davis Publishing Company. Its mission is to research, develop, and support the publicly available, core benchmarks that all Ziff�Davis publications use.
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��BENCHMARK REQUEST FORM

Please check the boxes of the products you want:

___	PC Benchmarks CD-ROM containing Winstone® and WinBench® for desktop PCs running Windows®.

___	Server Benchmarks CD-ROM containing NetBench® for file servers and ServerBench® for client/servers (for x86-compatible processors).

___	Macintosh Benchmark CD-ROM containing MacBench® for Mac™ OS Systems.

Please send these products to:

Name: ____________________________________________________________________

Company: _________________________________________________________________

Address: __________________________________________________________________

City: ________________________________ State: _________________ Zip: ___________

Country: __________________________________________________________________

Telephone: ______________________________ FAX: _____________________________

We answer requests in the order we receive them. We ship all benchmarks via 3rd�class U.S Mail. Please allow 4-6 weeks for delivery. For faster shipment, provide your Federal Express account information below:

Your Federal Express account number: __________________________________________

Check one:	___ priority overnight 	___ standard overnight

Please return this form:

Fax to:	(919) 380-2879

or Mail to:	Distribution Coordinator�Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, NC 27560

�Problem Report Form

Information about you:

Name: ____________________________________________________________________

Address: __________________________________________________________________

Company: _________________________________________________________________

E-mail address: _____________________________________________________________

Phone: _______________________________  Fax: ________________________________

Benchmark you’re using: _____________________________________________________

A description of the PC:

Example:	WXY Corp. Model 486DX-66 with 8MB of RAM, 64 KB RAM cache, 200MB hard disk, IDE controller, no hardware disk cache, running Windows 3.1 and DOS 6.0

______________________________________________________________________________________________________________________________________________________________________________________________________________________________

Details of the problem:

What is the problem, and what did the benchmark do just before the problem occurred _____�____________________________________________________________________________________________________________________________________________________

What message was in the status bar at the bottom of the benchmark’s main window _______�__________________________________________________________________________

Can you reproduce the problem? ______

Could you please attach the contents of the benchmark’s Disclosure and the ERRORS.TXT file? (You can find the ERRORS.TXT file in the benchmark’s main directory.)

Other comments: ____________________________����������������������_______________________________�__________________________________________________________________________

Please return this form:

Fax to:	(919) 380-2879

or Mail to:	Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, NC 27560
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*	We didn’t test WinBench 96 on earlier versions of these operating systems. So, we can’t guarantee it will run on them, or, if it does, that the results will be valid.

†	The CD-ROM that includes WinBench 96 also includes the versions of Video for Windows and Win32s needed to run the benchmark’s tests.

‡	The test PC must have a sound card if you plan to run WinBench 96’s full-motion video tests.

*	The test files WinBench 96 uses for theCD-ROM tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM, will not contain these tests. In addition, some CD-ROM versions of WinBench 96 may not include these tests because of limited space requirements. Versions of WinBench 96 without these tests do not list “CD�ROM WinMark 96” in the list of tests.

*	You can only choose the Test Screen option if you’ve run a graphics test.

*	For each video test, WinBench 96 can produce five results.

*	The length of the video clip in seconds.

†	The number of frames per seconds for the video clip.

‡	The data rate of the video clip in kilobytes per second.
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